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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

 DANGER 
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

 WARNING 
indicates that death or severe personal injury may result if proper precautions are not taken. 

 

 CAUTION 
indicates that minor personal injury can result if proper precautions are not taken. 

 

 NOTICE 
indicates that property damage can result if proper precautions are not taken. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

 WARNING 
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Overview  
 

Description 

 
The DC-UPS modules augment the SITOP 24 V power supply units for uninterruptible rated 
currents up to 40 A from the UPS1100 battery modules based on maintenance-free lead or 
LiFePo batteries. SITOP UPS1600 with its integrated electronics automatically detects the 
battery type that it charges with the optimum temperature-controlled charging characteristic 
curve. The intelligent battery management monitors all relevant data, also for parallel-
connected battery modules. The Ethernet/PROFINET interface is used to output the battery 
status and various actual values, such as voltage and current. Thanks to the integrated web 
server, remote diagnosis is also possible. 

The low profile SITOP UPS1600 DC-UPS module provides a dynamic overload behavior, for 
example, to switch on industrial PCs. The high charging current quickly restores the buffer 
readiness after a supply system failure. And for the deployment in stand-alone operation, the 
UPS can be activated from the battery for missing supply system voltage, e.g. to start the 
generators. 

 

The key benefits of the product include: 

● Compact SITOP UPS1600 24 V/10 A, 20 A and 40 A DC-UPS modules with digital 
inputs/outputs, optional with USB or two Ethernet/PROFINET interfaces 

● SITOP UPS1100 24 V/1.2 Ah, 2.5 Ah, 3.2 Ah, 7 Ah and 12 Ah battery modules with 
maintenance-free lead-gel batteries or 5 Ah with LiFePo batteries and integrated 
electronics; intelligent battery management with automatic detection of the battery 
modules and selection of the optimum, temperature-controlled charging characteristic 
curve; monitoring of the operating readiness, battery supply cable, aging and charging 
state. 

● All diagnostic data and alarm messages are available via USB and Ethernet/PROFINET 

● High dynamic overload capability: 3-fold rated current for 30 ms and 1.5-fold rated current 
for 5 seconds per minute 

● High charging currents 

● Start from battery modules for missing supply system voltage 
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● Remote monitoring with integrated web server 

● SITOP UPS Manager (free software download) supports the configuration and monitoring 
for PC-based systems 

● Complete integration in TIA: User-friendly engineering in the TIA Portal, S7 function 
blocks for integration in user programs and WinCC faceplates 

Ordering data 
The following device options are available: 
 
SITOP UPS1600 uninterruptible power supply 
Type Order number 
Input 24 V DC 
Output 24 V DC / 10 A 

6EP4134-3AB00-0AY0 

Input 24 V DC 
Output 24 V DC / 10 A 
With USB interface 

6EP4134-3AB00-1AY0 

Input 24 V DC 
Output 24 V DC / 10 A 
With PROFINET (PN) interface 

6EP4134-3AB00-2AY0 

Input 24 V DC 
Output 24 V DC / 20 A 

6EP4136-3AB00-0AY0 

Input 24 V DC 
Output 24 V DC / 20 A 
With USB interface 

6EP4136-3AB00-1AY0 

Input 24 V DC 
Output 24 V DC / 20 A 
With PROFINET (PN) interface 

6EP4136-3AB00-2AY0 

Input 24 V DC, 
Output 24 V DC / 40 A 

6EP4137-3AB00-0AY0 

Input 24 V DC, 
Output 24 V DC / 40 A 
With USB interface 

6EP4137-3AB00-1AY0 

Input 24 V DC, 
Output 24 V DC / 40 A 
With PROFINET (PN) interface 

6EP4137-3AB00-2AY0 
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SITOP UPS1100 battery module 
Type Order number 
Battery module 1.2 Ah 6EP4131-0GB00-0AY0 
Battery module 2.5 Ah 6EP4132-0GB00-0AY0 
Battery module 3.2 Ah 6EP4133-0GB00-0AY0 
Battery module 5 Ah 6EP4133-0JB00-0AY0 
Battery module 7 Ah 6EP4134-0GB00-0AY0 
Battery module 12 Ah 6EP4135-0GB00-0AY0 

 
 
Accessories 
Type Order number 
Device identification labels 20 mm × 7 mm, pastel 
turquoise 

3RT1900-1SB20 
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 Safety instructions 1 
 

 

 
 

 WARNING 

Correct handling of the devices 

When operating electrical devices, it is inevitable that certain components will carry 
dangerous voltages. 

Therefore, failure to handle the units properly can result in death or serious physical injury 
as well as extensive property damage. 

Only appropriately qualified personnel may work on or in the vicinity of this equipment. 

Perfect, safe, and reliable operation of this equipment is dependent on proper 
transportation, storage, installation and mounting. 

Before installation or maintenance work can begin, the system's main switch must be 
switched off and measures taken to prevent it being switched on again. 

If this instruction is not observed, touching live parts can result in death or serious injury. 
 

Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, solutions, machines, equipment and/or networks. They are 
important components in a holistic industrial security concept. With this in mind, Siemens’ 
products and solutions undergo continuous development. Siemens recommends strongly 
that you regularly check for product updates. 

For the secure operation of Siemens products and solutions, it is necessary to take suitable 
preventive action (e.g. cell protection concept) and integrate each component into a holistic, 
state-of-the-art industrial security concept. Third-party products that may be in use should 
also be considered. You can find more information about industrial security under: 
http://www.siemens.com/industrialsecurity 

To stay informed about product updates as they occur, sign up for a product-specific 
newsletter. You can find additional information on this at: 
http://support.automation.siemens.com. 
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 Description, device design, dimension drawing 2 
2.1 Device description 

2.1.1 SITOP UPS1600 
The SITOP UPS1600 10 A, 20 A and 40 A are built-in devices of the SITOP series for 
mounting on TH35-15/7.5 standard mounting rails (EN 60715). When installing the 
SITOP UPS1600 devices and SITOP UPS1100 battery modules, the relevant DIN/VDE 
regulations or country-specific regulations (e.g. VDE 0510 Teil 2 / EN 50272-2) must be 
carefully complied with. 

See Section Installation (Page 149)  

In combination with the SITOP UPS1100 battery modules, they are used to buffer the load 
current from the 24 V load power supplies of the SITOP series. 
With their high dynamic overload capability up to the 300% rated current for 30 ms or up to 
the 150% rated current for 5 seconds per minute, they are suitable for applications with 
programmable logic controllers (PLCs) and industrial PCs, because they permit high switch-
on currents even in buffer operation.  

The input of the SITOP UPS1600 DC-UPS module must be connected with the output of the 
supplying 24 V DC power supply unit. The UPS1100 battery module is connected to the BAT 
terminals. The loads to be buffered are supplied via the output of the SITOP UPS1600 DC-
UPS module with the voltage connected at the input.  

The Energy Storage Link is new. This is an additional two-wire connection between the 
SITOP UPS1600 base device and the coded SITOP UPS1100 battery modules. 
Furthermore, the base device detects and manages as many as six battery modules and 
selects the optimum, temperature-controlled charging characteristic curve. The latter 
provides the basis for a long service life of the battery modules. The Energy Storage Link 
also monitors the operational readiness as well as the supply cables (wire breakage) and the 
charge state (voltage, current) of the rechargeable batteries. 
The connection to the SITOP UPS1100 battery module is checked every 20 seconds (for 
voltage, reverse polarity protection). A test with a defined load of the lead or LiFePo batteries 
is also performed automatically every four hours (basic setting). 
Battery modules of other type series and manufacturers can also be used, although with 
limited diagnostic functions, such as the display of the charging current or the end-of-charge 
voltage and without the possibility of temperature-controlled charging. 

In the event of failure of the 24 V DC supply voltage or voltage dip below the set switch-in 
threshold, the loads are supplied by switching over to the battery module. Buffering is 
realized until the line supply returns or until the buffer time, set using the rotary coding 
switch, has expired. If the buffer time has been set to MAX, then shutdown is realized when 
the exhaustive discharge threshold is reached. 

Using the output voltage interrupt function you can select as to whether the output voltage is 
interrupted once the set buffer time expires if, in the meantime, the input voltage returns. 
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(Delivery state: the output voltage is not interrupted). For devices without interface, the 
interruption lasts 5 s. For devices with interface, the interruption duration can be adjusted. 

For the "Maximum buffer time" setting, the output voltage is only interrupted by the UPS 
Manager. In this case, the rotary coding switch "Connection threshold" must be set to REN.  

Rotary switches can be used to set the battery module switch-in threshold and the buffer 
time. The charging current for the battery modules is set automatically, and can be changed 
using the interface (only for types -1AY0 and -2AY0), as well as via the signal connector. 

Eight LEDs, two potential-free changeover contacts and one floating NO contact indicate the 
SITOP UPS1600 status. 

The USB interface (only -1AY0) or PROFINET/Ethernet interface (only -2AY0) handles the 
communication to the PC/controllers. 
For details, see Sections Connections and terminal designation (Page 17) and Operator 
controls (Page 22). 

Operating data and diagnostic data can be transferred using two integrated Industrial 
Ethernet/PROFINET ports and visualized or further processed externally as an alternative to 
the proven USB connection. An integrated web server allows authorized users to export 
relevant data remotely via a web browser without requiring any additional software to be 
installed on the remote system. When delivered, the web server is not active (applies from 
version V2.1 and higher). Using the two rotary coding switches, the web server can be 
activated, and a temporary Internet address assigned, see SITOP UPS1600 (Page 22). 
The free-of-charge SITOP UPS Manager, which runs on Windows XP and Windows 7 
systems (32 and 64 bit), allows full access. This allows the overall DC-UPS installation to be 
configured and monitored easily using a PC. The software tool provides many possibilities 
for the visualization of operating and diagnostic information, such as in the form of alarm lists 
or easily understandable trend diagrams which, for example, provide a view of the 
chronological change of the charging current or load current of the DC-UPS at a glance. 
The SITOP UPS1600 is fully integrated in Totally Integrated Automation (TIA), the Siemens 
open system architecture for integrated automation solutions. The engineering is performed 
in the TIA Portal and reduces to just a few clicks for the user. The UPS modules can be 
selected directly in the hardware catalog and transferred into the graphic network 
representation. 
For applications without network connection, the SITOP UPS1600 is available in the variants 
with USB interface or digital inputs/outputs. 
For stand-alone operation, the DC-UPS can be activated without input voltage from the 
battery, for example, to start a generator via a directly supplied controller. (see Chapter 
Jumper variants (Page 23)) 



 Description, device design, dimension drawing 
 2.1 Device description 

SITOP UPS1600 / UPS1100 
Manual, 04.2016, A5E37775406-6-76 15 

 
① DC input X1 
② DC output X1 
③ BAT X1 
④ Signal connector X2 
⑤ PROFINET (Ethernet) interface X3 (only for ... - 2AY0) 
⑥ USB interface X3 (only for ... - 1AY0) 
⑦ Rotary coding switch, switch-in threshold 
⑧ Rotary coding switch, buffer time 
⑨ Signaling (LEDs) 
⑩ DIN rail slider 
⑪ Convection 
⑫ Clearance above/below 

Image 2-1 SITOP UPS1600 design (example 6EP4136-3AB00-2AY0) 
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2.1.2 SITOP UPS1100 
The SITOP UPS1100 battery modules consist of a battery holder with two maintenance-free, 
closed lead or LiFePO batteries with terminals for the connection cables to the 
SITOP UPS1600 uninterruptible power supply. The UPS1100 contains a printed-circuit 
board for monitoring the battery functions and the communication with the SITOP UPS1600. 
A green LED lights continually to indicate that there is a communication connection to the 
SITOP UPS1600. The LED flashes when the batteries are being replaced or for faults and 
alarms. 

Up to 6 SITOP UPS1100 of the same type can be connected in parallel with a 
SITOP UPS1600. 

When replacing a battery, see Chapter Battery replacement (Page 153). 

 

 
① DC input X1 
② Signal terminal X2 
③ Fuses F1/F2 (F2 only for 7 Ah and 12 Ah) 
④ Signaling (LED) 
⑤ Mounting rail holder (not for the 7 Ah and 12 Ah versions) 
⑥ Natural convection 
⑦ Clearance above 

Image 2-2 SITOP UPS1100 design (example 6EP4133-0GB00-0AY0) 

 

 Note 

For the UPS1100, clearance is required above it in order to open the cover. Clearance below 
is not required for thermal reasons - however, space is required to feed in the cable. 
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2.2 Connections and terminal designation 

2.2.1 SITOP UPS1600 

2.2.1.1 Power terminals 
The input terminals ① can be used to establish the connection to the supply voltage. The 
output terminals ② are used to connect to the supplied loads. 

Cables must be used that are suitable for at least 90° C (only when UL508 must be complied 
with). 

The UPS1100 battery modules are connected via BAT ③. 

(see also Chapter Installation (Page 149)) 
 
Connections and terminal designations (see Image 2-1 SITOP UPS1600 design (example 6EP4136-
3AB00-2AY0) (Page 15)) 

① DC input IN+, IN- One screw terminal each 

② DC output OUT+, OUT- One screw terminal each 

③ BAT+, BAT- One screw terminal each 

④ Signal connector Connector with 14 screw terminals 

⑤ PROFINET (Ethernet) connection RJ45 plug-in contact (only for ...-2AY0) 

⑥ USB connection USB-B plug-in contact (only for...-1AY0) 

 

 
Image 2-3 Terminal data SITOP UPS1600 10 A, 20 A 
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Image 2-4 Terminal data SITOP UPS1600 40 A 

2.2.1.2 Signal terminal 

 
Image 2-5 Signal connector 

 
Image 2-6 Signal connector connection schematic 

 
Pin Terminal designation Function 

1 BAT. 24 V DC OK / BAT 
REL1 (changeover contact):  
   Energized state: Normal operation 
Quiescent state: Buffer mode or off 

2 - 
3 OK 

4 ALARM Ready for buffer operation / alarm 
REL2 (changeover contact): 
   Energized state: Buffer mode is possible 
   Quiescent state: Not ready for buffering 
   Cycle 0.25 Hz: Defective battery 

5 - 
6 RDY TO BUFFER 

7 BAT. > 85 % Battery > 85% 
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Pin Terminal designation Function 
8 - REL3 (NO contact): 

   Energized state: Buffering of the selected buffer time is possible, or charge state 
>85% 

9 ON/OFF On/Off (buffer operation permitted/prevented) 
10 - - 
11 BAT. X2.1 Battery communication or charging current setting 
12 BAT. X2.2 Battery supply or charging current setting 
13 INTERRUPT Interrupt (interruption of the output voltage) 
14 START Start from the battery 

Relay contact: Maximum contact rating 30 V DC / 1 A or 125 V AC / 0.3 A 

The jumper (4a) (see Image 2-5 Signal connector (Page 18)) between pin 9 and 10 is 
necessary to operate the device in buffer mode. 

Delivery state: Jumper between pin 9 and 10 

2.2.1.3 USB port 

 
Image 2-7 USB port 

The USB interface (type B) ⑥ fully conforms to the USB 2.0 standard (12 MBd). Strain relief 
(see Section USB connector (Page 140)) is implemented using a defined cable/connector 
(Y-Con USB - Yamaichi). 

2.2.1.4 PROFINET/Ethernet connection 

 
Image 2-8 PROFINET/Ethernet connection 

Ethernet interface ⑤ corresponds to the standard full duplex with up to 100 Mbit/s electrical 
(100BASE-TX) according to IEEE 802.3.. 
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Properties of the Ethernet interface: 

● Transfer rate 10/100 Mbit/s 

● Two RJ45 sockets, i.e. integrated switch, for RJ45 connector 

● Cable type 100Base-TX (CAT5) 

● Auto negotiation 

● Auto crossover communication via TCP/IP and PROFINET 

The strain relief (see Section PROFINET/Ethernet connector (Page 141)) is implemented 
using a Siemens IE FastConnect RJ45. 

The physics of the Ethernet interface is implemented so that PROFINET IO according to 
standards IEC 61158 and IEC 61784-2 is possible. For PROFINET, conformance class B 
must be maintained as a minimum. 

The Ethernet/PROFINET interface permits: 

● Configuration and monitoring using the SITOP UPS Manager 

● Monitoring via the Web server 

● Integration and communication of the DC-UPS with other automation components from 
Siemens and the open environment, e.g. IPC, PLC, HMI 

● Firmware update of the device via UPS Manager, web server or STEP 7 
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2.2.2 SITOP UPS1100 

2.2.2.1 Power terminals 
Input terminals ① and signal terminal ② can be used to establish the connection to 
SITOP UPS1600. (also see Chapter Installation (Page 149)). 
 
Connections and terminal designations (see Image 2-2 SITOP UPS1100 design (example 6EP4133-
0GB00-0AY0) (Page 16)) 

① DC input +, - One screw terminal each 

② Signal terminal 1, 2 One screw terminal each 

 

 
Image 2-9  Terminal data for 6EP4131-0GB00-0AY0, 6EP4132-0GB00-0AY0, 6EP4133-0GB00 

and 6EP4133-0JB00-0AY0 

 

 
Image 2-10 Terminal data for 6EP4134-0GB00-0AY0 and 6EP4135-0GB00-0AY0 
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2.3 Operator controls 

2.3.1 SITOP UPS1600 

2.3.1.1 Rotary coding switch, switch-in threshold 
The switch-in threshold can be set using the rotary coding switch ⑦ on the device front 
between 21.0 V and 25.0 V (21 - 21.5 - 22 - 22.5 - 23 - 24 - 25 volt). The delivery state is 
22.5 V 

For devices with an interface (…-1AY0, …-2AY0), the coding switch has an additional REN 
position. If this is selected, the software settings (for the switch-in threshold and the backup 
time) apply rather than the hardware settings. In the switch position REN, the connection 
X2.13 (INTERRUPT - reset after buffer operation) of the signal terminal (see Section Signal 
terminal (Page 18)) has no effect. 

 
Image 2-11 Rotary coding switch, switch-in threshold 

 

 Note 

It is only permissible to operate the rotary switch using an insulated screwdriver. 
 

For notes on actuating the rotary coding switch (screwdriver, torque), see Image 2-3 
Terminal data SITOP UPS1600 10 A, 20 A (Page 17). 

2.3.1.2 Rotary coding switch, backup time 
The buffer time is set using the rotary coding switch ⑧ on the device front between 30 
seconds and MAX in steps of 0.5 minute (30 s), 1 minute, 2 minutes, 5 minutes, 10 minutes, 
20 minutes and MAX. The MAX setting means that buffering is realized for as long as 
possible. The device only shuts down when the battery has discharged down to the stop 
buffering voltage (factory setting, 18.5 V). Delivery state is MAX. 

The rotary coding switch has an additional setting OFF (see following diagram). If this is 
selected and the additional threshold rotary coding switch is not set to REN, then buffering is 
deactivated. 

If the buffer time is to be set using the software (only for devices with an interface (…-1AY0, 
…-2AY0)) (possible setting range, see Section Parameterizing SITOP UPS1600 (Page 70)), 
the rotary coding switch for the connection threshold (see Section Rotary coding switch, 
switch-in threshold (Page 22)) must be set to REN. 



 Description, device design, dimension drawing 
 2.3 Operator controls 

SITOP UPS1600 / UPS1100 
Manual, 04.2016, A5E37775406-6-76 23 

 
Image 2-12 Rotary coding switch, buffer time 

 

 Note 

It is only permissible to operate the rotary switch using an insulated screwdriver. 
 

For notes on actuating the rotary coding switch (screwdriver, torque), see Image 2-3 
Terminal data SITOP UPS1600 10 A, 20 A (Page 17). 

2.3.1.3 Jumper variants 

On/Off (pin 9) 

The wire jumper on the signal connector ④ between pin 9 and pin 10 (see Image 2-5 Signal 
connector (Page 18)) is used to enable/disable the buffer mode. 

Buffer operation is only possible if the ON/OFF wire jumper is connected. The ON/OFF wire 
jumper has priority over the position of the switch-in threshold rotary coding switch. Delivery 
state: Wire jumper is connected between pin 9 and 10 

As a consequence, buffer operation can be enabled or prevented using a floating contact 
(e.g. a contact in the plant or system). The contact is switched instead of the ON/OFF wire 
jumper. (Note: The contact in the switched-on state must have a resistance of < 10 Ohm, 
contact load must be a minimum of 15 V / 5 mA)  

 

 Note 

The external circuit must meet the requirements relating to SELV circuits according to 
EN60950-1. 

 

Changes are also effective in the buffer mode. 

Table 2- 1 With interface (up to firmware release less than V1.20) 

Rotary coding 
switch, 

buffer time 

Rotary coding 
switch, 

connection thresh-
old 

Wire jumper 
ON/OFF with respect to - 

Result 

OFF 21 - 25 Yes Buffering not permitted 
0,5 - MAX 21 - 25 Yes Buffer mode permitted 

(buffer time corresponding 
to the settings or maxi-
mum buffer time) 
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Rotary coding 
switch, 

buffer time 

Rotary coding 
switch, 

connection thresh-
old 

Wire jumper 
ON/OFF with respect to - 

Result 

OFF, 0,5 - MAX 21 - 25 No Buffering not permitted 
OFF, 0,5 - MAX REN Not relevant The software settings 

apply  
 

Table 2- 2 With interface (from firmware release V1.20 and higher) 

Rotary coding 
switch, 

buffer time 

Rotary coding 
switch, 

connection thresh-
old 

Wire jumper 
ON/OFF with respect to - 

Result 

OFF 21 - 25 Yes Buffering not permitted 
0,5 - MAX 21 - 25 Yes Buffer mode permitted 

(buffer time corresponding 
to the settings or maxi-
mum buffer time) 

OFF, 0,5 - MAX 21 - 25, REN No Buffering not permitted 
OFF, 0,5 - MAX REN Yes The software settings 

apply  
 

Table 2- 3 With interface (from firmware release V2.1) 

Rotary coding 
switch 

buffer time 

Rotary coding 
switch 

switch-in threshold 

Wire jumper 
ON/OFF with respect to - 

Result 

OFF 21 - 25 Yes Buffering permitted 
0,5 - MAX 21 - 25 Yes Buffer mode permitted 

(buffer time corresponding 
to the settings or maxi-
mum buffer time) 

OFF, 
0,5 - MAX 

21 - 25 REN No Buffering not permitted 

0,5 - MAX REN Yes The software settings 
apply 

OFF REN Not relevant The web server can be 
activated, and a temporary 
Internet address assigned 
(precondition: IP address 
is 0.0.0.0 (when deliv-
ered)) 
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Table 2- 4 Without interface 

Rotary coding 
switch, 

buffer time 

Rotary coding 
switch, 

connection thresh-
old 

Wire jumper ON/OFF with 
respect to - 

Result 

OFF 21 - 25 Not relevant Buffering not permitted 
0,5 - MAX 21 - 25 Yes Buffer mode permitted 

(buffer time corresponding 
to the settings or maxi-
mum buffer time) 

0,5 - MAX 21 - 25 No Buffering not permitted 

Interruption of the output voltage (pin 13) 

A wire jumper on the signal connector ④ between pin 13 and pin 10 is used to 
enable/disable the interruption of the output voltage, after the set buffer time expires, for the 
parameterized time (default value 5 seconds) when the line supply returns during the buffer 
time. The default value can only be changed for devices with USB or Ethernet/PROFINET 
interface. 

To prevent data losses, PCs must be shut down in time before the buffer time ends. If the 
input voltage returns after the shutdown has already started, the SITOP UPS1600 terminates 
the buffer mode and transitions into normal operation. The PC will be shut down, however, it 
is not switched off. PCs, which do not have an on/off switch, can only be rebooted by 
switching off the power and switching on again. When the "Interrupt output voltage" jumper is 
inserted, the UPS generates this pulse. 

Start from the battery (pin 14) 

The start from the battery is initiated by connecting pin 14 to pin 10. This jumper must not 
provide a permanent connection, but must be controlled using a button. The input is 
designed so that a single lamp with a permissible supply voltage of between 12 and 30 V 
and 8 to 15 mA can be switched in series to the switching contact. If the button is actuated 
when the input voltage is not available, and if buffering is permitted, then the UPS goes into 
the buffer mode. The UPS1600 shuts down if, at the end of the selected buffer time, an input 
voltage is still not available. 

The SITOP UPS1600 starts in normal operation if the input voltage is available. 

This can occur if the UPS was remotely shut down via the interface. 
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Charge current setting (pin 10 / 11 / 12) 

For uncoded batteries, the size of the charge current can be changed by placing jumpers 
between terminals X2.10 (-) and X2.11 or X2.12. These settings are only effective if the 
"Connection threshold" rotary coding switch is not set to REN. 

Table 2- 5 Charge current 

SITOP UPS1600  
10 A 

SITOP UPS1600  
20 A and 40 A 

Terminal X2.11 Terminal X2.12 

0.3 A 0.8 A open open 
0.8 A 1.75 A open connected with X2.10 
Max. Max. connected with X2.10 open 

Remark 
The charge current can be automatically reduced if the charge current plus the load current 
at the UPS1600 results in an overload of the feeding power supply. The charge current can 
also be reduced if the ambient temperature of the UPS1600 is higher than 40 °C - or if the 
input voltage at the UPS1600 is less than 24 V. 
Derating: 
10 A: 3 A-->2 A 
20 A: 4 A-->3 A 
40 A: 5 A-->3 A 

2.3.2 SITOP UPS1100 

2.3.2.1 Buttons for battery replacement 
For the SITOP UPS1100, below the cover there is a button ⑧ for battery replacement. 

Battery change, see Battery replacement (Page 153) 

 

 
Image 2-13 Buttons for battery replacement 
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2.4 Operating displays and signaling 

2.4.1 SITOP UPS1600 

2.4.1.1 LEDs 
 

 6EP4134-3AB00- ... 
6EP4136-3AB00- ... 
6EP4137-3AB00- ... 

Status display 
 
 
 
 
 
• Remark 

LED 1: Operating mode DC-UPS 
LED 2: Charge state 
LED 3: Buffer readiness 
LED 4: Battery test 
LED 5: for PROFINET-specific diagnostic displays 
LED 6: for PROFINET-specific diagnostic displays 
LED 7: Connection status Ethernet port 1 
LED 8: Connection status Ethernet port 2 
LEDs 7 and 8 are only active for... -2AY0 

 

 
LEDs Labeling, just the same as at the housing Description 
LED 1 O.K./BAT. Operating mode DC-UPS 
LED 2 BAT. > 85 % Charge state 
LED 3 ALARM Ready for buffering 
LED 4 BAT. FAULT Battery test 
LED 5 SF for PROFINET-specific diagnostic dis-

plays 
LED 6 RUN for PROFINET-specific diagnostic dis-

plays 
LED 7 P2 Connection status Ethernet port 1 
LED 8 P1 Connection status Ethernet port 2 

 
Image 2-14 Operating displays 
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Legend: 
 

  LED off 

  LED lights up 
 0.5/3 LED flashes in the interval: 0.5 s on - 3 s off 

 

LED 1 (O.K./BAT) 
 

Signaling 6EP4134-3AB00- ... 
6EP4136-3AB00- ... 
6EP4137-3AB00- ... 

 Off DC-UPS off 

 Red DC-UPS defect (severe hardware fault) 

 Flashing red (0.5/0.5) Firmware update 

 Flashing red (1/1) Software corrupted 

 Flashing yellow 
(0.5/0.5) 

Critical temperature reached, overtemperature or overvoltage at the input. 

 Flashing yellow (0.5/3) Buffer mode, output off 

 Yellow Buffer mode, output on 

 Flashing green (0.5/3) DC-UPS OK, output off 

 Green DC-UPS OK, output on 

 

LED 2 (BAT>85 %) 
 

Signaling 6EP4134-3AB00- ... 
6EP4136-3AB00- ... 
6EP4137-3AB00- ... 

 Flashing green 
(0.5/0.5) 

Firmware update 

 Off Battery charge state <85 % 

 Green Battery charge state >85 % 

 

LED 3 (alarm) 
 

Signaling 6EP4134-3AB00- ... 
6EP4136-3AB00- ... 
6EP4137-3AB00- ... 

 Red Output off for 45 seconds because of overcurrent, overtemperature or buffer operation not 
possible 

 Off Buffer operation possible 
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LED 4 (battery/BAT.Fault) 
 

Signaling 6EP4134-3AB00- ... 
6EP4136-3AB00- ... 
6EP4137-3AB00- ... 

 Off Battery O.K. or uncoded battery modules connected or buffer time rotary coding switch at 
position MAX 

 Flashing yellow 
(0.5/0.5) 

Battery outside the permitted temperature range 

 Red Battery defective 

 Yellow Selected buffer time cannot be attained 

 

LED 5 and LED 6 (PROFINET LEDs) 
 

Signaling 6EP4134-3AB00-2AY0 
6EP4136-3AB00-2AY0 
6EP4137-3AB00-2AY0 

LED 5 (SF) LED 6 (RUN)  

 Off  Off No connection to a PROFINET IO controller 

 Off  Flashing green 
(0.5/0.5) 

Configuration by the PROFINET IO controller 

 Off  Green Application started successfully, module O.K. 

 Red  Green Application started successfully, module not O.K. 

 Flashing red (0,1/0,1)  Green Application in progress, diagnosis can be called 

 Flashing red (0.5/0.5)  Flashing green 
(0.5/0.5) 

Self-test running (flashing alternately every 3 s) 

 Flashing red (0.5/0.5)  Off DCP requires device identification (LED flashes for 
3 seconds) 

 Flashing red (0.5/0.5)  Flashing green 
(0.5/0.5) 

Firmware update 

LEDs 5 and 6 are active only for ... -2AY0. 

 

LED 7 (Ethernet LED / P2) 
 

Signaling 6EP4134-3AB00-2AY0 
6EP4136-3AB00-2AY0 
6EP4137-3AB00-2AY0 

 Off Device not connected with controller  

 Green Device connected with controller, no activity 

 Green/orange alternately Device connected with controller, send/receive data (RX/TX) 
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LED 7 is active only for ... -2AY0 

LED 8 (Ethernet LED / P1) 
 

Signaling 6EP4134-3AB00-2AY0 
6EP4136-3AB00-2AY0 
6EP4137-3AB00-2AY0 

 Off Device not connected with controller  

 Green Device connected with controller, no activity 

 Green/orange alternately Device connected with controller, send/receive data (RX/TX) 

LED 8 is active only for ... -2AY0 

2.4.1.2 Relay outputs 

 
Image 2-15 Signal connector connection schematic 

 

 REL1 (changeover contact): 
Energized state: Normal operation (X2.2 - X2.3) 
Deenergized state: Buffer mode or off 

 REL2 (changeover contact): 
Energized state: Buffer operation is possible (X2.5 - X2.6) 
Deenergized state: Not ready for buffering 
Cycle 0.25 Hz: Battery defective or set buffer time is not reached. 

REL3 (NO contact): 
Energized state: Buffering of the selected buffer time is possible, or charge state > 85 %. 
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2.4.2 SITOP UPS1100 

2.4.2.1 LEDs 
 

 6EP4131-0GB00-0AY0 (1.2 Ah) 
6EP4132-0GB00-0AY0 (2.5 Ah) 
6EP4133-0GB00-0AY0 (3.2 Ah) 
6EP4133-0JB00-0AY0 (5 Ah) 
6EP4134-0GB00-0AY0 (7 Ah) 
6EP4135-0GB00-0AY0 (12 Ah) 

Status display LED battery 

 

 
Image 2-16 6EP4131-0GB00-0AY0 example 

 

Table 2- 6 LED ④ battery 

Signaling 6EP4131-0GB00-0AY0 (1.2 Ah) 
6EP4132-0GB00-0AY0 (2.5 Ah) 
6EP4133-0GB00-0AY0 (3.2 Ah) 
6EP4133-0JB00-0AY0 (5 Ah) 
6EP4134-0GB00-0AY0 (7 Ah) 
6EP4135-0GB00-0AY0 (12 Ah) 

 Flashing green 
(0.5/0.5) 

Error or alarm, battery replacement initiated 

 Off Battery off, no communication 

 Green Battery OK 
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2.5 Block diagram 

2.5.1 SITOP UPS1600 

 
Image 2-17 Block diagram SITOP UPS1600 
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2.5.2 SITOP UPS1100 

 
Image 2-18 Block diagram SITOP UPS1100 
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2.6 Dimensions and weight 

2.6.1 SITOP UPS1600 

 
Image 2-19 6EP4134-3AB00-0AY0, 6EP4134-3AB00-1AY0, 6EP4136-3AB00-0AY0,6EP4136-

3AB00-1AY0 dimensioned drawing 

 
Image 2-20 6EP4134-3AB00-2AY0, 6EP4136-3AB00-2AY0 dimensioned drawing 
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Image 2-21 Dimension drawing 6EP4137-3AB00-0AY0, 6EP4137-3AB00-1AY0 

 
Image 2-22 Dimension drawing 6EP4137-3AB00-2AY0 
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 6EP4134-3AB00-0AY0 6EP4134-3AB00-1AY0 6EP4134-3AB00-2AY0 
Dimensions (W × H × D) in 
mm 

50 × 138.7 × 125 50 × 138.7 × 125 50 × 138.7 × 125 

Weight Approx. 0.38 kg Approx. 0.4 kg Approx. 0.45 kg 

 
 

 6EP4136-3AB00-0AY0 6EP4136-3AB00-1AY0 6EP4136-3AB00-2AY0 
Dimensions (W × H × D) in 
mm 

50 × 138.7 × 125 50 × 138.7 × 125 50 × 138.7 × 125 

Weight Approx. 0.39 kg Approx. 0.41 kg Approx. 0.45 kg 

 
 

 6EP4137-3AB00-0AY0 6EP4137-3AB00-1AY0 6EP4137-3AB00-2AY0 
Dimensions (W × H × D) in 
mm 

70 × 138.7 × 150 70 × 138.7 × 150 70 × 138.7 × 150 

Weight Approx. 0.65 kg Approx. 0.65 kg Approx. 0.7 kg 

2.6.2 SITOP UPS1100 

 
Image 2-23 6EP4131-0GB00-0AY0 dimensioned drawing 
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Image 2-24 Dimension drawing 6EP4132-0GB00-0AY0  

 
Image 2-25 6EP4133-0GB00-0AY0 dimensioned drawing 
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Image 2-26 Dimension drawing 6EP4133-0JB00-0AY0 

 
Image 2-27 6EP4134-0GB00-0AY0 dimensioned drawing 
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Image 2-28 Dimension drawing 6EP4135-0GB00-0AY0 

 

 6EP4131-0GB00-0AY0 
(1.2 Ah) 

6EP4132-0GB00-0AY0 
(2.5 Ah) 

6EP4133-0GB00-0AY0 
(3.2 Ah) 

Dimensions (W × H × D) in 
mm 

89 × 130.3 × 106.7 265 × 115 × 76 190 × 169.3 × 78.7 

Weight Approx. 1.9 kg Approx. 3.7 kg Approx. 3.8 kg 
 

 

 6EP4133-0JB00-0AY0 
(5 Ah) 

6EP4134-0GB00-0AY0 
(7 Ah) 

6EP4135-0GB00-0AY0 
(12 Ah) 

Dimensions (W × H × D) in 
mm 

189 × 185.5 × 112.7 186 × 186 × 110.3 253 × 186 × 110 

Weight Approx. 3.4 kg Approx. 6.1 kg Approx. 9.8 kg 
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 Engineering and remote access 3 
3.1 General 

This section describes the software tools offered by Siemens that are compatible with 
SITOP UPS1600 . The software tools are introduced with their functions, the associated 
requirements and the operation. The software products are: 

● SIMATIC STEP 7 in the TIA Portal 

● SIMATIC STEP 7 

● SITOP UPS Manager 

● Web server 

Functions of the individual software products 

● SIMATIC STEP 7 in the TIA Portal 
The SITOP UPS1600 can be used with STEP 7 in the TIA portal 12 with service pack 1 
(SP1). 
From SW version V2.1, STEP 7 can be used in the TIA Portal from Version 13. 
After SITOP UPS1600 has been saved in the hardware catalog of STEP 7 in the TIA 
Portal it can be integrated in the project, parameterized and diagnosed. 

● SIMATIC STEP 7 
SITOP UPS1600 can be used with STEP 7 from Version 5.4. 
After SITOP UPS1600 has been integrated in the hardware catalog of STEP 7 it can be 
integrated in projects, parameterized and diagnosed. 

● SITOP UPS Manager 
Using the SITOP UPS Manager , the SITOP UPS1600 can be parameterized. In addition, 
the protection of individual computers or computer networks can be determined by 
shutdown conditions after the failure of the supply voltage. 

● Web server 
The web server is used to monitor the SITOP UPS1600. It operates independently of the 
UPS Manager and the PROFINET access. 

 

 Note 

SIMATIC STEP 7 and the SITOP UPS Manager cannot simultaneously access the 
SITOP UPS1600. 
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3.2 Overview of application examples 
At our support web site you can find the following application example to parameterize the 
SITOP UPS1600 uninterruptible power supply: 

● "SITOP UPS1600: Graphic blocks and STEP 7 communication blocks" to integrate 
SITOP UPS1600 into an automation system : 
(https://support.industry.siemens.com/cs/ww/en/view/78817848) 

https://support.industry.siemens.com/cs/ww/en/view/78817848
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3.3 SIMATIC STEP 7 in the TIA Portal 

3.3.1 Introduction 
The uninterruptible power supply SITOP UPS1600 can be used with SIMATIC STEP 7 in the 
TIA Portal from Version 12 with service pack 1 (SP1). From SW version V2.1, STEP 7 can 
be used in the TIA Portal from Version 13.  

In SIMATIC STEP 7 in the TIA Portal , the basic device SITOP UPS1600 and its battery 
modules SITOP UPS1100 can be integrated in projects, parameterized and diagnosed. 

 

 Note 

In order to use SITOP UPS1600 with SIMATIC STEP 7 in the TIA Portal, then you must 
install the corresponding Hardware Support Package (HSP) or the corresponding generic 
station description file (GSD). Using UPS1600 with HSP is only possible from TIA Version 
V13. In TIA Version V12, only using GSD. 

You can find additional information at Installing the Hardware Support Package (HSP) 
(Page 43) or Installing the generic station description file (GSD) (Page 45). 

 

 Note 

TIA and SITOP UPS Manager cannot simultaneously access SITOP UPS1600. The service 
of the SITOP UPS Managers may not run while the system is accessed via TIA. 

 

3.3.2 Installing the Hardware Support Package (HSP) 
To use SITOP UPS1600, you must install the corresponding Hardware Support Package 
(HSP) in the TIA Portal . This HSP is available at our SITOP-homepage 
(http://www.siemens.com/sitop-ups1600) or directly under 
(https://support.industry.siemens.com/cs/ww/en/view/75854606). 

http://www.siemens.com/sitop-ups1600
https://support.industry.siemens.com/cs/ww/en/view/75854606
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Procedure 

To install the Hardware Support Package, proceed as follows: 

1. Start STEP 7 in the TIA Portal. 

2. In the "Options" menu, click on "Support Packages". 

 
Dialog "Detailed information" opens. 

All Support Packages from the directory that you specified as storage location for Support 
Packages in the settings are listed in a table. 

3. You have the following possibilities to install the Hardware Support Package: 

– If the Support Package is already present on your computer or on the supplied DVD, 
you can add it to the list from the "Add from the file system". 

– If you want to add a Support Package from the "Service & Support" page in the 
Internet, download it with "Load from the Internet". 
You can then add it to the file system. 

4. Select the support package that you want to install. 

5. Click on "Install", and follow the instructions of the installation program. During the 
installation you will be prompted to close all TIA Portal instances. 

6. Close all TIA Portal instances and click on "Continue". 

7. After the Support Package has been installed, the TIA Portal is reinitialized by clicking on 
"Restart". 

The installed devices are imported into the module catalog and can then be integrated in 
the project.  

You can find the SITOP UPS1600 in the hardware catalog under "Power Supplies\SITOP 
UPS\UPS1600". 

 

 Note 

You can find additional information on installing hardware support packages in the manual of 
your STEP 7 software. 

 



 Engineering and remote access 
 3.3 SIMATIC STEP 7 in the TIA Portal 

SITOP UPS1600 / UPS1100 
Manual, 04.2016, A5E37775406-6-76 45 

3.3.3 Installing the generic station description file (GSD) 
As an alternative to installing the hardware support package (HSP), in the TIA Portal you can 
also install the generic station description file (GSD) in order to be able to use the UPS1600. 
The GSD is available at our SITOP-homepage (http://www.siemens.com/sitop-ups1600) or 
directly at (https://support.industry.siemens.com/cs/ww/en/view/75854605). 

Preconditions 

● You know where the GSD file is saved. 

Procedure 

To install the generic station description file, proceed as follows: 

1. Download the GSD file from the Internet. 

2. Start STEP 7. 

3. In the project view, click in the menu "Options" on "Install general station description file 
(GSD)" or "Manage general station description file (GSD)". 

 
The "Manage general station description file (GSD)" dialog is opened. 

4. Select the source path under which you locally saved the GSD file that you downloaded. 

5. Select the GSD file. 

6. Click on "Install", and follow the instructions of the installation program. 

The installed devices are imported into the module catalog and can then be integrated in the 
project. You can find the UPS1600 in the hardware catalog at "Other field 
devices\PROFINET IO\I/O\Siemens AG\UPS1600". 

3.3.4 Inserting SITOP UPS1600 into a project 
To be able to use the SITOP UPS1600, you must assign it as IO device to an IO controller 
(SIMATIC S7 control). Further, SITOP UPS1600 can be equipped in the project with one or 
several SITOP UPS1100 battery modules. 

The main views used to configure the SITOP UPS1600 are the Network view and the Device 
view. 

 

http://www.siemens.com/sitop-ups1600
https://support.industry.siemens.com/cs/ww/en/view/75854605
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 Note 

Additional information on the Network view and Device view, as well as the Topology view is 
available in the manual for your STEP 7 software. 

 

Preconditions 

● The hardware support package or the general station description file of the 
SITOP UPS1600 has been installed. 

● STEP 7 in the TIA Portal has been opened, and a project with an IO controller (SIMATIC 
S7 control) has been created. 

Inserting SITOP UPS1600 from the hardware catalog 
1. Open the network view. 

2. Open the "Hardware catalog" task card. 

3. If you use the SITOP UPS1600 with the hardware support package:  
In the "Catalog" palette navigate to SITOP UPS1600 under Power Supplies\SITOP 
UPS\UPS1600. 

4. If you use the SITOP UPS1600 with the general station description file:  
In the "Catalog" palette, navigate to the SITOP UPS1600 under "Other 
devices\PROFINET IO\I/O\Siemens AG\UPS1600". 

5. Select the required SITOP UPS1600 using a mouse click. 
In the "Information" area you can see information about the selected SITOP UPS1600, 
and if necessary change the preselected version. 

6. Drag the SITOP UPS1600 and drop it into the Network view. 

 
Alternatively, you can add the module to the Network view by double-clicking on the entry 
in the hardware catalog. 

You have now inserted the SITOP UPS1600 into the project. The rectangle displayed in 
the network view symbolizes the SITOP UPS1600. 
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3.3.5 Assigning the SITOP UPS1600 to a controller 
To be able to use the SITOP UPS1600 you must assign an IO controller as IO device. 

1. Click in the network view on the blue lettering "Not assigned" at the left next to the symbol 
of the SITOP UPS1600. 

 
A menu opens with the available controllers. 

 
2. Select a controller in the menu. 

3. Select the connection between the controller and SITOP UPS1600. 

 
4. Make the required settings in the "Network data". 

5. Double-click on SITOP UPS1600 to display it in the device view. 
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6. Select the PROFINET-interface. 

 
7. Under "Ethernet addresses" in the inspector window enter the IP address of the 

SITOP UPS1600, which was already assigned in theTIA Portal. 

You have assigned a controller to the SITOP UPS1600. 

3.3.6 Assigning a battery module SITOP UPS1100 to the basic device SITOP 
UPS1600 

The basic functions of the uninterruptible power supply are available with all of the battery 
modules that are compatible with the SITOP UPS1600. The SITOP UPS100 5 Ah LiFePo 
battery is first supported by the UPS1600 with SW version V2.1. 
Additional functions are available with the SITOP UPS1100 battery module: 

● Automatic detection of the battery module rated values 

● Automatic management of up to six battery modules 

● Temperature-controlled charging 

● Battery fast test 

● Diagnostics using the SITOP UPS Manager and the web server 

Using an example, in the following steps, it is shown how the SITOP UPS1600 is assigned a 
SITOP UPS1100 battery module. 

 

 Note 

Only SITOP UPS1100 battery modules of the same type can be inserted into the slots of a 
SITOP UPS1600.  

The number of battery modules that can be configured is limited to six. The description is 
only applicable to devices that were linked to via the HSP. 

 

Preconditions 

● STEP 7 in the TIA Portal has been opened and a project has been created. 

● A SITOP UPS1600 has been integrated in the project. 
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Procedure 

The procedure is only applicable for devices integrated via HSP. 
For GSD devices, values can be manually specified for a (third-party) battery module; 
however, it is not necessary to add a battery module to the configuration. 

1. In the device view, select the SITOP UPS1600 basic device. 

2. In the Hardware catalog , navigate to the SITOP UPS1100 battery module under Power 
Supplies\SITOP UPS\UPS1100. 

3. Select the required battery module in the hardware catalog. 
In the "Information" area you can see information about the expansion module, and when 
necessary you can change the preselected (default) version. 

4. Drag the battery module and drop it into the Device view. 
Alternatively, the battery module can be added by double-clicking on the entry in the 
hardware catalog. 
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5. Drag the battery module and drop at the first free slot to the right next to the 
SITOP UPS1600. 
The battery module is inserted at the selected slot. 

 
6. Save the hardware configuration. 

You have assigned a battery module to the basic device SITOP UPS1600. 

How you change the number and type of SITOP UPS1100 battery modules used is 
described under Parameterizing UPS1600 with STEP 7 in the TIA Portal (Page 51). 



 Engineering and remote access 
 3.3 SIMATIC STEP 7 in the TIA Portal 

SITOP UPS1600 / UPS1100 
Manual, 04.2016, A5E37775406-6-76 51 

3.3.7 Parameterizing the UPS1600 
The adjustable parameters of the SITOP UPS1600 can be found in STEP 7 in the TIA Portal 
in the inspector window under Properties when the appropriate device was selected. 

For parameterization, in the area navigation, the settings under "Base Unit", "Energy 
storage" and "Webserver" are relevant.  

 
Navigation area Description 
Base Unit Buffering All parameters, which involve the behavior of SITOP UPS1600 when 

buffering 
Signaling Setting of the alarm signaling and the wait time for stable input voltage. 

Energy storage – Parameters for the battery modules used 
Web server General information Define as to whether the SITOP UPS1600 may be accessed via web 

server (yes / no) 
Activate web server on this module Automatic logoff / Active access only 
via HTTPS 

Automatic update Activate automatic update / Activation interval 

A detailed description of the individual parameters of the subgroups is contained in the 
associated section under Parameterizing the UPS in STEP 7 in the TIA Portal (Page 51). 

 

The procedure is the same for all parameters. This section describes the general procedure 
to reach the configuration dialog, using as example the parameters for buffering. The 
individual parameters and their possible values are described in the following subsections. 

Each parameter has a start value. A click on "Reset to initial values" resets all parameters of 
a subgroup to the associated start value. 

Preconditions 

● The SITOP UPS1600 was integrated in the opened project. 
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Proceed as follows 

1. Select the SITOP UPS1600 in the Device view. 

2. In the Inspector window, select "Properties " > "General > Device configuration". 

Entries for parameterization are provided in the navigation area. 

 

"Buffering" parameters 
 
Parameter Value range Initial value 
Buffering allowed Yes / No Yes 
Connection threshold 21 - 25 V 22.5 V 
Buffer time 1 - 32767 s 60 s 
Maximum buffer time 1) Yes / No No 
Additional buffer time after PC shutdown. 1 - 300 s 10 s 
Expected buffer current 1) 0 - 40 A 0 A 
Stop buffering voltage 18 - 23 V 18.5 V 
Enable reset Yes / No No 
Reset time 1 - 120 s 5 s 
Battery test interval 2) 1 - 65535 h 4 h 
 1) Parameter only available from SW version V2.0 and higher 

2) Parameter only available from SW version V2.1 and higher 

● Buffering permitted 
When the connection threshold is fallen below, selects whether the system is buffered or 
the output is shut down. 

● Switch-in threshold 
Setting the switch-in threshold. 

● Buffer time 
Length of time during which the system should be buffered by the SITOP UPS1600. 
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● Maximum buffer time 

The setting means that buffering is realized for as long as possible. The device only shuts 
down when the battery has discharged down to the defined stop buffering voltage. The 
value entered for the "Buffer time" parameter is not relevant in this case.  

● Additional buffer time after PC shutdown 
Time during which the system should be buffered by the SITOP UPS1600 after the PC 
was shut down. 

● Expected buffer current 

Load current, which is expected at the device output during buffer operation. If a value of 
0 A is entered, then for this parameter, the average value of the actual load current 
measured at the output over the last 10 min is assumed. The value of this parameter is 
used when calculating the remaining buffer time. The entered value may not exceed the 
rated device current. 

● Stop buffering voltage 
The voltage at which battery discharge is terminated. The stop buffering voltage defined 
for this type is always used for a coded battery (UPS1100). 

● Enable reset 
If the value is set to "Yes" then the output voltage is interrupted after the selected buffer 
time expires if, in the meantime, the input voltage returns. This option is useful, when, for 
example, computer networks are protected by the UPS that can be activated by a reset 
when the power supply is restored. For buffer time "MAX", the output voltage is not 
interrupted. 

● Reset time 
Here, you define the interrupt duration. 

"Signaling" parameter 
 
Parameter Value range Default setting 
Downtime alarm 0 - 20,000 ms 125 ms 
Wait time for stable input voltage 0.2 - 65 s 0.5 s 

● Downtime alarm 
The time in which no alarm is issued to the system although it is buffered. 

● Wait time for a stable input voltage 
Time where the input voltage must continually lie above the connection threshold so that 
buffering is exited and a transition is made into normal operation. 
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"Energy storage" parameter 
The "energy storage" has two different areas that depend on the battery type being used. 
First select whether you are using a SITOP UPS1100 battery module or some other energy 
storage device. 

Possible parameters when using a SITOP UPS1100 battery module 
 
Parameter Value range 
Module Drop-down menu with the SITOP UPS1100 battery modules saved by the HSP 
Number of modules 0 - 6 
Total capacity 0 - 42 Ah 

● Module 
Type of SITOP UPS1100 battery module. 

● Number of modules 
Number of the installed modules. 

● Total capacity 
Total capacity of the installed battery modules. 

Possible parameters for the deployment of a different battery module 
 
Parameter Value range Default setting 
Total capacity 0.1 - 3,200 Ah 10 Ah 
End-of-charge voltage 24 - 30 V 26 V 
Charge current 0.001 - 4 A 0.8 A 
Faulty battery voltage 1 - 18 V 6 V 

● Total capacity 
Total capacity of the installed batteries. 

● End of charge voltage 
Maximum voltage up to which the battery may be charged. 

● Charge current 
The battery is not charged with more than the selected charge current. The 
manufacturer's details for the permitted battery charge current must be observed. 
Further, the following, device-dependent values apply: 

– SITOP UPS1600 10 A: Maximum permissible charge current 3,000 mA 
Derating for Tu > 40 °C or Uin < 24 V: 2,000 mA 

– SITOP UPS1600 20 A: Maximum permissible charge current 4,000 mA 
Derating for Tu > 40 °C or Uin < 24 V: 3,000 mA 

– SITOP UPS1600 40 A: Maximum permissible charge current 5,000 mA 
Derating for Tu > 40 °C or Uin < 24 V: 3,000 mA 

Faulty battery voltage 
If the battery voltage undershoots this value, it is considered as being faulty by the 
SITOP UPS1600 and is not charged. 
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"Web server" parameters 
 
Parameter Value range Default setting 
Activate web server on this module Yes / No Yes (up to V2.0) 

No (from V2.1) 
Permit access only with HTTPS Yes / No Yes 
Log off automatically after 15 minutes Yes / No No 
Update interval 0 / 5 s / 10 s / 20 s / 30 s / 60 s 10 s 

Set here whether access to the UPS via web server is permitted. 

● Activate web server on this module 
Define whether this device can be accessed via the web server. 

● Permit access only with HTTPS 
Define whether access is only permissible via HTTPS. 

● Download certificate 
By pressing the "Download certificate" button, you can download the certificate for 
encrypted connection via HTTPS. 

● Log off automatically after 15 minutes 
You define whether a user should be automatically logged off after closing the web 
server. 

● Update interval 
You define in which intervals the actual values are sent to the web server. 

3.3.8 Loading the configuration (commissioning) 
In the delivered state, the SITOP UPS1600 has not yet been assigned an IP address and the 
DHCP protocol is deactivated. 

When the SITOP UPS1600 is first connected with a controller (SIMATIC S7- control system), 
it must be assigned a device name and an IP address by the controller. A new configuration 
can be loaded to the device using STEP 7 in the TIA Portal . 

Identifying a SITOP UPS1600 in the network 
From the STEP 7 in the TIA Portal , you can get the LED "SF" at the SITOP UPS1600 to 
flash. This means that you can clearly identify a module in the network, e.g. if several 
SITOP UPS1600 are installed in the network. 

Preconditions 

● The SITOP UPS1600 has been correctly connected and linked with the network. 

● PG/PC with STEP 7 in the TIA Portal is connected with the network. 
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Proceed as follows 

1. Open the "Online > Accessible nodes" menu. 

2. As type of PG/PC interface, select "PN/IE". 

3. Select the PG/PC interface connected with the system. 

4. Select the connection with the subnet, in which the SITOP UPS1600 is located. 
All of the available SITOP UPS1600 devices in the selected subnet are displayed. 

5. Select the required SITOP UPS1600. 

6. Activate the "Flash LED" checkbox. 

 
7. Check at which SITOP UPS1600 in the network the "SF" LED flashes. 

By checking the flashing LEDs, you can uniquely identify all SITOP UPS1600 in a network. 
Note the device name and the IP address of the required SITOP UPS1600 in order to load a 
configuration. 

Changing the device name of the SITOP UPS1600 
1. In STEP 7 , in the tabular area of the Network view, select the "Network overview" table. 

2. Overwrite the name in the "Device" column in the row of the PROFINET device involved. 

You have changed the name of the SITOP UPS1600 device. 

The name is adapted in the graphical area of the network view. 

Changing the PROFINET device name of the SITOP UPS1600 via the properties of the PROFINET 
interface 

You can change the PROFINET device name using the properties of the PROFINET 
interface. 

1. In the Network or Device of view of the hardware and network editor from STEP 7, select 
the PROFINET interface of a PROFINET device. 

2. In the Inspector window navigate to "Ethernet addresses" in the "PROFINET" area. 

3. Deactivate the "Generate automatically the PROFINET device name" checkbox. 

4. Enter the new PROFINET device name in the appropriate field. 
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Changing the IP address of a SITOP UPS1600 
1. In the Network or Device view of the hardware and network editor from STEP 7 in the TIA 

Portal , select PROFINET interface of a PROFINET device. 

2. In the Inspector window navigate to "Ethernet addresses" in the "IP protocol" area. 

3. Check whether the "Set IP address in the project" option is activated. 

4. Enter the new IP address in the appropriate field. 

Loading the configuration to the SITOP UPS1600 
To commission the UPS, you must load the project data that you created offline into the 
connected SITOP UPS1600. This project data results from the configuration of the hardware, 
networks and connections in STEP 7. 
Initially, the complete project data is loaded. Only the changes are loaded for subsequent 
load actions. 

Preconditions 

● The project data is consistent. 

● The device name must be identical offline and online. 

● The SITOP UPS1600 is accessible online. 

● The SITOP UPS1600 is located in the PROFINET IO system of an IO controller. 

● The PG/PC is connected to the same network to which the SITOP UPS1600 and the 
controller are connected. The interface of the PG/PC must be set to TCP/IP. 

 

 Note 

Ensure that the article number of the SITOP UPS1600 configured offline matches the article 
number of the device connected online. The following response is obtained after loading the 
configuration into the device: 
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Image 3-1 Online / offline 
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Procedure 

1. In the "Project tree", right-click on the SITOP UPS1600 controller. 
The shortcut menu opens. 

 
2. In the shortcut menu, in submenu "Download to device", select option "Hardware 

configuration". 

The project data are compiled. The "Load" button is activated as soon as loading is 
possible. 

3. Click on "Load". 

Data is loaded. The "Result of the load operation" dialog window is then opened. In this 
dialog, you can check whether the load task was successful and select any further 
actions. 

4. Click on the "Finish" button. 

Result 

The set parameters have been loaded to the SITOP UPS1600 via the controller. 
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3.3.9 Diagnostics 
The following data can be retrieved using the online and diagnostics function: 

 
Navigation area Value 
General Module Short designation 

Article number 
Hardware 
Firmware 

Module information Device name 
Module name 
Plant designation 
Location ID 

Manufacturer information Description of manufacturer 
Serial number 
Copyright entry 
Profile 
Profile details 

PROFINET interface Ethernet address / network connec-
tion  

MAC address 

Ethernet address / IP parameter IP address 
Subnet mask 
Default router 
IP settings 
IP setting time 

Ports List of ports 
Functions Assign an IP address MAC address 

IP address 
Subnet mask 
Router address 

Firmware update / UPS1600 Article number 
Firmware 
Name 
Rack 
Slot 
Firmware file 
Firmware version 
Suitable for modules with 
Status 
Activate firmware after update 

Assign name PROFINET device name 
Type 

Reset to factory settings MAC address 
IP address 
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Navigation area Value 
PROFINET device name 

Retrieve the online and diagnostics data of SITOP UPS1600 
Proceed as follows to start the online and diagnostics view of the particular module:  

Project tree: 

1. Open the device folder of the SITOP UPS1600 in the Project tree. Is located (after the 
assignment to the control system) in the folder of the control system under "Distributed 
I/O " > [name of the PROFINET connection] 

2. Double-click on "Online & diagnostics". 

Alternatively: 

3. Select the device folder of the SITOP UPS1600 in the Project tree. 

4. In the shortcut menu or in the "Online" main menu, select the "Online & diagnostics" . 

Device view: 

1. Open the device view of the device configuration. 

2. Select the SITOP UPS1600. 

3. In the shortcut menu or in the "Online" main menu, select the "Online & diagnostics" . 

Network view: 

1. Open the network view of the device configuration. 

2. Select the SITOP UPS1600. 

3. In the shortcut menu or in the "Online" main menu, select the "Online & diagnostics" . 

4. Click on "Connect online". 

The information is displayed under "Diagnostics / General". 
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3.3.10 Firmware update 
 

 WARNING 

The SITOP UPS1600 is reset while updating the firmware. For safety reasons, the output is 
switched off. 

Ensure that no damage is caused to the plant or system. 

Ensure that the PG/PC and/or all switches, routers and gateways that are used have an 
independent power supply during the firmware update. 

 

 Note 

Do not switch-off the devices during the firmware update. 
 

The files for updating the firmware (firmware updates) are available online under 
(http://support.automation.siemens.com/WW/view/en/79207181). Different firmware updates 
are offered depending on the amp rating of the SITOP UPS1600. 

 

 Note 
Observe the compatibility of the firmware! 

Other firmware updates are not compatible. 

Determine the amp rating of your SITOP UPS1600 and download the appropriate firmware 
update. 

 

 Note 

It is not possible to downgrade the device firmware to a release with a version number lower 
than the firmware installed in the device itself. Information on how to read out the firmware 
release from the device is provided in Section Diagnostics (Page 60). 

 

 Note 
"Reset to factory" function: 

Everything is reset, also the IP address. A new IP address must then be assigned, as 
otherwise there is no connection to the UPS Manager or TIA. 

 

Preconditions 

● The SITOP UPS1600 has been correctly connected and linked with the system. 

● PG/PC with STEP 7 in the TIA Portal is connected with the system. 

● Online connection is established. 

http://support.automation.siemens.com/WW/view/en/79207181
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Procedure 

The firmware update consists of several files, which are combined in a zip file. 

1. Download the firmware update. 

2. Unpack the ZIP file into a temporary directory. 

3. In the network view, select the components whose firmware is to be updated. 

4. Change to the device view. 

5. Click on "Go online". 

6. In the shortcut menu of the SITOP UPS1600, select "Online & Diagnostics". 
The "Online access" menu opens. 

 
7. In the "Functions" folder, select the "Firmware update" group. 

8. Click on the "Browse" button in the "Firmware loader" area to select the path to the 
directory with the unzipped files. 

9. Select file "ups10a.upd", "ups20a.upd", "ups40a.upd". All SITOP UPS1600 are displayed 
in the table, for which an update is possible with the selected firmware file. 

10.Click on the "Start update" button. If the selected file can be interpreted by the module, it 
will be loaded into the module. For version V2.1 - depending on the UPS1600 type - the 
firmware file is called "ups20a.upd", for example. If this requires changing the operating 
state of the CPU, you will be prompted to do this with dialogs. 

11.Confirm the notes that are displayed. 
The firmware is sent from the controller to the component . While sending, LED 4 ("SF") 
and LED 6 ("RUN") flash at the SITOP UPS1600. 

12.Confirm the message from the TIA Portal that the data was successfully sent by pressing 
"OK".  
The firmware is saved in the internal component memory. The following LEDs flash while 
saving: 

– LED 1 ("OK/Bat") 

– LED 2 (">85%") 

 
  Note 

It can take several minutes to save the firmware in the component. Do not switch-off the 
devices. 

 



Engineering and remote access  
3.3 SIMATIC STEP 7 in the TIA Portal 

 SITOP UPS1600 / UPS1100 
64 Manual, 04.2016, A5E37775406-6-76 

13.The device is automatically restarted after the LEDs no longer flash. 

 
  Note 

During the firmware update, if the power supply of the SITOP UPS1600, or PG/PC or 
intermediate switches, routers or gateways is interrupted, then under certain 
circumstances, a fallback firmware is activated. If the SITOP UPS1600 can then no 
longer be accessed remotely, you must assign the a new IP address, or under the menu 
item "Assign name" you must enter a new name in the field "PROFINET device names" 
(see the manual for the particular unit). 

 

14.The firmware has been updated. Only now is it permissible to switch off the 
SITOP UPS1600. 

 

 Note 

After updating the firmware, in the hardware configuration of your project, you must replace 
the SITOP UPS1600 involved by SITOP UPS1600 with the current firmware version. The 
configured configuration then matches the actual configuration again. 

 

 Note 

For GSD, the SITOP UPS1600 must be deleted, and newly integrated; this means that 
parameters, addresses and names must be newly set - and it is also possible that a new 
GSD file must first be installed. 
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3.3.11 Restore factory settings 
A reset to the factory settings deletes all configurations of the PROFINET interface saved in 
the SITOP UPS1600 and restores the factory settings. This affects, for example: 

● IP address 

● Device name 

The parameter values for SITOP UPS1600 and the energy storage device are kept. 

Proceed as follows to reset the SITOP UPS1600 factory settings: 

1. Select SITOP UPS1600 in the Network view and change to the Device view. 

2. Click on "Go online". 

3. In the SITOP UPS1600 shortcut menu, select "Online & diagnostics". 

4. In the "Functions" folder, select the "Reset to factory settings" group. 

 
5. Click on the "Reset" button. 

6. Respond to the confirmation prompt with "OK". 
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3.4 SIMATIC STEP 7 

3.4.1 Introduction 
The uninterruptible power supply SITOP UPS1600 can be used with SIMATIC STEP 7 from 
Version 5.4 and higher. 

In SIMATIC STEP 7 , the basic device SITOP UPS1600 and its SITOP UPS1100 battery 
modules can be integrated in the project, parameterized and diagnosed. 

 

 Note 

SIMATIC STEP 7 and the SITOP UPS Manager cannot simultaneously access the 
SITOP UPS1600. It is not permissible that the SITOP UPS Manager service runs while the 
system is being accessed via SIMATIC STEP 7. 

 

3.4.2 Installing the generic station description file (GSD) 
To use the SITOP UPS1600 and the SITOP UPS1100 battery modules in SIMATIC STEP 7, 
you must install the corresponding generic station description file (GSD). The GSD file is 
available at our SITOP-homepage (http://www.siemens.com/sitop-ups1600) or directly at 
(https://support.industry.siemens.com/cs/ww/en/view/75854605). 

Preconditions 

● SIMATIC STEP 7 has been opened and a project has been created. 

● At least one station has been added. 

● You know where the GSD data have been saved. 

Procedure 

1. Download the GSD file from the Internet. 

2. Close all stations in HW Config. 

3. Click on "Browse ...", and select the folder in which the GSD file is located. 

4. Select the GSD file and click on "Install". 

 
  Note 

If the file was not able to be installed, or if errors occurred during installation, then 
SIMATIC STEP 7 creates a report file. You can open this log file by clicking on the 
"Display log" button. 

 

5. In the "Options" menu, click on "Update Catalog". 

The installed devices are imported into the module catalog and can then be integrated in the 
project. You can find SITOP UPS1600 in the hardware catalog under 
"PROFINET IO\I/O\UPS1600". 

http://www.siemens.com/sitop-ups1600
https://support.industry.siemens.com/cs/ww/en/view/75854605
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3.4.3 Inserting SITOP UPS1600 into a project 
To be able to use the SITOP UPS1600, it must be assigned as IO device to an IO controller 
(SIMATIC S7 control system) . 

Preconditions 

● The GSD file of the SITOP UPS1600 has been correctly installed. 

● SIMATIC STEP 7 has been opened, and a project with an IO controller (SIMATIC S7 
control) has been created. 

Creating a subnet 
1. Open the Hardware view "HW Config". 

2. Call the shortcut menu of line "PN-IO" 

3. Select "Insert PROFINET IO system". 

 
4. In dialog field "Properties - Ethernet interface PN-IO", select the "Parameters" tab. 

5. Set the IP address of the PROFINET interface. 



Engineering and remote access  
3.4 SIMATIC STEP 7 

 SITOP UPS1600 / UPS1100 
68 Manual, 04.2016, A5E37775406-6-76 

6. Create a new subnet. 

 
7. Confirm the properties of the new subnet. 

8. Close the "Properties - Ethernet interface PN-IO" dialog box. 

The subnet is displayed as a horizontal line in the hardware view. 

 

Inserting SITOP UPS1600 from the hardware catalog 
1. Select the subnet. 

2. Open the "Catalog" window using the "View > Catalog" menu command. 
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3. In the hardware catalog, navigate to the SITOP UPS1600 under "PROFINET IO \ I/O \ 
UPS1600". 

 
4. Click the desired SITOP UPS1600; keep the left mouse button pressed and drag the 

SITOP UPS1600 to the subnet. 

5. Double-click on "SITOP UPS1600". 

6. In the open dialog Device name, enter the device number and IP address in the Ethernet. 

7. Save the hardware configuration. 

You have now inserted the SITOP UPS1600 into the project. The rectangle displayed in 
the editor symbolizes the SITOP UPS1600. 
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3.4.4 Parameter assignment 

3.4.4.1 Parameters of the basic device and battery module 
The adjustable parameters of the basic device SITOP UPS1600 and the SITOP UPS1100 
battery modules are structured according to subgroups in SIMATIC STEP 7. These 
subgroups are shown in the table below. 

 
Subgroup Description 
Buffer parameters All parameters, which involve the behavior of SITOP UPS1600 when buffering. 
Battery parameters Parameterizing the battery being used. 
Charging parameters Parameters for the charging behavior: 

• End-of-charge voltage 
• Charge current 

Reset parameters Activate interruption of the output voltage for supply system restoration. 
Buffering parameters Load current that is expected at the device output during buffer operation. 
Maintenance R test - the battery state is determined by subjecting it to a load. 
Identification Definition of the location and contact data to be able to identify the 

SITOP UPS1600. 
Web server Definition as to whether the SITOP UPS1600 may be accessed via web server 

(yes / no). 

A detailed description of the individual parameters of the subgroups is contained in the 
associated section under Parameterizing SITOP UPS1600 (Page 70). 

3.4.4.2 Parameterizing SITOP UPS1600 
The procedure is the same for all parameters. This section describes the general procedure 
to reach the configuration dialog. The individual parameters and their possible values are 
described in the following subsections. 

Each parameter has a start value. A click on "Reset to initial values" resets all parameters of 
a subgroup to the associated start value. 

Preconditions 

● The SITOP UPS1600 has been integrated in the opened project and networked. 

Proceed as follows 

1. Open Network view "NetPro" ("Tools > Configure network"). 
The controller and the networked SITOP UPS1600 are displayed. 

2. In the Network view click on SITOP UPS1600. The hardware configuration opens. 

3. Double click in the hardware configuration on the SITOP UPS1600 entry in the station 
window for slot 0.1. 

4. In the configuration dialog click on the "Parameters" tab. 
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5. Click the desired subgroup. 
The subgroup opens. 

 
6. Enter the values. 

7. Confirm your entry by clicking on "OK". 

The parameters are stored in the project. 

Buffer parameters 
 
Parameter Value range Default setting 
Buffer time 1 … 32767 s 60 s 
Additional buffer time after PC shutdown 1 … 300 s 10 s 
Connection threshold 21 … 25 V 22.5 V 
Stop buffering voltage 18 ... 23 V 18.5 V 
Wait time for stable input voltage 200 … 65,000 ms 500 ms 
Downtime alarm 0 … 20.000 ms 125 ms 
Buffering allowed Yes / No Yes 
Enable reset after buffering Yes / No No 
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● Buffer time 
Time where the system is to be buffered by SITOP UPS1600. The "Buffering allowed" 
parameter is used to specify whether buffering should be performed. If a value of 32767 
is entered, then the SITOP UPS1600 interprets this as MAX, and only shuts down the 
buffering when the stop buffering voltage is reached. 

● Additional backup time after the PC has been shutdown 
The time to be buffered by the SITOP UPS1600 once the PC has been shut down. 

● Connection threshold 
If the connection threshold value is fallen below, the SITOP UPS1600 starts buffering. If 
the value of the connection threshold is subsequently exceeded again, then the 
SITOP UPS1600 stops buffering. 

● Stop buffering voltage 
The voltage at which battery discharge is terminated. 

● Wait time for a stable input voltage 
Time where the input voltage must continually lie above the connection threshold so that 
buffering is exited and a transition is made into normal operation. 

● Downtime alarm 
The time in which no alarm is issued to the system although it is buffered. 

● Buffering allowed 
Select between buffers with the specified values or passive measurement of the power 
supply by the SITOP UPS1600. 

● Activate reset after buffering 
If the value is set to "yes", then, in the meantime, if the input voltage returns after the 
buffer time has expired, the SITOP UPS1600 shuts down the output for the selected 
interrupt time. 

Battery parameters 
 
Parameter Value range Default setting 
Faulty battery voltage 1 … 18 V 6 V 
Battery capacity 0.1 … 3,200 Ah 10 Ah: 
Ignore data of coded battery Yes / No No 

● Battery defective voltage 
If the battery voltage undershoots this value, it is considered as being defective by the 
SITOP UPS1600 and is not charged. 

● Battery capacity 
If no UPS1100 battery modules are being used: Enter the total capacity of the installed 
batteries. 

● Ignore data of coded battery 
Set the value to "Yes" if you define the parameters for the UPS1100 yourself. 
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Charging parameters 
 
Parameter Value range Default setting 
End-of-charge voltage 24 … 30 V 26 V 
Charge current 1 … 4,000 mA 800 mA 

● End-of-charge voltage 

The end-of-charge voltage is the maximum voltage up to which the battery is charged. 

● Charge current 
The battery is not charged with more than the selected charge current. The 
manufacturer's details for the permitted charge current of the battery must be observed. 

 
  Note 

When UPS1100 battery modules are used, both parameters are automatically set, and do 
not have to be defined. 

 

The following, device-dependent maximum values apply:  

– SITOP UPS1600 10 A: Maximum permissible charge current 3,000 mA 
Derating for Tu > 40 °C or Uin < 24 V: 2,000 mA 

– SITOP UPS1600 20 A: Maximum permissible charge current 4,000 mA 
Derating for Tu > 40 °C or Uin < 24 V: 3,000 mA 

– SITOP UPS1600 40 A: Maximum permissible charge current 5,000 mA 
Derating for Tu > 40 °C or Uin < 24 V: 3,000 mA 

Reset parameters 
 
Parameter Value range Default setting 
Reset time 1 … 120 s 5 s 

Here, you define the interrupt duration for the "Interrupt output voltage" function (reset after 
buffering) 

Buffering parameters (2) 
 
Parameter Value range Default setting 
Expected buffer current 0 ... 40 A 0 A 

Load current, which is expected at the device output during buffer operation. If a value of 0 A 
is entered, then for this parameter, the average value of the actual load current measured at 
the output over the last 10 min is assumed. The value of this parameter is used when 
calculating the remaining buffer time. The entered value may not exceed the rated device 
current. 
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Maintenance 
 
Parameter Value range Default setting 
R test interval 1 ... 65535 h 4 h 

R test: The battery state is determined by subjecting it to a cyclic load. 

Identification 
 
Parameter Value range 
Contact Free text 
Location Free text 

● Contact 
Enter, for example, a contact address or the name of a staff member. 

● Location 
Enter a description of the location that can be used to locate the SITOP UPS1600. 

Web server 
 
Parameter Value range Default setting 
Activate web server Yes / No No 
Activate web server on this module Yes / No No 
Permit access only with HTTPS Yes / No Yes 
Log off automatically after 15 minutes Yes / No No 

Set here whether access to the SITOP UPS1600 via web server is permitted. 

Update interval: 0 / 5 s / 10 s / 20 s / 30 s / 60 s 10 s 

● Activate web server on this module 
Define whether this device can be accessed via the web server. 

● Permit access only with HTTPS 
Define whether access is only permissible via HTTPS. 

● Download certificate 
By pressing the "Download certificate" button, you can download the certificate for 
encrypted connection via HTTPS. 

● Log off automatically after 15 minutes 
You define whether a user should be automatically logged off after closing the web 
server. 

● Update interval 
You define in which intervals the actual values are sent to the web server. 
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3.4.5 Loading the configuration to the SITOP UPS1600 (commissioning) 
In the delivered state, the SITOP UPS1600 has not yet been assigned any IP address and 
the DHCP protocol is deactivated. 

When the SITOP UPS1600 is first connected with an IO controller (SIMATIC S7 control 
system), it must be assigned a device name and an IP address by the IO controller. STEP 7 
can be used to load a new configuration to the device. 

Preconditions 

● The SITOP UPS1600 has been correctly connected and linked with the system. 

● PG/PC with SIMATIC STEP 7 is connected with the network. 

Displaying accessible nodes 
 

 Note 

If nodes can only be accessed via interposed switches or routers (with protocol conversion), 
they are not displayed in the list of the accessible nodes. 

 

1. Click in the "Target system" menu on "Display accessible nodes" 
The "Accessible nodes" window is opened with the following displays: 

– The station 

– The SITOP UPS1600 

The following table shows which information is displayed in the "Object name" column. 
 
Accessible nodes Object name Description 
S7-CPU, PC station Name of the station The "Details" view also shows the operating state, module 

type and, if available, information from the associated STEP 
7 project (station name, CPU name, system identification). 

Loading the IO controller for the first time 
Once you have configured the SITOP UPS1600 and the station, you must load this 
configuration to the IO controller (SIMATIC S7 control system). This is the way that the IO 
controller is assigned its configured IP addresses. 

Before loading, carry out a consistency test to check the configuration for duplicate 
addresses, identical names, etc. 

Inform yourself whether the IO controller to be loaded can also be initially loaded via the 
PROFINET interface. If not, you must first load the hardware configuration via the MPI 
interface . 

1. Select in the "Target system > Load" menu. 

2. Select the module to be loaded. 

3. In the "Select node address" dialog, if necessary, click the "Display" button to display the 
actual accessible modules (these include the IO controller to be loaded with its current IP 
address or its MAC address, if no IP address is yet available). 
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4. Select the IO controller to be loaded from the accessible modules. 

This module is displayed in the "Enter connection to target station" dialog box. 

5. Start loading by clicking on the "OK" button. 

The IO controller is assigned the configured IP address. 
 

 Note 

Ensure that the article number of the SITOP UPS1600 configured offline matches the article 
number of the device connected online. The following response is obtained after loading the 
configuration into the device: 

 

 
Image 3-2 Online / offline 
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Allocating the SITOP UPS1600 a device name (online) 
In order that the configured IO controller can address the SITOP UPS1600, you must assign 
each individual IO device (including SITOP UPS1600) the configured device name. 

For the procedure described below, the SITOP UPS1600 and the station for the PG/PC must 
be accessible online on the Ethernet. 

1. Open HW Config. 

2. In the "Target system > Ethernet" menu, click on "Assign device name". 

3. In the "Assign device name" dialog, in the "Device name" field, select SITOP UPS1600. 

4. In the "Available devices" select the SITOP UPS1600. Using the "Flash" button, you can 
flash the LED on the SITOP UPS1600 so that the device can be uniquely identified. 

5. Click on the "Assign name" button. 

After the name assignment, you can bring the IO controller into the RUN operating state. 

When powering up, the IO controller distributes the configuration information to the 
SITOP UPS1600 and then goes into cyclic operation. 

3.4.6 Diagnostics 
The following data can be fetched using the Diagnostics function: 

 
Group Value 
SITOP UPS1600 general Article number 

Serial number 

Fetching diagnostics data 
You can use the "Station > Open online" menu command in "HW Config" to select the 
SITOP UPS1600 and view the diagnostics data. 
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3.4.7 Firmware update 
 

 WARNING 

The SITOP UPS1600 is reset while updating the firmware. For safety reasons, the output is 
switched off. 

Ensure that no damage is caused to the plant or system. 

Ensure that the PG/PC and/or all switches, routers and gateways that are used have an 
independent power supply during the firmware update. 

 

 Note 

Do not switch-off the devices during the firmware update. 
 

The files for updating the firmware (firmware updates) are available online under 
(http://support.automation.siemens.com/WW/view/en/79207181). Different firmware updates 
are offered depending on the amp rating of the SITOP UPS1600. 

 

 Note 
Observe the compatibility of the firmware! 

Other firmware updates are not compatible. 

Determine the amp rating of your SITOP UPS1600 and download the appropriate firmware 
update. 

 

 Note 

It is not possible to downgrade the device firmware to a release with a version number lower 
than the firmware installed in the device itself. Information on how to read out the firmware 
release from the device is provided in Section Diagnostics (Page 77). 

 

 Note 
"Reset to factory" function: 

Everything is reset, also the IP address. A new IP address must then be assigned, as 
otherwise there is no connection to the UPS Manager or TIA. 

 

Preconditions 

● The SITOP UPS1600 has been correctly connected and linked with the PROFINET IO 
system. 

● PG/PC with STEP 7 is connected with the network. 

Procedure 

The firmware update consists of several files, which are combined in a zip file. 

1. Download the firmware update. 

http://support.automation.siemens.com/WW/view/en/79207181
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1. Unpack the ZIP file into a temporary directory. 

2. Open the "Accessible nodes" window with the "Target system > Display accessible 
nodes" menu command. 

 
  Note 

For an online connection via the "Accessible nodes" window, PG/PC and "Accessible 
nodes" must be connected to the same physical Ethernet subnet. 

 

3. Select the "Target system > Update firmware" menu command. 

4. Select the SITOP UPS1600 whose firmware is to be updated. 

5. In the open "Update firmware" dialog, press the "Browse" button to select the path to the 
directory with the unzipped files. 
In this directory, select the "ups10a.upd", "ups20a.upd", "ups40a.upd" files. 

6. After you have selected a file, the information in the bottom fields of the "Update 
firmware" dialog box indicate the components for which the file is suitable and from which 
firmware version. 

7. Click the "Run" button. 

8. STEP 7 verifies that the selected file can be interpreted by the module and then 
downloads the file to the module. 

9. If this requires changing the operating state of the IO controller, then you will be prompted 
to do this in the relevant dialog boxes. 

10.The module then automatically updates the firmware. 

 
  Note 

A separate connection is established to the CPU for the firmware update, if available. In 
this case, the task can be interrupted. If no resources are available for another 
connection, an existing connection will be used automatically. In this case, the task 
cannot be interrupted; the "Cancel" button in the transfer dialog is grayed-out and cannot 
be operated. 
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11.Confirm the notes that are displayed. 
The firmware is sent from the IO controller to the component, and saved in the internal 
component memory. The following LEDs flash while saving: 

– LED 1 ("OK/Bat") 

– LED 2 (">85%") 

 
  Note 

It can take several minutes to save the firmware in the component. Do not switch-off the 
devices. 

 
  Note 

During the firmware update, if the power supply of the SITOP UPS1600, or PG/PC or 
intermediate switches, routers or gateways is interrupted, then under certain 
circumstances, a fallback firmware is activated. If the SITOP UPS1600 can then no 
longer be accessed remotely, you must assign the SITOP UPS1600 a new IP address, or 
under the menu item "Assign name" you must enter a new name in the field "PROFINET 
device names" (see the manual for the particular device). 

 

12.The SITOP UPS1600 automatically updates the firmware. 

13.The firmware has been updated. Only now is it permissible to switch off the 
SITOP UPS1600. 

14.Using STEP 7 (read out the diagnostics buffer of the IO controller), check whether 
SITOP UPS1600 successfully starts with the new firmware. 

 

 Note 

After updating the firmware, in the hardware configuration of your project, you must replace 
the SITOP UPS1600 involved by the SITOP UPS1600 with the current firmware version. The 
configured configuration then matches the actual configuration again. 

 

3.4.8 Restore factory settings 
With STEP 7 Version 5.5, it is possible to restore the factory setting of modules using the 
"Target system -> Edit Ethernet node". 

1. To select the MAC address of the SITOP UPS1600, which should be reset to the factory 
setting, click in dialog "Edit Ethernet node" on "Browse". 

2. Click on the "Reset" button. 

This deletes the IP address and the device name from the module. The parameter values 
for SITOP UPS1600 and the energy storage device are kept. 
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3.5 SITOP UPS Manager 
 

 Note 

Ensure that only the UPS Manager accesses the SITOP UPS1600. 
 

 Note 

Install the current version of the SITOP UPS Manager so that you can use the full functional 
scope of the SITOP UPS1600. 

The installation file for the SITOP UPS Manager is available at no charge on the SITOP 
home page (http://www.siemens.com/sitop-ups1600) or directly 
(https://support.industry.siemens.com/cs/ww/en/view/75854607). 

 

3.5.1 Functions of the SITOP UPS Manager 
You can execute the following tasks with the SITOP UPS Manager: 

● Configure the SITOP UPS1600 uninterruptible power supply and the battery modules 

● Protect a computer or a computer network provided by the uninterruptible power supply 
with the master-slave technique 

● Data backup by controlled shutdown 

● Alarm-driven starting of any application (SMS, email) 
New functions from V4.71: 
OPC UA server as non-proprietary software interface. 
Setting IP address and names in the UPS1600 
Identifying the UPS1600 as a result of the flashing LED SF 

● OPC UA server as non-proprietary software interface. 

By specifying additional applications and alarms, you define a comprehensive protection of 
your computer or computer network. 

The applications can be started depending on the following events: 

● Supply voltage failure 

● Restoration of the supply voltage 

● State of the buffer readiness by the UPS: 

– General buffer readiness 

– Remaining buffer time 

● Status of the UPS battery: 

– Battery replacement required 

– Battery charge 

http://www.siemens.com/sitop-ups1600
https://support.industry.siemens.com/cs/ww/en/view/75854607
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3.5.2 OPC UA server 

System overview 
The "DC-UPS software" component is essential for integrating the OPC server. It comprises 
two subcomponents: 

1. SitopUPSManagerService: Responsible for communication with the DC UPS main board 
and data management. 

2. SitopUPSManager: Interface between the user and the DC UPS system. 

The SitopUPSManagerService component is suitable for two reasons when it comes to 
integrating the OPC server: 

1. As the component is responsible for data management, the OPC server does not require 
any external interface in order to access data. 

2. The component is executed as Windows service, and is therefore run independently of 
users logged on to the system. 

The structure of the DC-UPS software component - and the expansion to include the OPC 
server component (in green) are shown in the following diagram: 

 
Image 3-3 DC-UPS software component 

This results in the following system overview: 

● The DC-UPS software at the PC communicates via USB and the USB board - or via 
Ethernet and the ProfiNet board with the DC UPS main board. 

● OPC clients can connect with the OPC server in the DC-UPS software via Ethernet and a 
binary protocol or SOAP. 
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Image 3-4 DC-UPS system overview 

Available data 
The "Path" column specifies the path to the particular parameter. An "x" in column 
"SitopUPSManagerService" signals, that parameters of the current version (4.60) of the 
SitopUPSManagerService are interrogated. 

 
Parameter Path SitopUPSManagerService 
input voltage ok GetCyclicData.STAT.Bit0 x (cyclic) 
buffer mode active GetCyclicData.STAT.Bit2 x (cyclic) 
ready for buffering GetCyclicData.STAT.Bit3 x (cyclic) 
charge sufficient GetCyclicData.STAT.Bit4 x (cyclic) 
battery change recommended GetCyclicData.STAT.Bit5 x (cyclic) 
battery connection fault GetCyclicData.STAT.Bit6 x (cyclic) 
new alarms pending GetCyclicData.STAT.Bit7 x (cyclic) 
battery charge level GetCyclicData.CHRG x (cyclic) 
        
buffer time GetDataObject.1 x (only at beginning) 
buffer threshold GetDataObject.2 x (only at beginning) 
buffering allowed GetDataObject.3   
battery information GetDataObject.4   
  Mlfb GetDataObject.4.1 x (cyclic) 

serial number GetDataObject.4.2 x (cyclic) 
type GetDataObject.4.3   
manufacturing date GetDataObject.4.4   
EOCV GetDataObject.4.5   
charge current GetDataObject.4.6   
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stop buffering voltage (SBV) GetDataObject.4.7   
capacity GetDataObject.4.8 x (cyclic) 
standby time GetDataObject.4.9   
buffer time GetDataObject.4.10   
total charging current GetDataObject.4.11   
total culled current GetDataObject.4.12   
min temp GetDataObject.4.13   
max temp GetDataObject.4.14   
software version GetDataObject.4.15 x (cyclic) 
hardware version GetDataObject.4.16 x (cyclic) 
batterie cell volt 1 GetDataObject.4.17   
batterie cell volt 2 GetDataObject.4.18   
batterie voltage GetDataObject.4.19   

device information GetDataObject.5.   
  Mlfb GetDataObject.5.1 x (cyclic) 

serial number GetDataObject.5.2 x (cyclic) 
hardware version GetDataObject.5.3 x (cyclic) 
software version GetDataObject.5.4 x (cyclic) 
max current GetDataObject.5.5 x (cyclic) 
communication GetDataObject.5.6 x (cyclic) 
software version (BTLDR) GetDataObject.5.7 x (cyclic) 
DPS GetDataObject.5.8 x (cyclic) 
SWD GetDataObject.5.9 x (cyclic) 
SSN GetDataObject.5.10 x (cyclic) 

end of charge voltage GetDataObject.6 x (only at beginning) 
charge current GetDataObject.7 x (only at beginning) 
enable reset GetDataObject.8 x (only at beginning) 
reset time GetDataObject.9 x (only at beginning) 
stop buffering voltage GetDataObject.10 x (only at beginning) 
input voltage ok time GetDataObject.11 x (only at beginning) 
battery defect voltage GetDataObject.12 x (only at beginning) 
ignore battery coding GetDataObject.13 x (only at beginning) 
hardware settings GetDataObject.14   
  buffer time GetDataObject.14.1   

buffer threshold GetDataObject.14.2   
buffering allowed GetDataObject.14.3   
enable reset GetDataObject.14.4   
start from battery GetDataObject.14.5   
sel. bat. profile GetDataObject.14.6   

downtime alarm GetDataObject.15 x (only at beginning) 
battery capacity GetDataObject.16 x (only at beginning) 
buffer time 2 GetDataObject.17 x (only at beginning) 
expected buffer current GetDataObject.18 x (only at beginning) 



Engineering and remote access  
3.5 SITOP UPS Manager 

 SITOP UPS1600 / UPS1100 
86 Manual, 04.2016, A5E37775406-6-76 

battery inspection time GetDataObject.19 x (only at beginning) 
resistor test interval GetDataObject.20 x (only at beginning) 
input voltage ok GetDataObject.401   
buffer mode GetDataObject.402 x (cyclic) 
battery charge GetDataObject.403 x (cyclic) 
charge sufficient GetDataObject.404   
remaining buffer time GetDataObject.405 x (cyclic) 
battery temperature GetDataObject.406 x (cyclic) 
device temperature GetDataObject.407 x (cyclic) 
input voltage GetDataObject.408 x (cyclic) 
input current GetDataObject.409 x (cyclic) 
output voltage GetDataObject.410 x (cyclic) 
load current GetDataObject.411 x (cyclic) 
mesured charge current GetDataObject.412 x (cyclic) 
battery voltage GetDataObject.413 x (cyclic) 
battery change recommended GetDataObject.414 x (cyclic) 
total operating time GetDataObject.415   
sw settings valid GetDataObject.416   
calculated battery capacity GetDataObject.417   
number of batteries GetDataObject.418 x (cyclic) 
ouput current GetDataObject.419 x (cyclic) 
calculated battery health GetDataObject.420 x (cyclic) 
charge voltage GetDataObject.421 x (cyclic) 
led pattern GetDataObject.422 x (cyclic) 
extended led pattern GetDataObject.423   
battery connection fault GetDataObject.424 x (cyclic) 

OPC server 
The OPC server is implemented based on the "ANSI C stack source code" 
(https://opcfoundation.org/developer-tools/developer-kits-unified-architecture/ansi-c-stack-
source-code/) of the OPC Foundation. The OPC server provides the data listed in "Available 
data" in the following hierarchical structure: 

 
Parameter Path SitopUPSManager-

Service 
Mainboard     
  state information     

  input voltage ok GetCyclicData.STAT.Bit0 x 
buffer mode active GetCyclicData.STAT.Bit2 x 
ready for buffering GetCyclicData.STAT.Bit3 x 
charge sufficient GetCyclicData.STAT.Bit4 x 
battery change recommended GetCyclicData.STAT.Bit5 x 
battery connection fault GetCyclicData.STAT.Bit6 x 

https://opcfoundation.org/developer-tools/developer-kits-unified-architecture/ansi-c-stack-source-code/
https://opcfoundation.org/developer-tools/developer-kits-unified-architecture/ansi-c-stack-source-code/
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new alarms pending GetCyclicData.STAT.Bit7 x 
battery charge level GetCyclicData.CHRG x 
remaining buffer time GetDataObject.405 x 
total operating time GetDataObject.415   
input voltage GetDataObject.408 x 
input current GetDataObject.409 x 
output voltage GetDataObject.410 x 
load current GetDataObject.411 x 
mesured charge current GetDataObject.412 x 
battery voltage GetDataObject.413 x 
ouput current GetDataObject.419 x 
charge voltage GetDataObject.421 x 
sw settings valid GetDataObject.416   
device temperature GetDataObject.407 x 
led pattern GetDataObject.422 x 
extended led pattern GetDataObject.423   

buffering     
  buffer time GetDataObject.1 x 

buffer time 2 GetDataObject.17 x 
buffer threshold GetDataObject.2 x 
stop buffering voltage GetDataObject.10 x 
input voltage ok time GetDataObject.11 x 
downtime alarm GetDataObject.15 x 
buffering allowed GetDataObject.3   
enable reset GetDataObject.8 x 
expected buffer current GetDataObject.18 x 

battery     
  battery defect voltage GetDataObject.12 x 

battery capacity GetDataObject.16 x 
ignore battery coding GetDataObject.13 x 
battery inspection time GetDataObject.19 x 
number of batteries GetDataObject.418 x 
total calculated battery capacity GetDataObject.417.0   
total calculated battery health GetDataObject.420.0 x 
total battery change recommended GetDataObject.414.0 x 
total battery connection fault GetDataObject.424.0  
battery #0     
  calculated battery 

capacity 
GetDataObject.417.1   

calculated battery 
health 

GetDataObject.420.1 x 

battery change 
recommended 

GetDataObject.414.2 x 
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battery connection 
fault 

GetDataObject.424.1  

battery tempera-
ture 

GetDataObject.406.1 x 

standby time GetDataObject.4.9.1   
buffer time GetDataObject.4.10.1   
total charging cur-
rent 

GetDataObject.4.11.1   

total culled current GetDataObject.4.12.1   
EOCV GetDataObject.4.5.1   
charge current GetDataObject.4.6.1   
capacity GetDataObject.4.8.1 x 
stop buffering 
voltage (SBV) 

GetDataObject.4.7.1   

type GetDataObject.4.3.1   
min temp GetDataObject.4.13.1   
max temp GetDataObject.4.14.1   
Mlfb GetDataObject.4.1.1 x 
serial number GetDataObject.4.2.1 x 
manufacturing date GetDataObject.4.4.1   
software version GetDataObject.4.15.1 x 
hardware version GetDataObject.4.16.1 x 
isAvailable   

battery #n     
  calculated battery 

capacity 
GetDataObject.417.n   

calculated battery 
health 

GetDataObject.420.n x 

battery change 
recommended 

GetDataObject.414.n x 

battery connection 
fault 

GetDataObject.424.n  

battery tempera-
ture 

GetDataObject.406.n x 

standby time GetDataObject.4.9.n   
buffer time GetDataObject.4.10.n   
total charging cur-
rent 

GetDataObject.4.11.n   

total culled current GetDataObject.4.12.n   
EOCV GetDataObject.4.5.n   
charge current GetDataObject.4.6.n   
capacity GetDataObject.4.8.n x 
stop buffering 
voltage (SBV) 

GetDataObject.4.7.n   

type GetDataObject.4.3.n   
min temp GetDataObject.4.13.n   



 Engineering and remote access 
 3.5 SITOP UPS Manager 

SITOP UPS1600 / UPS1100 
Manual, 04.2016, A5E37775406-6-76 89 

max temp GetDataObject.4.14.n   
Mlfb GetDataObject.4.1.n x 
serial number GetDataObject.4.2.n x 
manufacturing date GetDataObject.4.4.n   
software version GetDataObject.4.15.n x 
hardware version GetDataObject.4.16.n x 
isAvailable   

device information     
  mainboard     

  hardware version GetDataObject.5.3 x 
software version GetDataObject.5.4 x 
software version 
(BTLDR) 

GetDataObject.5.7 x 

max current GetDataObject.5.5 x 
Mlfb GetDataObject.5.1 x 
serial number GetDataObject.5.2 x 
DPS GetDataObject.5.8 x 
SWD GetDataObject.5.9 x 
SSN GetDataObject.5.10 x 
communication GetDataObject.5.6 x 

USB-board     
  hardware version GetDataObject.5.3 x 

software version GetDataObject.5.4 x 
software version 
(BTLDR) 

GetDataObject.5.7 x 

SSN GetDataObject.5.10 x 
PN-board     
  hardware version GetDataObject.5.3 x 

software version GetDataObject.5.4 x 
software version 
(BTLDR) 

GetDataObject.5.7 x 

SSN GetDataObject.5.10 x 
charging     
  end of charge voltage GetDataObject.6 x 

charge current GetDataObject.7 x 
reset     
  reset time GetDataObject.9 x 
hardware settings     
  buffer time GetDataObject.14.1   

buffer threshold GetDataObject.14.2   
buffering allowed GetDataObject.14.3   
enable reset GetDataObject.14.4   
start from battery GetDataObject.14.5   
sel. bat. profile GetDataObject.14.6   
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Parameter Alarm # 
Mainboard   
  alarms   

  Buffer mode not possible 1 
Battery defect 2 
Battery deep discharge, no charging possible 3 
Insufficient charge 4 
Battery deep discharge 5 
Device temperature critical (to high) 8 
Device temperature critical (to low) 9 
Connection to Battery high resistive 10 
Connection to Battery broken 11 
Wrong battery polarity 12 
Device failure 13 
Unknown Battery 14 
Over current 15 
Reset executed 20 
Battery test 21 
Input voltage too high 24 
Surplus battery 26 
DC-UPS parameters corrupt 28 
Device overtemperature 30 
Battery SOH test 34 
Low Voltage Mode 35 
Buffering  36 
Fuse broken 39 

battery   
  battery #0   

  alarms   
  battery defect 2 

Battery deep discharge, no 
charging possible 

3 

Battery temperature high 6 
Battery temperature low 7 
Communication to battery fault 23 
Wrong battery configuration 27 
Battery parameters corrupt 29 
Fuse broken 39 

battery #n   
  alarms   

  battery defect 2 
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Battery deep discharge, no 
charging possible 

3 

Battery temperature high 6 
Battery temperature low 7 
Communication to battery fault 23 
Wrong battery configuration 27 
Battery parameters corrupt 29 
Fuse broken 39 

Alarms defined in Chapter Troubleshooting (Page 135) are also incorporated in the 
previously defined hierarchic structure. OPC clients can subscribe to these alarms. All 
subscribers are informed if an alarm changes its status. The previous table lists all of the 
alarms. 

3.5.3 The user interface of the SITOP UPS Manager 

 
① Tabs for selecting the submenus 
② Language selection 
③ Save bar 
④ Connection lamps 
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Use the tab ① to reach the individual submenus. 

The language selection ② is used to select the user interface language of the SITOP UPS 
Manager. The German, English, French, Italian, Spanish, and Chinese languages are 
available. 

The functions of the save bar ③ are used to load the configuration into or from the 
SITOP UPS1600 and open or save the configurations on a data medium. 

The colored representations of the connection lamps ④ indicate the status of the incoming 
and outgoing connection. Both lamps must light green.  

 
Left-hand connection lamp: Connection status SITOP UPS Manager application - SITOP 
UPS Manager service 
Right-hand connection lamp: Connection status SITOP UPS Manager service - SITOP 
UPS1600 

3.5.4 Installation/uninstallation 
The installation file for the SITOP UPS Manager is available at no charge on the SITOP 
home page (http://www.siemens.com/sitop-ups1600) or directly 
(https://support.industry.siemens.com/cs/ww/en/view/75854607). 

Operational requirements 

Operating systems 

The Windows XP and Windows 7 (32 bit and 64 bit) operating systems are supported. 

Ethernet or USB interface 

To install and use the SITOP UPS Manager in conjunction with the SITOP UPS1600, the 
computer must be connected with the SITOP UPS1600 via Ethernet or USB port. 

Windows user group 

Users of the SITOP UPS Manager must be members of the Windows user group "power 
users". 

Installation preconditions 

Administration rights 

You require administrator rights to install the SITOP UPS Manager. 

http://www.siemens.com/sitop-ups1600
https://support.industry.siemens.com/cs/ww/en/view/75854607
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Installation paths without blanks 
 

 Note 
Paths must not contain any blanks! 

The path names of the directories for SITOP UPS Manager and batch files must not contain 
any blanks. 

 

Installation steps 

Procedure when installing for the first time 

1. Close all applications before you start the installation. 

2. Double-click on the "Setup_SITOP-UPSManager_x.xx.x" file. 

3. Follow the installation instructions. Enter the requested information in the dialogs: 

– Installer language, English or German 

– Agreement declaration with the license conditions 

– Installation scope: 
Activate option "USB driver" if your SITOP UPS1600 has a USB interface. You can 
select between application and service. 

– Installation path: 
Use the recommended target directory "C:\Program Files (x68\SITOPUPSManager" or 
select another one. If you select another target directory, please note that spaces are 
not permissible in the path name (to be taken into consideration up to version 4.61). 

– Start menu folder 
Select the folder structure under which the SITOP UPS Manager should appear in the 
start menu. 

4. If you are using a SITOP UPS1600 with USB interface, then connect the 
SITOP UPS1600 to the computer using this interface. 

5. Click "Finish" to complete the installation. 

Procedure for an already existing installation 
 

 Note 

The procedure described below is only necessary if a SITOP UPS Manager with version 
number less than 4.50 is to be installed. These steps are automatically executed for versions 
from V4.50 and higher. 

 

1. Back up the file "dcups.ini", which is located in directory "ini" in the installation directory of 
the SITOP UPS Managers. 

2. Carry out steps 1 to 5 of the procedure described above when installing for the first time. 

3. Replace file "dcups.ini", which is located in directory "ini" in the installation directory of the 
SITOP UPS Managers, as a result of the file backed up in Step 1. 
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Result 
After the successful installation, the SITOP "UPS Manager" is contained in the start menu 
under the selected start menu folder. 

No further installations are required to operate the SITOP UPS Manager. 

Uninstallation 
The UPS Manager can be uninstalled using "Start → All programs → SITOPUPS Manager → 
Uninstall". 

3.5.5 Options of establishing a connection to the SITOP UPS1600 
Depending on the type, the SITOP UPS1600 provides either a USB interface or an Ethernet 
interface. 

Depending on the type, the SITOP UPS1600 communicates via USB or Ethernet with the 
SITOP UPS Manager. 

The SITOP UPS Manager supports the master-slave operation only for an existing Ethernet 
connection. This permits, for example, a controlled shutdown of the computers in the 
network by the applications started with the SITOP UPS Manager. 

3.5.6 Establishing a connection via Ethernet 
The SITOP UPS1600 requires an IP address for communication with the UPS Manager. This 
is assigned by the network administrator. Use the Primary Setup Tool to configure the 
SITOP SITOP UPS1600 interface. 

Configuring the SITOP UPS1600 with the Primary Setup Tool 
The Primary Setup Tool is a Siemens product that is free of charge, and which is used to 
identify and configure network-capable devices. You can download the Primary Setup Tool 
at (http://support.automation.siemens.com/WW/view/en/19440762). 

From SW Version V2.1.0, the Primary Setup Tool is already integrated in the UPS Manager 
(from Version V4.71.x). 

Additional information is contained in the Primary Setup Tool manual. This manual and 
further links can be found at 
(http://support.automation.siemens.com/WW/view/en/19440762). 

http://support.automation.siemens.com/WW/view/en/19440762
http://support.automation.siemens.com/WW/view/en/19440762
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Preconditions 

● The SITOP UPS1600 is connected with the client (PG/PC) via the Ethernet interface. 

● The Primary Setup Tool is installed on the client. 

● Firewall settings that are necessary: 

– Communication via 5000 is permitted. 

– Echo request (ping) is permitted. 

Procedure 

1. Start the Primary Setup Tool. 

2. Select the "Settings > Select interface" menu command. 
The "Set PG/PC interface" dialog opens. 

 
3. Select the interface with which the client is connected with the SITOP UPS1600. 

Click "OK" to close the "Set PG/PC interface" dialog. 
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4. Select the menu command "Network > Search". 
SITOP UPS1600 appears in the tree view as "DC-UPS :" with its MAC address and its IP 
address. 

 
5. Open the SITOP UPS1600 entry and select "Ind. Ethernet interface". 

In the right-hand section, the configuration menu for the Ethernet interface of the SITOP 
UPS1600 opens. 
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6. Configure the Ethernet interface as specified by the network administrator. 

7. Select the SITOP UPS1600 in the Tree view. 

Loading to the device is not possible while an interface is selected. 

 
8. Select menu command "Module > Download", to load the configuration to the device. 

Alternatively, you can start loading using the "Load" button in the toolbar. 

 

Configuring the connection in the SITOP UPS Manager 
A basic setting is the configuration of the client (PC/PG) as master or slave. The 
consideration of possible application situations can help here: 

 
● The local computer is the only computer at the SITOP UPS1600. 

Local computer = master PC 

● The local computer is one of several computers and performs the master function. 
Local computer = master PC 

● The local computer is one of several computers at the SITOP UPS1600 and operates as 
slave. 
Local computer = slave PC 

In the master-slave configuration, the SITOP UPS1600, the master PC and the slave PC are 
connected at the same physical Ethernet. Only the master PC communicates directly with 
the SITOP UPS1600. The slave PC receives the control signals from the SITOP UPS 
Manager of the master PC. 

 

 Note 

Up to SITOP UPS Manager Version 4.12, the master PC can only manage 1 slave PC. From 
version 4.12.5 and higher, up to 8 slaves can be managed. 
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Configuring the local computer as master PC 
1. Select "General settings > Device configuration". 

2. Activate the "Ethernet" checkbox and the "Master-PC" checkbox. 

3. If you are prompted as to whether you want to restart the SITOP UPS Manager, confirm 
this with "Yes". 

The SITOP UPS Manager is restarted. 

4. Select "Hardware configuration > Ethernet configuration". 

5. Enter the IP address of the master PC in the field "IP address of the master PC". A 
selection box is displayed next to field "IP address of the master PC", which lists all of the 
available IP addresses of the client (PC/PG). Selecting an IP address automatically 
inserts this address in field "IP address of the master PC". 

 
  Note 

Also at the local computer, the IP address of the master PC must be specified in the 
SITOP UPS Manager if a master-slave configuration is to be used. 

 

6. Enter the IP address of the SITOP UPS1600 in the "IP address of the DC-UPS" field. 

7. If you are prompted as to whether you want to restart the SITOP UPS Manager, confirm 
this with "Yes".  
The SITOP UPS Manager is restarted. 

The connection lamps light up green, the connection as master PC to the SITOP UPS1600 
is established, if the (local) PC is connected as master PC to the SITOP UPS1600. 

 

Configuring the client as slave PC 
1. Select "General settings > Device configuration". 

2. Activate the "Ethernet" checkbox and the "Slave PC" checkbox. 

3. If you are prompted as to whether you want to restart the SITOP UPS Manager, confirm 
this with "Yes".  
The SITOP UPS Manager is restarted. 

4. Select "Hardware configuration > Ethernet configuration". 

5. Enter the IP address of the master PC in the field "IP address of the master PC". 

6. If you are prompted as to whether you want to restart the SITOP UPS Manager, confirm 
this with "Yes".  
The SITOP UPS Manager is restarted. 

The connection lamps light up green, the connection as slave PC to the master PC is 
established, if the (local) PC is connected as master PC to the SITOP UPS1600. 
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3.5.7 Establishing a connection via USB 
1. Connect the SITOP UPS1600 using a USB cable with the client (PC/PG). 

 
2. Select "General settings > Device configuration". 

3. Activate the "USB (UPS1600)" checkbox. 

4. If, in the lower area, a blue bar with the message "Configuration changed, restart 
application now." appears, click on the bar to restart the UPS. Clicking on "x" only 
minimizes the UPS Manager. You can maximize the UPS Manager again by clicking on 
the associated symbol in the task bar.  
The SITOP UPS Manager is restarted. 

5. Check that the connection lamps light green. 

The connection lamps light green, the connection to the SITOP UPS1600 via USB has 
been established, if the (local) PC is connected as master PC to the SITOP UPS1600. 
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3.5.8 Configuration in the SITOP UPS Manager 
Once you have connected the SITOP UPS1600 and the SITOP UPS Manager, you have the 
following configuration options: 

● Create a new configuration. 

● Load a configuration from a data medium or from a device. 

● Change a configuration. 

● Store a configuration on a data medium or load it into a device. 

Procedure 

1. Make the required hardware configuration in the SITOP UPS Manager. 
Alternatively, you can load a saved hardware configuration to the UPS Manager using 
command "Open file" in the storage bar "Configurations". 

2. Click in the storage bar "Configurations" on the "Download" button. 

The configuration is loaded to the SITOP UPS1600. 
 

 Note 

When storing or loading a HW configuration, the entry in "Base unit > Location" is not 
accepted/changed. 

 

3.5.8.1 General settings 
Under "Software configuration > General settings", specify the maximum size of the log file in 
Kbytes and where it is saved.  

From SITOP UPS Manager V4.12.5 and higher, under "Software configuration > General 
settings" you can also specify as to whether the window of the SITOP UPS Manager should 
always be in the foreground. 

Log file 
1. Select "Software configuration > General settings". 

2. Enter the maximum file size in kbytes in the "Size of log file" dialog box. 

3. Click on "Browse" 

4. Select the directory in which the log file should be stored. 

5. Confirm with "Select folder". 

The maximum size and the storage location of the log file has been saved. 
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3.5.8.2 Configuring the SITOP UPS1600 
Using the SITOP UPS Manager, you can configure the SITOP UPS1600 and its energy 
storage device, and then load to the device (if it is an uncoded battery - for UPS1100, the 
values are automatically identified). To change the charge parameters switch-in threshold or 
buffer time, you must set the corresponding rotary coding switch to the "REN" position. 

1. To do this, select "Hardware configuration > Base device" or "Hardware configuration  
> Energy storage". 

2. Enter the desired values. 

3. Click on "Download" 

Configuring the basic device (base unit) 
The following parameters are available under "Hardware configuration> Base unit". 

 
Parameter Value range Default setting 
Location Free text – 
Connection threshold 21 - 25 V 22.5 V 
Buffer time 1 - 32767 s 60 s 
Maximum buffer time 1) Yes / No No 
Additional buffer time after PC shutdown 1 - 300 s 10 s 
Expected buffer current 1) 0 - 40 A 0 A 
Reset time 1 - 120 s 5 s 
Enable reset time after buffering: Yes / No No 
Downtime alarm 0 - 20000 ms 125 ms 
Wait time for stable input voltage 0.2 - 65 s 0.5 s 
Variable time for battery test 2) 1 - 65535 h 4 h 
 1) Parameter only available from V2.0.0 and higher 

2) Parameter only available from V2.1 and higher 

● Location: Details of the location identification where the SITOP UPS1600 is installed. 

● Connection threshold: If the connection threshold value is fallen below, the 
SITOP UPS1600 starts buffering. If the value of the connection threshold is reached or 
undershot again later, the SITOP UPS1600 stops buffering. 

● Buffer time: Length of time during which the system should be buffered by the 
SITOP UPS1600. 

● Maximum buffer time: The MAX setting means that buffering is realized for as long as 
possible. The device only shuts down when the battery has discharged down to the 
defined stop buffering voltage. The value entered for the "Buffer time" parameter is not 
relevant in this case. 

● Additional buffer time after PC shutdown: The time in which the system is buffered by the 
SITOP UPS1600 once the PC has been shut down. 

● Expected buffer current: Load current, which is expected at the device output during 
buffer operation. If a value of 0 A is entered, then for this parameter, the average value of 
the actual load current measured at the output over the last 10 min is assumed. The 
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value of this parameter is used when calculating the remaining buffer time. The entered 
value may not exceed the rated device current. 

● Reset time: Time, in which the output voltage of the SITOP UPS1600 is switched off, 
although in the meantime the input voltage has returned. This function allows IPCs to 
automatically restart. 

● Enable reset time after buffering: If the value is set to "Yes", the SITOP UPS1600 shuts 
down the output for the selected interrupt time if, in the meantime, the input voltage 
returns after the buffer time has expired. Using this function, after the SITOP UPS1600 
has been powered down, an IPC can be switched on again, for example. 

● Downtime alarm: The time in which no alarm is issued to the system although it is 
buffered. 

● Time of the pending input voltage: The time in which no alarm is issued to the system 
although the connection threshold has been undershot. 

● Variable time for battery test: The time interval between battery tests can be set using the 
parameter. 

To reset the parameters to their initial value, click the "Reset to initial values" button. All 
parameters for the base device will be reset to their initial value. 

Configuring the energy storage 
The characteristic values of a SITOP UPS1100 battery module are automatically read by the 
coding. If a SITOP UPS1100 battery module is used, activate the "SITOP UPS1100 battery" 
checkbox. 

If you are using a different battery, activate the "Use third-party battery" checkbox. Enter the 
rated values of the other battery. The following parameters are available under "Hardware 
configuration> Energy storage". 

 
Parameter Value range 
Battery capacity 0.1 - 3,200 Ah 
End-of-charge voltage 24 - 30 V 
Charge current 0.001 - 5 A 
Faulty battery voltage 1 - 18 V 

● Battery capacity: Total capacity of the installed batteries. 

● End-of-charge voltage: The charging completes when the selected end-of-charge voltage 
is reached. 

● Charge current: The battery is not charged with more than the selected charge current. 
The manufacturer's details for the permitted charge current of the battery must be 
observed. If several batteries are connected, the smallest permitted charge current 
applies. 

● Faulty battery voltage: If the battery voltage falls below this value, it will be considered as 
being defective by the SITOP UPS1600 and is not charged. 

To reset the parameters to their initial value, click the "Reset to initial values" button. All 
parameters for the energy storage will be reset to their initial value. 
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3.5.9 Behavior of the SITOP UPS Manager 
The monitoring of the uninterruptible power supply by the SITOP UPS Manager permits 
other applications to be started event driven.  

In the event of a power failure, the SITOP UPS Manager can use the network to perform a 
controlled shutdown of the devices connected to the uninterruptible power supply in the 
specified order, or place them in a defined standby state. 

The sending of alarms and notifications to the system or to users is also possible (SMS, e-
mail). 
 

The applications can be started depending on the following events and factors: 

● Power failure 

● Power return 

● State of the buffer readiness by the SITOP UPS1600: 

– General buffer readiness 

– Remaining buffer time 

● State of the SITOP UPS1600 battery: 

– Battery charge 

– for recommended battery replacement 

● State of the communication interface: 

– Connection established/interrupted 

● System alarm status 

– At least one alarm is active/no longer active 

Storing an application 
In the various submenus, you can store applications that will be started depending on the 
above-mentioned events and factors. Examples of such applications are: 

● Batch scripts, for example, to shut down a computer in the network. 

● Applications that inform the user about the state of the power supply. 

● Applications that protect licenses assigned to computers (floating licenses) from being 
lost because of power failure. 

Procedure 

1. Open the appropriate submenu under "Software configuration". 

2. Activate the checkbox to start the application for the desired event. 

3. Click on "Browse" to select an application. 

4. Select the required application in a directory. 

The application path is displayed. 
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5. To check whether the application will performed correctly, click the "Start" button. 

6. Enter the time in minutes and seconds after which the application should be started. 

 

 Note 

Only those applications that do not open any Windows screen can be started. 
 

Behavior during buffer mode 
Make the settings under "Software configuration > Buffer operation" vor.  

The following options are available: 

● Start application on power failure. 

● Start application after power return. 

● Show SITOP UPS Manager on power failure. 

● Show SITOP UPS Manager after power return. 

● Shut down PC on power failure after xx minutes. 

 

 Note 

NOTICE: If the buffer time (see Section Configuring the SITOP UPS1600 (Page 101)) is set 
shorter than this time, the SITOP UPS1600 switches off before the PC has been shut down. 
The PC is then no longer protected. 

 

Behavior for missing buffer readiness 
Make the settings under "Software configuration > Not ready for buffering". 

The following options are available: 

● Start the application if buffer mode is not possible. 

● Start the application when buffer readiness returns 

● Open the SITOP UPS Manager if buffer mode is not possible 

● Open the SITOP UPS Manager when buffer readiness returns. 

Behavior when battery replacement required 
Make the settings under "Software configuration > Battery replacement". 

The following options are available: 

● Start the application if battery replacement is recommended (from SITOP UPS Manager 
V4.12.5 and higher). 

● Start the application once the battery has been replaced. 
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● Open the SITOP UPS Manager if battery replacement is recommended (from SITOP 
UPS Manager V4.12.5 and higher). 

● Open the SITOP UPS Manager once the battery has been replaced. 

Behavior depending on the battery charge 
Make the settings under "Software configuration > Battery charge". 

The following options are available: 

● Start the application when the battery charge is > 85 % of the maximum. 

● Start the application when the battery charge is < 85 % of the maximum. 

● Open SITOP UPS Manager when the battery charge is > 85 % of the maximum. 

● Open SITOP UPS Manager when the battery charge is < 85 % of the maximum. 

 

 Note 

From UPS Manager Version V4.71, a percentage value of the battery charge can be 
programmed where an action should be initiated. 

 

Behavior depending on the remaining buffer time 
Make the settings under "Software configuration > Remaining buffer time". Specify the 
minimum buffer time under "Hardware configuration > Base Unit" in entry "Buffer time". 

The following options exist in the "Remaining buffer time" submenu: 

● Start the application if the desired buffer time cannot be achieved. 

● Start the application if the desired buffer time can be achieved again. 

● Display the SITOP UPS Manager if the desired buffer time cannot be achieved. 

● Display the SITOP UPS Manager if the desired buffer time can be achieved again. 

Response when communication to the SITOP UPS1600 is interrupted 
Make the settings under "Software configuration > Communication interface".  

The following options are available: 

● Start the application if there is a connection to the SITOP UPS1600. 

● Start the application if the connection to the SITOP UPS1600 is interrupted. 

● Open the SITOP UPS Manager if there is a connection to the SITOP UPS1600. 

● Open the SITOP UPS Manager if the connection to the SITOP UPS1600 was interrupted. 
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Behavior for pending system alarms 
Make the settings under "Software configuration > System alarms". Reasons for a system 
alarm are contained in the alarms list (see Section Troubleshooting (Page 135)). 

The following options exist in the "System alarms" submenu: 

● Start the application if at least one system alarm is active. 

● Start the application if no system alarm is active. 

● Open the SITOP UPS Manager if at least one system alarm is active. 

● Open the SITOP UPS Manager if no system alarm is active. 

3.5.10 Display and visualization 
The "Display" menu item shows information about the device data and parameters as well as 
the state of the power supply. 

The following display options exist: 

● Active alarms 

● Alarm history 

● Operating data: Data and parameters of the basic device and the energy storage device 

● Trend charts: 

– Load current over time 

– Input voltage over time 

– Remaining buffer time over time 

– Battery temperature over time 

– Battery charge over time 

– Charge current over time 

● Online functions: 

– Updating the firmware 

Displaying pending alarms 
1. Select "Display > Pending alarms". 

The pending alarms are displayed in a tabular form. 
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The individual columns contain the following information: 

● Name: A descriptive name of the alarm 

● Time: The time and date of the alarm arrival 

● Help: Description of the alarm 

Displaying the alarm history 
1. Select "Display > Alarm history". 

The alarm history is displayed in a tabular form. 

 
The individual columns contain the following information: 

● Name: A descriptive name of the alarm 

● Time: The time and date when the alarm comes and goes 

● Alarm: 

– incoming: Occurrence of the alarm event 

– outgoing: Rectification of the alarm event 

Data and parameters SITOP UPS1600 
1. Select "Display > Operating data". 

2. Under "Base Unit" you can find data and parameters of the SITOP UPS1600. 

The following data are displayed: 

● Order number 

● Serial number 

● SW version 

● HW product version 

The following parameters are displayed: 

● Buffer mode 

● Remaining buffer time 

● Input voltage 
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● Load current 

● Ready for buffering 

Energy storage data and parameters 
1. Select "Display > Operating data". 

2. The data and parameters of the energy storage device can be found under "Energy 
storage". 

The following data are displayed: 

● Order number 

● Serial number 

● SW version 

The following parameters are displayed: 

● Battery capacity 

● Battery charge level 

● Battery temperature 

● Measured charge current 

Trend charts 
You have the possibility of graphically displaying values about the power supply under 
"Display> Trend chart", for instance the load current over time: 
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The following trend charts can be selected: 

● Load current over time 

● Input voltage over time 

● Remaining buffer time 

● Battery temperature over time 

● Battery charge over time 

● Charge current over time 

Procedure 

1. Select "Display > Trend diagram". 

2. Select "Base Unit" to display trend diagrams for SITOP UPS1600 values 

or 

select "Energy storage" to display trend diagrams for the energy storage device values. 

3 diagrams are available below both points. 

3. Click the appropriate button to display the required trend diagram. 
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3.5.11 Determining the firmware version 
 

The firmware version of the SITOP UPS1600 can be determined as follows using the UPS 
Manager: 

Precondition 

The SITOP UPS1600 is connected to your PC via USB. 

Also possible for a connection via Ethernet with software version> V2.0 - and manager 
version > 4.60.1 

Procedure 

1. Start the UPS Manager. 

2. Using the menu command "Display > Operating data > Base unit" the firmware version of 
the SITOP UPS1600 is displayed. 

 
In the example shown, firmware version V2.0.1 is installed on the SITOP UPS1600. 



 Engineering and remote access 
 3.5 SITOP UPS Manager 

SITOP UPS1600 / UPS1100 
Manual, 04.2016, A5E37775406-6-76 111 

3.5.12 Firmware update 
 

 WARNING 

The SITOP UPS1600 is reset while updating the firmware. For safety reasons, the output is 
switched off. 

Ensure that no damage is caused to the plant or system. 

Ensure that the PG/PC and/or all switches, routers and gateways that are used have an 
independent power supply during the firmware update. 

 

 Note 

Do not switch-off the devices during the firmware update. 
 

The files for updating the firmware (firmware updates) are available online under 
(http://support.automation.siemens.com/WW/view/en/79207181). Different firmware updates 
are offered depending on the amp rating of the SITOP UPS1600. 

 

 Note 
Observe the compatibility of the firmware! 

Other firmware updates are not compatible. 

Determine the amp rating of your SITOP UPS1600 and download the appropriate firmware 
update. 

 

 Note 

It is not possible to downgrade the device firmware to a release with a version number lower 
than the firmware installed in the device itself. Information on how to read out the firmware 
release from the device is provided in Section Display and visualization (Page 106). 

 

 Note 
"Reset to factory" function: 

Everything is reset, also the IP address. A new IP address must then be assigned, as 
otherwise there is no connection to the UPS Manager or TIA. 

 

Preconditions 

● The SITOP UPS1600 has been correctly connected and linked with the system. 

● PG/PC with SITOP UPS Manager is connected with the system. 

http://support.automation.siemens.com/WW/view/en/79207181


Engineering and remote access  
3.5 SITOP UPS Manager 

 SITOP UPS1600 / UPS1100 
112 Manual, 04.2016, A5E37775406-6-76 

 

 Note 

Install the current version of the SITOP UPS Managers, before you start the update. It is 
possible that an older version (less than 4.5X) of the SITOP UPS Managers does not 
support this update. The installation file for the SITOP UPS Manager is available at no 
charge on the SITOP home page (http://www.siemens.com/sitop-ups1600) or directly 
(https://support.industry.siemens.com/cs/ww/en/view/75854607). 

 

Procedure 

1. Select "Display > Online functions". 

2. Select "Update firmware". 

3. To select the path to the directory with the unzipped files, click on the "Browse" button. 
In this directory, select the "ups10a.upd", "ups20a.upd" or "ups40a.upd" file. 

4. Click on the "Start" button. 
The firmware is updated. 

5. A message appears in the window area after the successful update. 

6. Manually restart the STIOP UPS1600 by interrupting the STIOP UPS1600 power supply. 
Restore the power supply to the SITOP UPS1600. 

The firmware update has been performed successfully. 

http://www.siemens.com/sitop-ups1600
https://support.industry.siemens.com/cs/ww/en/view/75854607


 Engineering and remote access 
 3.6 Web server 

SITOP UPS1600 / UPS1100 
Manual, 04.2016, A5E37775406-6-76 113 

3.6 Web server 
The web server is used to monitor the SITOP UPS1600. It operates independently of 
UPS Manager and PROFINET access. It is not possible to write access the 
SITOP UPS1600. 

New functions of the web server from V2.1 and higher: 

● Write access 

● User management 

● Access via https 

3.6.1 Accessing the web server 
A Web browser is used for the access and operation. 

The following Web browsers are suitable: 

● Internet Explorer V8 (on MS Windows XP) 

● Internet Explorer V10 (on MS Windows 7) 

● Internet Explorer V11 (on MS Windows 7) 

● Mozilla Firefox V40 (on MS Windows 7) 

● Google Chrome V44 (on MS Windows 7) 

Preconditions 
● The computer with installed web browser is connected with the SITOP UPS1600 via 

Ethernet. 

● The Web browser can display SVG graphics. From version V2.1 and higher, it is no 
longer necessary that SVG graphics are supported. 

If your web browser cannot display SVG graphics, then "Please install the SVG viewer for 
a correct display" message appears on the start screen. To permit the correct display, 
perform the following steps: 

– Download the SVG update at (http://www.savarese.com/software/svgplugin). 

– Install the SVG update. 

– If required, restart your computer. 

● The SITOP UPS1600 has an IP address that you know. 

● Web server access is activated. 

The following sections explain how to activate access to the web server: 

– For SIMATIC STEP 7 in the TIA Portal at Parameterizing the UPS1600 (Page 51). 

– For SIMATIC STEP 7 at Parameter assignment (Page 70). 

http://www.savarese.com/software/svgplugin
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Procedure 
1. Connect the client (PG, PC) via the PROFINET interface with the CPU. 

2. Open the web browser. 
In the address dialog box of the web browser, enter the IP address of the 
SITOP UPS1600 in the form http://ww.xx.yy.zz (input example: http://192.168.0.14). 

The start page of SITOP UPS1600 is opened. You can navigate to further menus from the 
start page. 

3.6.2 The web server user interface 

 
① Language selection 
② "Configurations" save bar 
③ Editor area 
④ Submenus 
⑤ Menu 

Menu selection ⑤ allows you to access the "HW configuration" and "Display" menus and 
their associated submenus. The functions of the menus are described in the following 
sections. 

In this area, you can find the submenus dependent on the selected menu item. The function 
of the individual submenu items is presented in the following sections ④. 

The settings (for the submenu items) are made in the Editor area ③. 

The functions of the save bar ② are used to load the actual configuration to the 
SITOP UPS1600 and open or save the configurations to a data medium. 
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The language selection ① is used to select the user interface language of the web server. 
The German, English, French, Italian, Spanish, and Chinese languages are available. 

Grayed out menus 
If the SITOP UPS1600 was assigned a SIMATIC S7 control as I/O device, or the 
SITOP UPS Manager is connected to the SITOP UPS1600, then the web server is in the 
read-only mode. The following applies in the read-only mode: 

● No write access is possible; the parameter settings can only be read (input values shown 
in gray, valid for software version up to V2.0) 

● Firmware cannot be updated, the item is hidden. 

3.6.3 Functions of the web server 

Display 
The following functions are available: 

● View the data of the SITOP UPS1600 (basic device), see View the data of the SITOP 
UPS1600 (basic device) (Page 115) 

● View the energy storage data, see Viewing the energy storage data (Page 116) 

● Alarm monitoring (pending alarms, alarm history), see Alarm monitoring (Page 116) 

3.6.4 View the data of the SITOP UPS1600 (basic device) 
1. Select the "Display" menu 

2. Select the "Base unit" entry under "Operating data" in the navigation. 

The "Base unit" entry provides the following information:  

● Data of the SITOP UPS1600: 

– Order number 

– Serial number 

– SW version 

– HW product version 

● Operating mode (normal or buffer mode) 

● Ready for buffering 

● Remaining buffer time 

● Input voltage 

● Load current 
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3.6.5 Viewing the energy storage data 
1. Select the "Display" menu 

2. Select the "Energy storage" entry under "Operating data" in the navigation. 

3. Select the desired battery (example: battery 1) with a click. 

The "Battery" entry provides the following information: 

● Data of the battery module: 

– Order number 

– Serial number 

– SW version 

– HW product version 

● Capacity 

● Battery charge 

● Battery temperature 

● Load current 

3.6.6 Alarm monitoring 
You can use the web server to obtain information about active alarms and the history of the 
alarms. Every alarm that concerns the SITOP UPS1600 and the connected battery modules 
is recorded. You can display pending alarms via "Pending alarms". 

Displaying pending alarms 
1. Select the "Display" menu 

2. Select the "Pending alarms" entry under "Alarms" in the navigation. 

The active alarms are displayed in a tabular format. 

 
The individual columns contain the following information: 

● Name: A descriptive name of the alarm 

● Time: The time and date when the alarm came 

● Help: Description of the alarm 
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Displaying the alarm history 
1. Select the "Display" menu 

2. Select the "Alarm history" entry under "Alarms" in the navigation. 

The alarm history is displayed in a tabular form. 

 
The individual columns contain the following information: 

● Name: A descriptive name of the alarm 

● Time: The time and date when the alarm comes and goes 

● Alarm: 

– incoming: Occurrence of the alarm event 

– outgoing: Rectification of the alarm event 

 

 Note 
The alarm history is displayed only when no further communications relationships to the 
SITOP UPS1600 have been established. 

Examples for further communications relationships are communication relationships via 
STEP 7 or the SITOP UPS Manager. 
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3.6.7 Determining the firmware version 
The firmware version of the SITOP UPS1600 can be determined as follows via Ethernet 
using the web server: 

Using the menu command "Display > Operating data > Base unit" the firmware version of the 
SITOP UPS1600 is displayed. 

 
In the example shown, firmware version V2.0.1 is installed on the SITOP UPS1600. 
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3.6.8 Web server settings / user administration 
Here, you can make general settings and define which actions should be automatically 
executed. User administration is also located here. 

Settings 

 
 
Parameters Value range Default setting 
Activate web server on this module Yes/no No 
Permit access only with HTTPS Yes/no Yes 
Log off automatically after 15 minutes Yes/no No 
Update interval 0 / 5 s / 10 s / 20 s / 30 

s / 60 s 
10 s 

● Activate web server on this module 

Define as to whether the device may be accessed via the web server. 

● Permit access only with HTTPS 

Define whether access is only permissible via HTTPS. 

● Download certificate 

You can download the certificate for encrypted connection via HTTPS by pressing the 
"Download certificate" button. 
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● Log off automatically after 15 minutes 

Define whether a user should be automatically logged off after closing the web server. 

● Update interval 

Define the interval in which the actual values are sent to the web server. 

Procedure for changing the administrator password 

1. Select the "Hardware configuration" menu. 

2. Select submenu "General > Communication interface > Web server". 

3. Select entry "Settings". 

4. Make the required settings and carry out the appropriate actions in the editor area. 

5. Load the data to the device. 

User administration 
Here, you can change the administrator password and set up the system so that guests can 
access the system - and up to 14 additional user accounts with different authorization levels. 

 

Procedure for changing the administrator password 

1. Select the "Hardware configuration" menu. 

2. Select submenu "General > Communication interface > Web server". 

3. Select entry "User administration". 

4. In the editor area, under "Administrator" enter the current administrator password. 

5. In the editor area, under "Password" enter a new password. 

6. Repeat the new password. 

7. Load the data to the device. 

Procedure for setting up a guest access 

1. Select the "Hardware configuration" menu. 

2. Select submenu "General > Communication interface > Web server". 

3. Select entry "User administration". 

4. In the editor area under "Add new user" enter the password and select the individual 
access rights for a new user. 



 Engineering and remote access 
 3.6 Web server 

SITOP UPS1600 / UPS1100 
Manual, 04.2016, A5E37775406-6-76 121 

Procedure for setting up a user account  

1. Select the "Hardware configuration" menu. 

2. Select submenu "General > Communication interface > Web server". 

3. Select entry "User administration". 

4. In the editor area under "Add new user" enter the password and select the individual 
access rights for a new user. 



Engineering and remote access  
3.7 Cyclic and acyclic data 

 SITOP UPS1600 / UPS1100 
122 Manual, 04.2016, A5E37775406-6-76 

3.7 Cyclic and acyclic data 
The data communicated between the SITOP UPS1600 and the PROFINET IO-Controller 
can be viewed in STEP 7 or classic in the TIA Portal. Here, a distinction is made between 
cyclic data (input/output data) and acyclic data (reading/writing data sets). 

Input/output data 

SITOP UPS1600 sends, in cyclic intervals (1 ms - 512 ms for IRT or 1 ms - 2048 ms for RT), 
data about the actual operating states to the PROFINET IO-Controller. You will find more 
information on this at Input and output data (Page 122). 

Reading and writing data sets 

Reading and writing data sets are sent acyclically from the SITOP UPS1600 to the 
PROFINET IO-Controller or from the PROFINET IO-Controller to the SITOP UPS1600. 
Additional information can be found at Reading and writing data sets (Page 123).  

3.7.1 Input and output data 
An overview of the input and output data, which is cyclically sent from the SITOP UPS1600 
to the PROFINET IO controller is provided in the following tables.  
 
Slot Subslot Data Description Data size 
0 2 Input voltage Input voltage is present: 

• 0: NOT OK 
• 255: OK 

Unsigned8 

Buffer mode Buffer mode: The load connected 
to the SITOP UPS1600 is sup-
plied via the energy storage de-
vice connected to the 
SITOP UPS1600: 
• 0: inactive 
• 255: active 

Unsigned8 

Ready for buffering  Ready for buffer operation as the 
energy storage device of the 
buffer component has been suffi-
ciently charged. 
• 0: NOT OK 
• 255: OK 

Unsigned8 

Charge sufficient  Charge sufficient: The required 
charge has been reached when 
the flag is set: 
• 0: NOT OK 
• 255: OK 

Unsigned8 
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Slot Subslot Data Description Data size 
Battery change 
recommended  

Battery replacement recommend-
ed: The battery capacity is not 
sufficient for the defined buffer 
time: 
• 0: no 
• 255: yes 

Unsigned8 

New alarms pending  New alarms pending: 
• 0: no 
• 255: yes 

Unsigned8 

Battery charge level  Battery charge level in %: 
• 0-100: 0-100% 
• 255: unknown battery 

Unsigned8 

Battery connection 
maintenance  
from V2.1 

Connection to the battery inter-
rupted: Check the connection and 
fuse: 
• 0: no maintenance required 
• 255: maintenance required 

Unsigned8 

3.7.2 Reading and writing data sets 
An overview of all data sets, which are communicated between the SITOP UPS1600 and the 
PROFINET IO-Controller is provided in the following table. Here, a distinction is made 
between the following data sets: 

● Reading data sets: Data which is sent from the SITOP UPS1600 to the 
PROFINET IO-Controller. 

● Writing data sets: Data which is sent from the PROFINET IO-Controller to the 
SITOP UPS1600. 

 
Index Slot Subslot Data set Type Description Data size 
0x0001 0 1 Buffering parameters Reading / 

writing 
Buffer parameters. 
 

14 bytes 

0x0002 0 1 Battery parameters Reading / 
writing 

Parameters of the connected battery 
modules. 

5 bytes 

0x0003 0 1 Charging parameters Reading / 
writing 

Charge parameters of the connected 
battery modules. 

4 bytes 

0x0004 0 1 Reset parameters Reading / 
writing 

Reset parameters. 1 byte 

0x0005 0 1 Battery information 
parameters 

Reading Information about the connected battery 
modules SITOP UPS1100. This infor-
mation is available via the link "Energy 
Storage". 

1024 bytes 

0x0006 0 1 Device information 
Parameters 

Reading Information about the SITOP UPS1600. 148 bytes 
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Index Slot Subslot Data set Type Description Data size 
0x0007 0 1 Hardware settings 

parameters 
Reading Hardware settings of the 

SITOP UPS1600 (settings that were 
made at the front of the device). 

8 bytes 

0x0008 0 1 Buffering parameters 
from V2.0 

Reading / 
writing 

Buffer parameters of the 
SITOP UPS1600 

2 bytes 

0x0009 0 1 Maintenance parame-
ters from V2.1 

Reading / 
writing 

Maintenance parameters of 
SITOP UPS1600 

2 bytes 

0x0020 0 1 State information Reading Status information about 
SITOP UPS1600 and the connected 
battery modules SITOP UPS1100. 
Information about the SITOP UPS1100 
battery modules is available via the link 
"Energy Storage". 

64 bytes 
70 bytes 
(from V2.1) 

0x0040 0 1 Identification value 
parameters 

Reading / 
writing 

Device identification parameters. 80 bytes 
108 bytes 
(from V2.1) 

0x0041 0 1 Web server  
parameters 

Reading / 
writing 

Web server settings of the 
SITOP UPS1600. 

1 byte 
6 bytes (from 
V2.1) 

You can find detailed information about the individual data sets in Section Data sets 
(Page 124) 

3.7.2.1 Data sets 
In this section you can find detailed information about the individual data sets that are sent 
from the PROFINET IO-Controller to the SITOP UPS1600 - and which can be read from the 
SITOP UPS1600. 

0x0001: Buffering parameters (reading/writing) 
 
Data Description Data type 
Buffer time [1 s] Buffer time: After the selected buffer time has expired, the 

SITOP UPS1600 switches off the load output. The actual buffer 
time that can be achieved depends on the connected loads and 
energy storage devices. 

Unsigned16 

Buffer time 2 [1 s] Additional buffer time after PC shutdown. The specified value is 5 
seconds (only valid in conjunction with the PC software 
SITOP UPS Manager) 

Unsigned16 

Buffer threshold [0.01 V] Connection threshold: Switching voltage for buffering. Buffering is 
active below this value. 

Unsigned16 

Stop buffering voltage [0.01 V] Stop buffering voltage: Buffer operation is exited if the battery 
voltage is below this value. 

Unsigned16 

Input voltage OK time [1 ms] Wait time for stable input voltage: Minimum time during which the 
input voltage during buffer operation must be available at the 
SITOP UPS1600 to exit buffer operation of the SITOP UPS1600 
and to again supply the connected loads via the input voltage 
(normal operation).  

Unsigned16 
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Data Description Data type 
Downtime alarm [1 ms] Downtime alarm: Alarm filter - alarm is only sent if it is active for 

longer than the set time. 
Unsigned16 

Buffering allowed Activate or deactivate buffer operation. The setting is only accept-
ed in operating mode Remote Enable (REN) of the 
SITOP UPS1600. 

Unsigned8 

Enable reset after buffering Enable reset after buffering: If, during buffer operation, the input 
voltage becomes available again, then the output is switched off 
for a selectable time in order to reset the connected devices. 

Unsigned8 

0x0002: Battery parameters (reading/writing) 
 
Data Description Data type 
Battery defect voltage [0.01 V] Battery defect voltage: If the battery voltage falls below the set 

value, then the battery is identified to be defective. 
Unsigned16 

Battery capacity [0.1 Ah] Battery capacity: Total battery capacity of all energy storage de-
vices connected to the SITOP UPS1600. 

Unsigned16 

Ignore battery coding Ignore data of the coded battery: When this parameter is set to 
"1", then data of the coded battery is ignored. Instead, data is 
taken from the parameterization ("Battery Parameters", "Charging 
Parameters"). 

Unsigned8 

0x0003: Charging parameters (reading/writing) 
 
Data Description Data type 
End of charge voltage [0.01 V] End of charge voltage: Battery voltage when charging changes to 

trickle charging. The connected energy storage device is then 
charged up to 100 %. 

Unsigned16 

Charge current [1 mA] Charge current: Current magnitude used to charge the connected 
battery modules during the constant charging process. 

Unsigned16 

0x0004: Reset parameters (reading/writing) 
 
Data Description Data type 
Reset time [1 s] Reset time: Time during which the SITOP UPS1600 output is 

shutdown if the connected devices are reset. 
Unsigned8 

0x0005: Battery information parameters (reading) 
 
Data Description Data type 
Number of batteries Number of connected battery modules. Here, only the 

SITOP UPS1100 battery modules (coded batteries) are counted. 
Unsigned8 

Fill byte(s) - 3xUnsigned8 
Batt 1: Standby time [1 s] Standby time. Unsigned32 
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Data Description Data type 
Batt 1: Buffer time [1 s] Required buffer time, after which the SITOP UPS1600 shuts down 

in the buffer mode. 
Unsigned32 

Batt 1: Total charging current 
[1 mA] 

Total charge current (battery-specific data): Total charge within the 
service lifetime of the SITOP UPS1600. 

Unsigned32 

Batt 1: Total culled current [1 mAh] Total charge level used (battery-specific data): Time, in which the 
battery is connected to the SITOP UPS1600 and power was 
drawn. 

Unsigned32 

Batt 1: EOCV [0.01 V] "End-of-charge voltage": Battery voltage when charging changes 
to trickle charging. The energy storage device is then charged up 
to 100 %. 

Unsigned16 

Batt 1: Charge current [1 mA] Charge current: Current magnitude used to charge the connected 
battery modules during the constant charging process. 

Unsigned16 

Batt 1: Battery capacity [0.1 Ah] Battery capacity: Total battery capacity of all energy storage de-
vices connected to the SITOP UPS1600. 

Unsigned16 

Batt 1: Stop buffering voltage 
[0.01 V] 

Stop buffering voltage: Buffer operation is exited if the battery 
voltage is below this value. 

Unsigned16 

Batt 1: Battery type Battery type Unsigned8 
Batt 1: Minimal temperature [1 °C] Lowest specified operating temperature of the battery module 

being used SITOP UPS1100. 
Signed8 

Batt 1: Maximal temperature [1 °C] Highest specified operating temperature of the battery module 
being used SITOP UPS1100. 

Signed8 

Fill byte(s) - 3xUnsigned8 
Batt 1: Order number Order number (Article number). VisibleString(30) 
Batt 1: Serial number Serial number VisibleString(30) 
Batt 1: Manufacturing date Manufacturing date VisibleString(30) 
Batt 1: Version number Version number VisibleString(50) 
Batt 2: Standby time [1 s] Standby time. Unsigned32 
Batt 2 Buffer time [1 s] Required buffer time, after which the SITOP UPS1600 shuts down 

in the buffer mode. 
Unsigned32 

Batt 2: Total charging current 
[1 mA] 

Total charge current (battery-specific data): Total charge within the 
service lifetime of the SITOP UPS1600. 

Unsigned32 

Batt 2: Total culled current [1 mAh] Total charge level used (battery-specific data): Time, in which the 
battery is connected to the SITOP UPS1600 and power was 
drawn. 

Unsigned32 

Batt 2: EOCV [0.01 V] "End-of-charge voltage": Battery voltage when charging changes 
to trickle charging. The energy storage device is then charged up 
to 100 %. 

Unsigned16 

Batt 2: Charge current [1 mA] Charge current: Current magnitude used to charge the connected 
battery modules during the constant charging process. 

Unsigned16 

Batt 2: Battery capacity [0.1 Ah] Battery capacity: Total battery capacity of all energy storage de-
vices connected to the SITOP UPS1600. 

Unsigned16 

Batt 2 Stop buffering voltage 
[0.01 V] 

Stop buffering voltage: Buffer operation is exited if the battery 
voltage is below this value. 

Unsigned16 

Batt 2: Battery type Battery type Unsigned8 
Batt 2: Minimal temperature [1 °C] Lowest specified operating temperature of the battery module 

being used SITOP UPS1100. 
Signed8 
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Data Description Data type 
Batt 12 Maximal temperature [1 °C] Highest specified operating temperature of the battery module 

being used SITOP UPS1100. 
Signed8 

Fill byte(s) - 3xUnsigned8 
Batt 2: Order number Order number (Article number). VisibleString(30) 
Batt 2: Serial number Serial number VisibleString(30) 
Batt 2: Manufacturing date Manufacturing date VisibleString(30) 
Batt 2: Version number Version number VisibleString(50) 
Batt 3: Standby time [1 s] Standby time. Unsigned32 
Batt 3: Buffer time [1 s] Required buffer time, after which the SITOP UPS1600 shuts down 

in the buffer mode. 
Unsigned32 

Batt 3: Total charging current 
[1 mA] 

Total charge current (battery-specific data): Total charge within the 
service lifetime of the SITOP UPS1600. 

Unsigned32 

Batt 3: Total culled current [1 mAh] Total charge level used (battery-specific data): Time, in which the 
battery is connected to the SITOP UPS1600 and power was 
drawn. 

Unsigned32 

Batt 3: EOCV [0.01 V] "End-of-charge voltage": Battery voltage when charging changes 
to trickle charging. The energy storage device is then charged up 
to 100 %. 

Unsigned16 

Batt 3: Charge current [1 mA] Charge current: Current magnitude used to charge the connected 
battery modules during the constant charging process. 

Unsigned16 

Batt 3: Battery capacity [0.1 Ah] Battery capacity: Total battery capacity of all energy storage de-
vices connected to the SITOP UPS1600. 

Unsigned16 

Batt 3: Stop buffering voltage 
[0.01 V] 

Stop buffering voltage: Buffer operation is exited if the battery 
voltage is below this value. 

Unsigned16 

Batt 3: Battery type Battery type Unsigned8 
Batt 3: Minimal temperature [1 °C] Lowest specified operating temperature of the battery module 

being used SITOP UPS1100. 
Signed8 

Batt 3: Maximal temperature [1 °C] Highest specified operating temperature of the battery module 
being used SITOP UPS1100. 

Signed8 

Fill byte(s) - 3xUnsigned8 
Batt 3: Order number Order number (Article number). VisibleString(30) 
Batt 3 Serial number Serial number VisibleString(30) 
Batt 3: Manufacturing date Manufacturing date VisibleString(30) 
Batt 3: Version number Version number VisibleString(50) 
Batt 4: Standby time [1 s] Standby time. Unsigned32 
Batt 4: Buffer time [1 s] Required buffer time, after which the SITOP UPS1600 shuts down 

in the buffer mode. 
Unsigned32 

Batt 4: Total charging current 
[1 mA] 

Total charge current (battery-specific data): Total charge within the 
service lifetime of the SITOP UPS1600. 

Unsigned32 

Batt 4: Total culled current [1 mAh] Total charge level used (battery-specific data): Time, in which the 
battery is connected to the SITOP UPS1600 and power was 
drawn. 

Unsigned32 

Batt 4: EOCV [0.01 V] "End-of-charge voltage": Battery voltage when charging changes 
to trickle charging. The energy storage device is then charged up 
to 100 %. 

Unsigned16 

Batt 4: Charge current [1 mA] Charge current: Current magnitude used to charge the connected 
battery modules during the constant charging process. 

Unsigned16 
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Data Description Data type 
Batt 4: Battery capacity [0.1 Ah] Battery capacity: Total battery capacity of all energy storage de-

vices connected to the SITOP UPS1600. 
Unsigned16 

Batt 4: Stop buffering voltage 
[0.01 V] 

Stop buffering voltage: Buffer operation is exited if the battery 
voltage is below this value. 

Unsigned16 

Batt 4: Battery type Battery type Unsigned8 
Batt 4: Minimal temperature [1 °C] Lowest specified operating temperature of the battery module 

being used SITOP UPS1100. 
Signed8 

Batt 4: Maximal temperature [1 °C] Highest specified operating temperature of the battery module 
being used SITOP UPS1100. 

Signed8 

Fill byte(s) - 3xUnsigned8 
Batt 4: Order number Order number (Article number). VisibleString(30) 
Batt 4: Serial number Serial number VisibleString(30) 
Batt 4: Manufacturing date Manufacturing date VisibleString(30) 
Batt 4: Version number Version number VisibleString(50) 
Batt 5: Standby time [1 s] Standby time. Unsigned32 
Batt 5: Buffer time [1 s] Required buffer time, after which the SITOP UPS1600 shuts down 

in the buffer mode. 
Unsigned32 

Batt 5: Total charging current 
[1 mA] 

Total charge current (battery-specific data): Total charge within the 
service lifetime of the SITOP UPS1600. 

Unsigned32 

Batt 5: Total culled current [1 mAh] Total charge level used (battery-specific data): Time, in which the 
battery is connected to the SITOP UPS1600 and power was 
drawn. 

Unsigned32 

Batt 5: EOCV [0.01 V] "End-of-charge voltage": Battery voltage when charging changes 
to trickle charging. The energy storage device is then charged up 
to 100 %. 

Unsigned16 

Batt 5: Charge current [1 mA] Charge current: Current magnitude used to charge the connected 
battery modules during the constant charging process. 

Unsigned16 

Batt 5: Battery capacity [0.1 Ah] Battery capacity: Total battery capacity of all energy storage de-
vices connected to the SITOP UPS1600. 

Unsigned16 

Batt 5: Stop buffering voltage 
[0.01 V] 

Stop buffering voltage: Buffer operation is exited if the battery 
voltage is below this value. 

Unsigned16 

Batt 5: Battery type Battery type Unsigned8 
Batt 5: Minimal temperature [1 °C] Lowest specified operating temperature of the battery module 

being used SITOP UPS1100. 
Signed8 

Batt 5: Maximal temperature [1 °C] Highest specified operating temperature of the battery module 
being used SITOP UPS1100. 

Signed8 

Fill byte(s) - 3xUnsigned8 
Batt 5: Order number Order number (Article number). VisibleString(30) 
Batt 5: Serial number Serial number VisibleString(30) 
Batt 5: Manufacturing date Manufacturing date VisibleString(30) 
Batt 5: Version number Version number VisibleString(50) 
Batt 6: Standby time [1 s] Standby time. Unsigned32 
Batt 6 Buffer time [1 s] Required buffer time, after which the SITOP UPS1600 shuts down 

in the buffer mode. 
Unsigned32 

Batt 6 Total charging current 
[1 mA] 

Total charge current (battery-specific data): Total charge within the 
service lifetime of the SITOP UPS1600. 

Unsigned32 
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Data Description Data type 
Batt 6: Total culled current [1 mAh] Total charge level used (battery-specific data): Time, in which the 

battery is connected to the SITOP UPS1600 and power was 
drawn. 

Unsigned32 

Batt 6: EOCV [0.01 V] "End-of-charge voltage": Battery voltage when charging changes 
to trickle charging. The energy storage device is then charged up 
to 100 %. 

Unsigned16 

Batt 6: Charge current [1 mA] Charge current: Current magnitude used to charge the connected 
battery modules during the constant charging process. 

Unsigned16 

Batt 6: Battery capacity [0.1 Ah] Battery capacity: Total battery capacity of all energy storage de-
vices connected to the SITOP UPS1600. 

Unsigned16 

Batt 6: Stop buffering voltage 
[0.01 V] 

Stop buffering voltage: Buffer operation is exited if the battery 
voltage is below this value. 

Unsigned16 

Batt 6: Battery type Battery type Unsigned8 
Batt 6: Minimal temperature [1 °C] Lowest specified operating temperature of the battery module 

being used SITOP UPS1100. 
Signed8 

Batt 6: Maximal temperature [1 °C] Highest specified operating temperature of the battery module 
being used SITOP UPS1100. 

Signed8 

Fill byte(s) - 3xUnsigned8 
Batt 6: Order number Order number (Article number). VisibleString(30) 
Batt 6: Serial number Serial number VisibleString(30) 
Batt 6: Manufacturing date Manufacturing date VisibleString(30) 
Batt 6: Version number Version number VisibleString(50) 

0x0006: Device information parameters (reading) 
 
Data Description Data type 
HW revision Hardware version Unsigned16 
SW revision Software release Unsigned16 
Boot loader version Boot loader version Unsigned16 
Max output current [1 A] Maximum output current Unsigned8 
Fill byte(s) - Unsigned8 
MLFB/Order number MLFB/order number (Article number) VisibleString(30) 
Serial number Serial number VisibleString(30) 
Device name Device name VisibleString(30) 
Version number Version number VisibleString(50) 
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0x0007: Hardware setting parameters (reading) 
 
Data Description Data type 
Buffer time [1 s] Buffer time: After the selected buffer time has expired, the 

SITOP UPS1600 switches off the load output. The actual buffer 
time that can be achieved depends on the connected loads and 
energy storage devices. 

Unsigned16 

Buffer threshold [0.01 V] Connection threshold: Switching voltage for buffering. Buffering is 
active below this value. 

Unsigned16 

Buffering allowed Activate or deactivate buffer operation. The setting is only accept-
ed in operating mode Remote Enable (REN) of the 
SITOP UPS1600. 

Unsigned8 

Enable reset Enable reset: If, during buffer operation, the input voltage be-
comes available again, then the output of the SITOP UPS1600 is 
switched off for a selectable time in order to reset connected 
loads. 

Unsigned8 

Start from battery Start from battery: Setting at the signal terminal for function "Start 
from battery". 

Unsigned8 

Selected battery profile Profile of the selected battery: The battery charging behavior is set 
at the signal terminals. The setting is only used, if the 
SITOP UPS1600 is not in the "Remote Enable" (REN) mode 

Unsigned8 

0x0008: Buffering parameters (reading/writing) 
 
Data Description Data type 
Expected buffer current [0.1 Ah] 
from V2.0 and higher 

Expected buffer current: Estimated average load current during 
buffer operation. 

Unsigned16 

0x0009: Maintenance parameters (reading/writing) 
 
Data Description Data type 
Resistor test interval [1 h] from 
V2.1 

R test interval Unsigned16 

0x0020: State information (reading) 
 
Data Description Data type 
Remaining buffer time [1 s] Probable remaining buffer time. The remaining buffer time is cal-

culated based on the present battery charge and the average 
current over a 10 minute period. 

Unsigned32 

Total operating time [1 h] Total operating time. Unsigned32 
Total calculated battery capacity 
[0.1 Ah] 

Total calculated battery capacity Unsigned16 

Calculated battery 1 capacity 
[0.1 Ah] 

Battery 1: Calculated battery capacity. Unsigned16 

Calculated battery 2 capacity 
[0.1 Ah] 

Battery 2: Calculated battery capacity. Unsigned16 
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Data Description Data type 
Calculated battery 3 capacity 
[0.1 Ah] 

Battery 3: Calculated battery capacity. Unsigned16 

Calculated battery 4 capacity 
[0.1 Ah] 

Battery 4: Calculated battery capacity. Unsigned16 

Calculated battery 5 capacity 
[0.1 Ah] 

Battery 5: Calculated battery capacity. Unsigned16 

Calculated battery 6 capacity 
[0.1 Ah] 

Battery 6: Calculated battery capacity. Unsigned16 

Input voltage [0.01 V] Input voltage: Measured rms value of the supply voltage at the 
input of the SITOP UPS1600. 

Unsigned16 

Input current [5 mA] Current measured at the input of the SITOP UPS1600. Unsigned16 
Output voltage [0.01 V] Voltage measured at the output of the SITOP UPS1600. Unsigned16 
Load current [5 mA] Load current measured at the output of the SITOP UPS1600. Unsigned16 
Measured charge current [1 mA] Measured battery charge current of the SITOP UPS1600. Unsigned16 
Battery voltage [0.01 V] Measured battery voltage of the connected battery modules. Unsigned16 
Output current [5 mA] Load current measured at the output of the SITOP UPS1600. Unsigned16 
Charge voltage [0.01 V] Voltage used to charge the batteries during the constant charging 

process. 
Unsigned16 

Fill byte(s) - 3 x Unsigned8 
Valid configuration Valid configuration: Indicates whether the software parameters or 

the parameters at the rotary switches are used. The corresponding 
setting should be made at the rotary switch for the buffer thresh-
old. 

Unsigned8 

Number of batteries Number of connected battery modules. Here, only the 
SITOP UPS1100 battery modules (coded batteries) are counted. 

Unsigned8 

Fill byte(s) - 7 x Unsigned8 
Battery 1 change recommended Battery 1: Battery replacement recommended: The battery capaci-

ty is not sufficient for the defined buffer time. 
Unsigned8 

Battery 2 change recommended Battery 2: Battery replacement recommended: The battery capaci-
ty is not sufficient for the defined buffer time. 

Unsigned8 

Battery 3 change recommended Battery 3: Battery replacement recommended: The battery capaci-
ty is not sufficient for the defined buffer time. 

Unsigned8 

Battery 4 change recommended Battery 4: Battery replacement recommended: The battery capaci-
ty is not sufficient for the defined buffer time. 

Unsigned8 

Battery 5 change recommended Battery 5: Battery replacement recommended: The battery capaci-
ty is not sufficient for the defined buffer time. 

Unsigned8 

Battery 6 change recommended Battery 6: Battery replacement recommended: The battery capaci-
ty is not sufficient for the defined buffer time. 

Unsigned8 

Battery 1 Connection Fault Battery1: Connection fault Unsigned8 
Battery 2 Connection Fault Battery2: Connection fault Unsigned8 
Battery 3 Connection Fault Battery3: Connection fault Unsigned8 
Battery 4 Connection Fault Battery4: Connection fault Unsigned8 
Battery 5 Connection Fault Battery5: Connection fault Unsigned8 
Battery 6 Connection Fault Battery6: Connection fault Unsigned8 
Battery 1 temperature [1 °C] Battery 1: Battery temperature Integer8 
Battery 2 temperature [1 °C] Battery 2: Battery temperature Integer8 



Engineering and remote access  
3.7 Cyclic and acyclic data 

 SITOP UPS1600 / UPS1100 
132 Manual, 04.2016, A5E37775406-6-76 

Data Description Data type 
Battery 3 temperature [1 °C] Battery 3: Battery temperature Integer8 
Battery 4 temperature [1 °C] Battery 4: Battery temperature Integer8 
Battery 5 temperature [1 °C] Battery 5: Battery temperature Integer8 
Battery 6 temperature [1 °C] Battery 6: Battery temperature Integer8 
Device temperature [1 °C] Temperature in the housing Integer8 
Device temperature Status of LEDs 1 to 4 for the SITOP UPS1600 Unsigned8 

0x0040: Identification value parameters (reading/writing) 
 
Data Description Data type 
Contact Name of the contact person. You can change the name to suit 

your requirements (maximum 22 characters). 
VisibleString(40) 
VisibleString(64) 
from V2.1 

Location Location designation: Indicates the unique location of the 
SITOP UPS1600 (max. 22 characters). 

VisibleString(40) 
VisibleString(44) 
from V2.1 

0x0041: Web server parameters (reading/writing) 
 
Data Description Data type 
WebserverEnabled  Enable/disable the web server of the SITOP UPS1600: 

• 0: disable 
• 255. enable 

Unsigned8 

AutoReloadEnabled from V2.1 Enable/disable automatic update: 
• 0: disable 
• 255. enable 

Unsigned8 

ReloadTime from V2.1 Update interval: 
• 0: Off 
• 5: 5s 
• 10: 10s 
• 20: 20s 
• 30: 30s 
• 60: 60s 

Unsigned8 

AutoLogout from V2.1 Enable/disable automatic logoff: 
• 0: disable 
• 255. enable 
When automatic logoff is activated, the logged on user ("Guest" or 
"Admin") is automatically logged off when the SITOP UPS1600 
web server is inactive for 15 minutes. 

Unsigned8 
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Data Description Data type 
HttpAccessEnable from V2.1 Enable/disable HTTP access: 

• 0: disable 
• 255: enable 

Unsigned8 

Fill byte(s) from V2.1 - Unsigned8 
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 Troubleshooting 4 
 

 

The help text provides further information about a pending alarm. 
The Extended Error Type helps to interpret the alarms in self-programmed S7 function 
blocks. 
The maintenance specifies the severity of the alarm: 
D = Diagnostics 
MD = Maintenance Demanded 
MR = Maintenance Required 

 
Error 
Type 

Extended 
Error Type 

Maintenance Alarm Text Help Text 

256 1 D Software corrupted Software has been corrupted - attempt to update the 
software. 

256 2 MR Wrong checksum Internal error: Communication disrupted 
256 3 MR Parameter corrupt Attempting to write to an unknown or read-only 

object. 
256 4 MR Unknown parameter Attempting to set a parameter that is not known by 

DC UPS. 
256 5 MR Wrong message length Internal error: Communication disrupted 
256 6 MR Wrong parameter Parameter value lies outside the valid range. 
256 7 MR Command not accepted An incorrect command was sent to the DC UPS 
256 8 MR Communication error: Wrong 

length field 
Syntax error in command 

256 9 MR Wrong request Error in sent message: Unknown request sent. 
256 10 MR Cannot write to object Attempting to write a parameter that is "read-only" 
256 11 MR Object pending DC UPS cannot provide data for the requested 

object. 
256 12 MR Battery not available Attempting to access a battery that is not available. 

Either the battery with the requested number was 
never connected or communication with this battery 
was interrupted. 

256 13 MR EEPROM write error Saving DC UPS parameters failed. Device is defec-
tive. 

256 14 MR Unknown alarm Internal error: Wrong parameter at execution of test 
command. 

256 15 MR Command outside range An incorrect command was sent to the DC-UPS. 
256 16 MR Software update is being 

performed. 
The command sent cannot be executed as long as 
the program is running. 

256 17 MR No software update Cannot execute the sent command because no 
software update has been started. 

256 18 MR Wrong battery number Attempting to retrieve data about a battery which 
does not exist or is not connected. 

256 19 MR Wrong address Wrong Flash address in software update - software 
update file is corrupt. 
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Error 
Type 

Extended 
Error Type 

Maintenance Alarm Text Help Text 

256 20 MR Write error Cannot write to flash - hardware may be defective. 
256 21 MR Read error Unable to read EEPROM. Device is defective. 
256 22 MR Wrong device ID An attempt was made to update the software with 

an update file that is not suitable for the DC PS. 
256 23 MR Corrupt data record Error during software update - try to update the 

software again. 
256 24 MR Wrong update An attempt was made to update the software with 

an invalid update file. The update file is probably too 
old. 

256 25 MR Too much data An entry in the software update cannot contain more 
than 32 bytes of reference data. 

256 26 D Device failure Device failure 
257 1 MD Buffer mode not possible. Buffer mode is not possible - check settings, ca-

bling, fuse, and battery voltages 
257 2 MD Device temperature critical 

(too high) 
Device temperature is very high! Ensure adequate 
cooling or disconnect unnecessary loads. 

257 3 MD Device temperature critical 
(too low) 

Device temperature is very low! Ensure a higher 
ambient temperature. 

257 4 D High-resistance connection 
to battery. 

High-resistance connection to battery - check the 
battery power cables. 

257 5 D Connection to battery inter-
rupted. 

Connection to battery interrupted - check connection 
and fuse. 

257 6 MD Unknown battery Data from the battery cannot be read correctly. 
Battery is defective or not supported by SIEMENS. 

257 7 MR Overcurrent Output current of DC UPS is too high. Output is 
switched off for 20 s The output is switched on 
again after 20 s. 

257 12 MR Reset executed. Input voltage at DC UPS was OK again before the 
buffer time expired. Connected devices are reset by 
switching off the DC UPS outputs for the configured 
time. 

257 13 MR Battery test Battery "State of Health" tests (SoH) are performed. 
The output of the DC UPS is connected to the bat-
tery in order to determine the actual battery capaci-
ty. 

257 15 MR Input voltage is too high Input voltage exceeds 30 V. DC UPS is not opera-
tional. 

257 16 MD Surplus battery More than 6 batteries are connected. Connect a 
maximum of 6 batteries to the Energy Storage Link. 

257 17 D DC UPS parameters corrupt. DC UPS parameters corrupt - attempt to update the 
software. 

257 18 D Device overtemperature Output and battery charging is switched off to pre-
vent damage to the device. 

257 19 MR Battery SoH test Battery "State of Health" tests (SoH) are performed. 
257 20 MR Low voltage mode Input voltage of DC UPS is too low. DC UPS is not 

ready for buffering. 
257 21 MR Buffering Device is in the buffer mode. 



 Troubleshooting 
 

SITOP UPS1600 / UPS1100 
Manual, 04.2016, A5E37775406-6-76 137 

Error 
Type 

Extended 
Error Type 

Maintenance Alarm Text Help Text 

257 24 F Wrong battery polarity Wrong battery polarity - check battery connections. 
257 25 MD Reserve  
257 26 MR Insufficient charge level Battery charge level presently too low to reach the 

set buffer capacity. 
257 27 MR Deep discharge battery Battery is deep discharged - no buffering possible. 
258 1 D Battery defective (battery 

index: x) 
Battery defective - check the fuse and the battery 
voltages. 

258 2 D Battery deep discharged, 
charging not possible (bat-
tery index: {1:d}). 

Battery is deep discharged - replace battery. 

258 3 MD Battery temperature high 
(battery index: {1:d}). 

Battery temperature too high - battery life will be 
shortened. 

258 4 MD Battery temperature low 
(battery index: {1:d}). 

Battery temperature too low - reduced output cur-
rent 

258 5 D Communication error to 
battery (battery index: {1:d}). 

Communication with formerly known battery is no 
longer possible - check communication. 

258 7 D Wrong battery configuration 
(battery index: x). 

Different battery types connected. Only batteries of 
the same type can be operated together. 

258 8 MD Battery parameters corrupt 
(battery index: {1:d}). 

Battery defective - replace battery. 

258 12 D Fuse is defective (battery 
index: x). 

Fuse is defective. 
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 Mounting/removing 5 
5.1 SITOP UPS1600 
 

 WARNING 

Installing the device in a housing or a control cabinet 

The SITOP UPS1600s are built-in units. They must be installed in a housing or control 
cabinet where only qualified personnel have access. 

 

The device can be mounted in a control cabinet on standard TH35×7.5/15 mounting rails 
(according to EN 60715). 

Mounting 

To mount the device, position it with the mounting rail guide at the upper edge of the 
standard mounting rail and press down to lock it into place. If this is too difficult, press slider 
⑩ at the same time, as described under "Removal". 

Removal 

To remove, carefully open the slider ⑩ using a screwdriver or by hand (see Image 5-1 
Removal (example 6EP4136-3AB00-2AY0) (Page 139)) and disengage the device at the 
bottom edge of the standard mounting rail. Then you can remove the device from the upper 
edge of the standard mounting rail. 

 
Image 5-1 Removal (example 6EP4136-3AB00-2AY0) 
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5.1.1 Signal connector 

Mounting 

Push connector on socket ④ in the housing. 

Removal 

To remove the signal connector, press the release lever (4b) (see Image 5-2 
Mounting/removal: Signal connector (Page 140)) and then remove the connector. 

 
Image 5-2 Mounting/removal: Signal connector 

5.1.2 USB connector 
For deployment in an explosion-endangered environment, a USB connector with strain relief 
must be used. 

Mounting 

Push the connector onto the socket in the housing until the strain relief (6b) snaps into the 
housing (6a). 

Removal 

To remove the USB connector, press to release the strain relief (6b) (see Image 5-3 
Mounting/removal: USB connector (Page 140)) and then remove the connector. 

 
Image 5-3 Mounting/removal: USB connector 
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5.1.3 PROFINET/Ethernet connector 
For use in a hazardous zone, a PROFINET/Ethernet connector with strain relief must be 
used. 

Mounting 

Push the connector onto the socket in the housing until the strain relief (5b) snaps into the 
housing (5a). 

Removal 

To remove the PROFINET/Ethernet connector, press to release the strain relief (5b) (see 
Image 5-4 Mounting/removal: Ethernet (Page 141)) and then remove the connector. 

 
Image 5-4 Mounting/removal: Ethernet 
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5.2 SITOP UPS1100 
 

 WARNING 

Mounting the device in a housing or a control cabinet 

The SITOP UPS1100 battery modules are built-in units. They must be mounted in a 
housing or control cabinet where only qualified personnel have access. 

 

All devices are suitable for direct wall mounting. 
Devices 6EP4131-0GB00-0AY0 (1.2 Ah), 6EP4132-0GB00-0AY0 (2.5 Ah), 6EP4133-
0GB00-0AY0 (3.2 Ah) and 6EP4133-0JB00-0AY0 (5 Ah) can also be snapped onto a 
standard mounting rail TH35×15 (EN 60715), and device 6EP4131-0GB00-0AY0 (1.2 Ah) 
also onto a standard mounting rail TH35×7.5 (EN 60715). 

The lower part of the control cabinet or the coolest location in the control cabinet should be 
chosen as mounting location. 

Mounting 

See Chapter Dimensions and weight for the holes for wall mounting SITOP UPS1100 
(Page 36). 

To mount the device on a standard mounting rail, place it with the standard mounting rail 
guide at the upper edge of the standard mounting rail and snap it in downwards. If this is too 
difficult, push the device downwards while pressing on the rail as described for "Removal". 

 

 Note 

The fuses should be inserted in the fuse holder only when commissioning the device 
(charged batteries). 

 

Removal 

To remove the device, pull it forcibly downwards while removing it from the lower edge of the 
standard mounting rail (see Image 5-5 Removal (example 6EP4133-0GB00-0AY0 (3,2 Ah)) 
(Page 143)). Then you can remove the device from the upper edge of the standard mounting 
rail. 
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Image 5-5 Removal (example 6EP4133-0GB00-0AY0 (3,2 Ah)) 
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 Mounting position, mounting clearances 6 
6.1 SITOP UPS1600 

6.1.1 Standard mounting position 
The device is designed for mounting on standard EN 60715 35×7.5/15 mounting rails. The 
device must be mounted vertically to ensure proper cooling, and with the input terminals and 
output terminals at the bottom. 

A clearance of at least 50 mm should be maintained above and below the device. 

No clearance is required at the side. 

Output current as a function of the ambient temperature 

 
Image 6-1 6EP4134-3AB00-... : Output current in the standard mounting position 
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Image 6-2 6EP4136-3AB00-... : Output current in the standard mounting position 

 

 
Image 6-3 6EP4137-3AB00-... : Output current in the standard mounting position 

6.1.2 Other mounting positions 
Not released. 
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6.2 SITOP UPS1100 

6.2.1 Standard mounting position 
The device is suitable for the direct wall mounting. Devices 6EP4131-0GB00-0AY0 (1.2 Ah), 
6EP4132-0GB00-0AY0 (2.5 Ah), 6EP4133-0GB00-0AY0 (3.2 Ah) and 6EP4133-0JB00-
0AY0 (5 Ah) can also be snapped onto a standard mounting rail TH35×15 (EN 60715), and 
device 6EP4131-0GB00-0AY0 (1.2 Ah), also onto a standard mounting rail TH35×7.5 
(EN 60715). It should also be mounted at the coolest point in the control cabinet (e.g. in the 
lower part of the control cabinet). The device must be mounted vertically in such a way that 
the terminals are at the bottom. 

No clearance is required at the side. 

6.2.2 Other mounting positions 
 

 Note 

In the case of mounting positions that deviate from the standard mounting position, reduced 
mechanical resistance of the devices against vibration and shock must be expected. 

Particularly when installing on a vertically fastened standard mounting rail, additional 
measures may be required, e.g. to prevent the device from slipping on the rail. 

 

All mounting positions have been released, except the following: 
For UPS1100 1.2 Ah: Mounting position (2) (see the following diagram) 
all other UPS1100: Mounting position (5) (see the following diagram) 

 
Image 6-4 Mounting positions forbidden for the UPS1100 
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6.3 Altitude derating 

Output current as a function of the altitude derating 
 

 
Image 6-5 Altitude derating 

Details see chapter Environmental conditions (Page 169) 
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 Installation 7 
 

 
 

 Note 

When installing the devices, the relevant country-specific regulations must be complied with. 

The 24 V supply voltage must be SELV in accordance with EN60950-1 and EN50178. 

Only qualified personnel are allowed to install the device/system and set it into operation. 

The connections must not be attached or detached during operation. 
 

 Note 
for SITOP UPS1100 

The self-discharge rate of the batteries is approx. 3%/month for a temperature of 20° C. This 
value is temperature dependent and becomes more unfavorable for an increasing 
temperature, and more favorable for a decreasing temperature. 

The fuses should only be inserted in the fuse holder when commissioning the device. 

SITOP UPS1100 1.2 Ah is only recommended in conjunction with SITOP UPS1600 10 A. 

SITOP UPS1100 2.5 Ah, 3.2 Ah and 5 Ah are only recommended in conjunction with 
SITOP UPS1600 10 A and 20 A. 

 

When using battery modules without Energy Storage Link, it must be ensured that the 
selected batteries match the data of the UPS1600 (static and dynamic load current, charge 
current). 
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Image 7-1 Wiring 

7.1 Connecting the SITOP UPS1600 at its input 
SITOP UPS1600 is designed to be connected to a 24 V DC supply. The 24 V supply voltage 
must be SELV in accordance with EN60950-1 and EN50178. 

 
Image 7-2 Input side connection 

The 24 V power supply is connected at the "IN+", and "IN-" ① terminals (see Image 7-2 
Input side connection (Page 150)). 

Cables must be used that are suitable for at least 90 °C (only for applications for UL508). 
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7.2 Connecting the SITOP UPS1600 at its output 
The output of the SITOP UPS1600 is no-load, overload and short-circuit proof. If an overload 
occurs, the electronic current limiting function limits the output current to a maximum value 
(see Section Technical data (Page 155)). 

 
Image 7-3 Output-side connection 

The output voltage is connected at the "OUT+" and "OUT–" ② terminals (see Image 7-3 
Output-side connection (Page 151)). Ensure that the output cables are dimensioned 
correctly for the maximum output current rms value and fused accordingly. 

The deployed cables must be suitable for temperatures of at least 90° C. (only for 
applications for UL508) 

7.3 Connecting the BAT SITOP UPS1600 

 
Image 7-4 BAT connection 

The "BAT+" and "BAT-" ③ connections (see Image 7-4 BAT connection (Page 151)) are 
used to connect the SITOP UPS1600 with one or more SITOP UPS1100 battery modules. 
Ensure that the cables are dimensioned correctly for the maximum output current rms value 
of the SITOP UPS1600. 

For wiring, see Image 7-1 Wiring (Page 150). 

Cables must be used that are suitable for at least 90 °C (only for applications for UL508). 

Maximum cable length 3 m 
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7.4 USB interface 
Maximum USB cable length 5 m 

7.5 PROFINET/Ethernet connection 
Maximum length of the PROFINET/Ethernet cable 100 m (90 m BASIC- Link plus 2 x 5 m 
CHANNEL- Link) 

7.6 SITOP UPS1100 connections 
 

 
Connections 1.2 Ah/2.5 Ah/3.2 Ah/5 Ah 

 
Connections 7/12 Ah 

Connection X1 ① 

The connections "X1+" and "X1-" are used to transfer power between the SITOP UPS1600 
and the SITOP UPS1100. 

1. Ensure that the cables are dimensioned corresponding to the fuses in the 
SITOP UPS1100 and the impedances between SITOP UPS1600 and SITOP UPS1100 
are the same. 

2. Only connect charged batteries with one another. 

Connection X2 ② 

Connections "X2-1" and "X2-2" serve to transfer data between SITOP UPS1600 and 
SITOP UPS1100 (see Image 7-1 Wiring (Page 150)). 

When several battery modules are used, note the following: 

● Up to 6 battery modules of the same type can be connected together in parallel. 

● If different battery modules are connected in parallel, relay 2 flashes (battery defective). 
No calculations with regard to charge and remaining buffer time are performed. The 
battery modules are not charged, but buffering is possible. 

● If more than six battery modules are connected in parallel, relay 2 flashes (battery 
defective). No calculations with regard to charge and remaining buffer time are 
performed. Charging and buffering, however, is possible. 
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7.7 Maintenance 

7.7.1 Battery 
SITOP UPS1100 devices contain 2 maintenance-free batteries. 
 
Device type Battery type 
6EP4131-0GB00-0AY0 (1.2 Ah) YUASA NP1,2-12  
6EP4132-0GB00-0AY0 (2.5 Ah) Hawker Energy CYCLON 0810-0075 2.5-12 
6EP4133-0GB00-0AY0 (3.2 Ah) YUASA NP3,2-12 or B.B.Battery BP3,6-12 
6EP4133-0JB00-0AY0 (5 Ah) NEC ALM12V7s 
6EP4134-0GB00-0AY0 (7 Ah) YUASA NP7-12 or B.B.Battery BP7-12 
6EP4135-0GB00-0AY0 (12 Ah) YUASA NP12-12 or B.B.Battery BP12-12 

When replacing the batteries, always use batteries with the same batch number 
(approximately the same charge state). 

The rechargeable batteries must be disposed of, discharged according to the applicable 
regulations. 

When storing, installing and operating the buffer batteries, the regulations of VDE 0510 Part 
2 / EN 50272-2 or the applicable national regulations must be observed. 

The self-discharge rate of the batteries is approx. 3%/month for a temperature of 20° C. This 
value is temperature dependent and becomes more unfavorable for an increasing 
temperature, and more favorable for a decreasing temperature. 

7.7.2 Battery replacement 
See Image 7-5 Maintenance (Page 154) and Image 7-6 Wiring schematic (Page 154) 

1. Remove the screws ⑨ using a Torx T10 screwdriver. 

2. Open the cover. 

3. Press button ⑧ for at least 2 s. 

LED ④ flashes 

4. Remove fuse ③ 

5. Replace the batteries. 

6. Press the button for at least 2 s 

LED ④ stops flashing and lights continuously. 

7. Insert the fuse. 

8. Close the cover (screw). 
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Pressing the button resets the following functions: 

● Operating hours counter 

● Buffer time counter 

● Summed charge current 

● Summed load current 

● Calculated capacity 

 

 Note 

Replace the battery only in normal operation, not in backup operation. 
 

 
Image 7-5 Maintenance 

 
Image 7-6 Wiring schematic 
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 Technical data 8 
 

 
 

 Note 

Technical data apply for a rated input voltage, rated load and 25 °C ambient temperature if 
nothing else is specified. 

 

8.1 Input 

8.1.1 SITOP UPS1600 
 

 6EP4134-3AB00- ... (10 A) 6EP4136-3AB00- ... (20 A) 6EP4137-3AB00- ... (40 A) 
Input voltage Uin rated/ 
range 

24 V DC/21 - 29 V 

Connection threshold for 
buffering 
• Remark 

22.5 V DC ± 3% (factory setting),  
setting range: 21 V DC , 21.5 V DC , 22 V DC, 22.5 V DC, 23 V DC, 24 V DC, 25 V DC or via 
software. 
The connection threshold must be at least 0.5 V lower than the input voltage  
(measured at the input terminal under load). 
After reaching the minimum input voltage at the DC UPS module, the module cannot buffer for 
a maximum of 1.5 seconds. 

Input current Iin rated Approx. 14 A  
at the maximum charge cur-
rent (3 A) 

Approx. 25 A  
at the maximum charge cur-
rent (4 A) 

Approx. 46 A  
at the maximum charge cur-
rent (5 A) 

Reverse polarity protec-
tion 

Yes 
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8.1.2 SITOP UPS1100 
Charge current: For one connected battery module the max. charge current is 0.3C A, for 
several battery modules connected in parallel, the charge current is 0.3C A multiplied by the 
number of batteries connected in parallel, however, limited by the maximum permissible 
charge current of the UPS1600 (see Chapter 8.2.1). 

Recommended end-of-charge voltage (standby use), dependent on the battery temperature 
 

 6EP4131-0GB00- ... (1.2 Ah) 
6EP4133-0GB00- ... (3.2 Ah) 
6EP4134-0GB00- ... (7 Ah) 
6EP4135-0GB00- ... (12 Ah) 

6EP4132-0GB00- ... (2.5 Ah) 6EP4133-0JB00- ... (5 Ah) 

at -10 C - 29.0 V 29.28 V 
at 0 C - 28.6 V 29.52 V 
at 10 C 27.8 V 28.3 V 29.16 V 
at 20 C 27.3 V 27.9 V 28.8 V 
at 30 C 26.8 V 27.5 V 28.8 V 
at 40 C 26.6 V 27.2 V 28.8 V 
at 50 C - 26.8 V 27.8 V 
at 60 C - 26.4 V - 

See also 
SITOP UPS1600 (Page 157) 

Output (Page 157) 



 Technical data 
 8.2 Output 

SITOP UPS1600 / UPS1100 
Manual, 04.2016, A5E37775406-6-76 157 

8.2 Output 

8.2.1 SITOP UPS1600 
 

 6EP4134-3AB00- ... (10 A) 6EP4136-3AB00- ... (20 A) 6EP4137-3AB00- ... (40 A) 
Output voltage with normal 
operation 

Input voltage Uin approx. - 0.2 V 

Output voltage for buffer 
mode 

27 V DC (no-load); 24 V (50 % rated battery current); 
22 V (100 % rated battery current); 18.5 V (deep discharge protection) 

Power-up characteristics Start delay < 1 s 
Typical voltage increase: < 60 ms 

Output +BAT/-BAT for nor-
mal operation 
• Remark 

I-U charging characteristic (initially fast charge current, then charge retention). 
 
For one connected battery module the max. charge current is 0.3C A, for several battery 
modules connected in parallel, the charge current is 0.3C A multiplied by the number of 
batteries connected in parallel, however, limited by the maximum permissible charge cur-
rent of the UPS1600. 

End-of-charge voltage Automatic temperature-controlled setting with the SITOP UPS1100 battery modules 
Output current – rated value 10 A 20 A 40 A 
Power boost for 30 ms 30 A 60 A 120 A 
Extra power for 5 s/min 15 A 30 A 60 A 

• Remark When using the UPS1100 5 Ah, Extra Power is permissible for 1 s/min. 

Charge current Max. 3 A 
Automatic setting for 
UPS1100; otherwise 0.3 A, 
0.8 A or 3 A can be selected 
(by software or jumper (see 
Table 2-5 Charge current 
(Page 26))) 

Max. 4 A 
Automatic setting for 
UPS1100; otherwise 0.8 A, 
1.75 A, 4 A can be selected 
(by software or jumper (see 
Table 2-5 Charge current 
(Page 26))) 

Max. 5 A 
Automatic setting for 
UPS1100; otherwise 0.8 A, 
1.75 A, 4 A can be selected 
(by software or jumper (see 
Table 2-5 Charge current 
(Page 26))) 

• Remark The charge current can be automatically reduced if the charge current plus the load current 
at the UPS1600 results in an overload of the feeding power supply. 
The charge current can also be reduced if the ambient temperature of the UPS1600 is 
higher than 40 °C - or if the input voltage at the UPS1600 is less than 24 V. 
Derating: 
10 A: 3 A→2 A 
20 A: 4 A→3 A 
40 A: 5 A→3 A 
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8.2.2 SITOP UPS1100 
 

 6EP4131-
0GB00- 
... (1.2 Ah) 

6EP4132-
0GB00- 
... (2.5 Ah) 

6EP4133-
0GB00- 
... (3.2 Ah) 

6EP4133-
0JB00- 
... (5 Ah) 

6EP4134-
0GB00- 
... (7 Ah) 

6EP4135-
0GB00- 
... (12 Ah) 

Output voltage 
rated value 

24 V DC 

Output voltage 
range  

22 - 27 V DC 22 - 27 V DC 22 - 27 V DC 22 - 28.8 V DC 22 - 27 V DC 22 - 27 V DC 

Output current 
rated value 

10 A 20 A 20 A 20 A 40 A 40 A 

Power boost 
for 30 ms 

30 A 60 A 60 A 60 A 120 A 120 A 

Extra Power for 
5 s/min 

15 A 30 A 30 A - 60 A 60 A 

Extra Power for 
1 s/min 

- - - 30 A - - 

Battery fuse 
(plug-in) 

15 A / 32 V 25 A / 32 V 25 A / 32 V 25 A/32 V 2 × 25 A/32 V 2 × 25 A/32 V 

8.3 Backup times 
 

Output current 6EP4131-
0GB00- 
... (1.2 Ah) 

6EP4132-
0GB00- 
... (2.5 Ah) 

6EP4133-
0GB00- 
... (3.2 Ah) 

6EP4133-
0JB00- 
... (5 Ah) 

6EP4134-
0GB00- 
... (7 Ah) 

6EP4135-
0GB00- 
... (12 Ah) 

1 A 34 minutes 1.7 h 2.5 h 5.2 h 5.4 h 10.3 h 
2 A 11 minutes 54.6 minutes 1 h 2.5 h 2.6 h 4.8 h 
3 A 9 minutes 32.9 minutes 39 minutes 1.7 h 1.6 h 3 h 
4 A 6 min 20.6 minutes 27 minutes 1.25 h 1.2 h 2.3 h 
6 A 3.5 minutes 14.3 minutes 17.5 minutes 50.6 minutes 41 minutes 1.4 h 
8 A 2 minutes 10.5 minutes 12 minutes 37.8 minutes 28 minutes 1 h 
10 A 1 minute 7.2 minutes 9 minutes 30.2 minutes 22 minutes 48.6 minutes 
12 A - 6 minutes 7 minutes 25.1 minutes 17 minutes 40.3 minutes 
14 A - 4.5 minutes 5 minutes 21.6 minutes 15 minutes 33.6 minutes 
16 A - 4.1 minutes 4 minutes 18.8 minutes 12.5 minutes 26 minutes 
20 A - 2.9 minutes 1 minute 12.9 minutes 9 minutes 19.6 minutes 
30 A - - - - 4.6 min 12.1 min 
40 A - -- - - 2.8 min 8.5 min 
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8.4 Efficiency 

Table 8- 1 SITOP UPS1600 

 6EP4134-3AB00-0AY0 (10 A) 
6EP4134-3AB00-1AY0 (10 A) 

6EP4134-3AB00-2AY0 (10 A) 

Efficiency at Uin rated, Iout rated, approx. 97.5 % 97.3 % 
Power loss at Uin rated, Iout rated, approx. 6 W 7 W 

 

 

 6EP4136-3AB00-0AY0 (20 A) 
6EP4136-3AB00-1AY0 (20 A) 

6EP4136-3AB00-2AY0 (20 A) 

Efficiency at Uin rated, Iout rated, approx. 97.7 % 97.5 % 
Power loss at Uin rated, Iout rated, approx. 10 W 11 W 

 

 

 6EP4137-3AB00-0AY0 (40 A) 
6EP4137-3AB00-1AY0 (40 A) 

6EP4137-3AB00-2AY0 (40 A) 

Efficiency at Uin rated, Iout rated, approx. 98.5 % 98.3 % 
Power loss at Uin rated, Iout rated, approx. 15 W 17 W 

8.5 Protection and monitoring 

Table 8- 2 SITOP UPS1600 

 6EP4134-3AB00- ... (10 A) 6EP4136-3AB00- ... (20 A) 6EP4137-3AB00- ... (40 A) 
Current limitation 
 Typ. 
• Remark 

30 A 
 
Power boost with 300 % Iout rated 
for typ. 30 ms 

60 A 
 
Power boost with 300 % Iout rated 
for typ. 30 ms 

120 A 
 
Power boost with 300 % Iout rated 
for typ. 30 ms 

Short-circuit protec-
tion 

Shutdown after 30 ms 

Reverse polarity 
protection 

With respect to the input voltage Uin and with respect to batteries 

Overload/short-circuit 
indicator 

Yes, restart in normal operation 
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Table 8- 3 SITOP UPS1100 

 6EP4131-
0GB00- 
... (1.2 Ah) 

6EP4132-
0GB00- 
... (2.5 Ah) 

6EP4133-
0GB00- 
... (3.2 Ah) 

6EP4133-
0JB00- 
... (5 Ah) 

6EP4134-
0GB00- 
... (7 Ah) 

6EP4135-
0GB00- 
... (12 Ah) 

Short-circuit 
protection 

Yes, fuse 

Reverse 
polarity pro-
tection 

Yes 

8.6 MTBF 
 

 6EP4134-3AB00-... (10 A) 
6EP4136-3AB00-... (20 A) 
6EP4137-3AB00-... (40 A) 

Mean Time Between Failures SN29500: >320000 hours at 40 °C, rated load, 24-h operation 

8.7 Mechanical system 

8.7.1 SITOP UPS1600 

Table 8- 4 SITOP UPS1600 10 A / 20 A 

 6EP4134-3AB00- ... (10 A) 6EP4136-3AB00- ... (20 A) 

 ... -0AY0 ... -1AY0 ... -2AY0 ... -0AY0 ... -1AY0 ... -2AY0 
Connection system Screw-type terminal 
Connections / DC input IN+, IN-: 1 screw terminal each for 0.2 - 6 (4) mm² solid (finely stranded) 
Connections / DC output OUT+, OUT-: 1 screw terminal each for 0.2 - 6 (4) mm² solid (finely stranded) 
Connections / BAT BAT+, BAT-: 1 screw terminal each for 0.2 - 6 (4) mm² solid (finely stranded) 
Connections / signal con-
nector 

X2 (1...14): 1 screw terminal each for 0.2 - 1.5 mm² solid/finely stranded 

Width of the housing 50 mm 50 mm 50 mm 50 mm 50 mm 50 mm 
Height of the housing 138.7 mm 138.7 mm 138.7 mm 138.7 mm 138.7 mm 138.7 mm 
Depth of the housing 125 mm 125 mm 125 mm 125 mm 125 mm 125 mm 
Installation width 50 mm 50 mm 50 mm 50 mm 50 mm 50 mm 
Mounting height 238.7 mm 238.7 mm 238.7 mm 238.7 mm 238.7 mm 238.7 mm 
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 6EP4134-3AB00- ... (10 A) 6EP4136-3AB00- ... (20 A) 

 ... -0AY0 ... -1AY0 ... -2AY0 ... -0AY0 ... -1AY0 ... -2AY0 
Weight, approx. 0.38 kg 0.4 kg 0.44 kg 0.39 kg 0.41 kg 0.45 kg 
Product feature /  
of the housing / 
housing that can be lined 
up next to one another 

Yes 

Type of mounting / 
wall mounting 

No 

Type of mounting / rail 
mounting 

Yes 

Type of mounting /  
S7-300 rail mounting 

No 

Mounting Can be snapped onto standard TH35x7,5/15 mounting rails (EN 60715) 
 

Table 8- 5 SITOP UPS1600 40 A 

 6EP4137-3AB00- ... (40 A) 

 ... -0AY0 ... -1AY0 ... -2AY0 
Connection system Screw-type terminal 
Connections / DC input IN+, IN-: 1 screw terminal each for 0.5 - 16 (4) mm² solid (finely stranded) 
Connections / DC output OUT+, OUT-: 1 screw terminal each for 0.5 - 16 (4) mm² solid (finely stranded) 
Connections / BAT BAT+, BAT-: 1 screw terminal each for 0.5 - 16 (4) mm² solid (finely stranded) 
Connections / signal con-
nector 

X2 (1 - 14): 1 screw terminal each for 0.2 - 1.5 mm² solid/finely stranded 

Width of the housing 70 mm 70 mm 70 mm 
Height of the housing 138.7 mm 138.7 mm 138.7 mm 
Depth of the housing 150 mm 150 mm 150 mm 
Installation width 70 mm 70 mm 70 mm 
Mounting height 238.7 mm 238.7 mm 238.7 mm 
Weight, approx. 0.65 Kg 0.65 Kg 0.7 kg 
Product feature /  
of the housing / 
housing that can be lined 
up next to one another 

Yes 

Type of mounting / 
wall mounting 

No 

Type of mounting / 
rail mounting 

Yes 

Type of mounting /  
S7-300 rail mounting 

No 

Mounting Can be snapped onto standard TH35x7,5/15 mounting rails (EN 60715) 
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8.7.2 SITOP UPS1100 

Table 8- 6 SITOP UPS1100 1.2 Ah / 2.5 Ah / 3.2 Ah 

 6EP4131-0GB00-  
... (1.2 Ah) 

6EP4132-0GB00-  
... (2.5 Ah) 

6EP4133-0GB00-  
... (3.2 Ah) 

Connection system Screw-type terminal 
Connections / DC input X1-1, X1-2: 1 screw terminal each for 0.2 - 6 (4) mm² solid (finely stranded) 
Connections / signal terminal X2-1, X2-2: 1 screw terminal each for 0.14 - 4 (2.5) mm² solid (finely stranded) 
Width of the housing 89 mm 265 mm 190 mm 
Height of the housing 130.3 mm 115 mm 169.3 mm 
Depth of the housing 106.7 mm 76 mm 78.7 mm 
Installation width 89 mm 265 mm 190 mm 
Mounting height 145.3 mm 130 mm 184.3 mm 
Weight, approx. 1.9 kg 3.7 kg 3.8 kg 
Product feature /  
of the housing / 
housing that can be lined up 
next to one another 

Yes 

Type of mounting / 
wall mounting 

Yes 

Type of mounting / rail mount-
ing 

Yes 

Type of mounting /  
S7-300 rail mounting 

No 

Mounting Wall mounting, can be 
snapped onto standard 
TH35x7,5/15 mounting rails 
(EN 60715) 

Wall mounting, can be snapped onto standard TH35x15 
mounting rails (EN 60715) 

 

Table 8- 7 SITOP UPS1100 7 Ah / 12 Ah 

 6EP4133-0JB00- ... (5 Ah) 6EP4134-0GB00- ... (7 Ah) 6EP4135-0GB00- ... (12 Ah) 
Connection system Screw-type terminal Screw-type terminal 
Connections / DC input X1-1, X1-2: 1 screw terminal 

each for 0.2 - 6 (4) mm² solid 
(finely stranded) 

X1-1, X1-2: 1 screw terminal each for 0.2 - 16 mm² sol-
id/finely stranded 

Connections / signal terminal X2-1, X2-2: 1 screw terminal 
each for 0.14 - 4 (2.5) mm² 
solid (finely stranded) 

X2-1, X2-2: 1 screw terminal each for 0.14 - 4 (2.5) mm² 
solid (finely stranded) 

Width of the housing 189 mm 186 mm 253 mm 
Height of the housing 186 mm 186 mm 186 mm 
Depth of the housing 112.7 mm 110.3 mm 110 mm 
Installation width 189 mm 186 mm 253 mm 
Mounting height 201 mm 201 mm 201 mm 
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 6EP4133-0JB00- ... (5 Ah) 6EP4134-0GB00- ... (7 Ah) 6EP4135-0GB00- ... (12 Ah) 
Weight, approx. 3.4 kg 6.1 kg 9.3 kg 
Product feature /  
of the housing / 
housing that can be lined up 
next to one another 

Yes Yes 

Type of mounting / 
wall mounting 

Yes Yes 

Type of mounting / 
rail mounting 

Yes No 

Type of mounting /  
S7-300 rail mounting 

No No 

Mounting Wall mounting, can be 
snapped onto standard 
TH35x15 mounting rails 
(EN 60715) 

Wall mounting 
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8.8 Dimension drawing 
see Section Dimensions and weight (Page 34) 

 

CAD data that can be downloaded from the Internet: 

6EP4134-3AB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00813) 

6EP4134-3AB00-1AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00816) 

6EP4134-3AB00-2AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00819) 

6EP4136-3AB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00810) 

6EP4136-3AB00-1AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00807) 

6EP4136-3AB00-2AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00804) 

6EP4137-3AB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01019) 

6EP4137-3AB00-1AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01022) 

6EP4137-3AB00-2AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01025) 

6EP4131-0GB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00829) 

6EP4132-0GB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01013) 

6EP4133-0GB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00832) 

6EP4134-0GB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00835) 

6EP4135-0GB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01016) 

6EP4133-0JB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01105) 

http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00813
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00816
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00819
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00810
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00807
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00804
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01019
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01022
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01025
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00829
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01013
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00832
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00835
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01016
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01105
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9.1 Safety 
 

 6EP4134-3AB00- ..., 6EP4136-3AB00- ..., 6EP4137-3AB00- ... 
6EP4131-0GB00- ..., 6EP4132-0GB00- ..., 6EP4133-0GB00- ..., 6EP4134-0GB00- ..., 
6EP4135-0GB00- ..., 6EP4133-0JB00- ... 

Protection class Class III 
Degree of protection  
(EN 60529) 

IP20 

Test voltage See Table 9-1 Test voltage (Page 166) 
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9.2 Test voltage 
 

 
Image 9-1 Test voltage diagram 

Only applicable for UPS1600 with PROFINET (-2AY0). 

Only the manufacturer can perform the type test and production test; users can also perform 
the field test.  

Preconditions for performing the field test:  

Test (A) 

● Connect the input, output, BAT and signaling contact with one another and measure with 
respect to PE 

Test (B) 

● Connect all PROFINET cables and measure with respect to PE (input, output, BAT signal 
connector and PE are connected with each other) 

Table 9- 1 Test voltage 

 Test time Input, output, BAT ↔ PE (A) PROFINET ↔ PE (B) 
Type test 60 s 700 V DC 2200 V DC 

60 s 500 V AC 1500 V AC 
Production test 1 s 200 V DC  

1 s 140 V AC  
Field test 1 s 200 V DC 2200 V DC 

1 s 140 V AC 1500 V AC 
 Remark:  

Tripping current for DC measurement: 0 mA 
Tripping current for AC measurement: <100 mA 
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9.3 Approvals 
 

 6EP4134-3AB00- ... 
6EP4136-3AB00- ... 
6EP4137-3AB00- ... 

6EP4131-0GB00-0AY0 
6EP4132-0GB00-0AY0 
6EP4133-0GB00-0AY0 
6EP4133-0JB00-0AY0 
6EP4134-0GB00-0AY0 
6EP4135-0GB00-0AY0 

CE marking Yes, (2004/108/EG) Yes, (2004/108/EG and 2006/66/EG) 
UL/cUL approval cULus-listed (UL 508, CSA 22.2 No. 107.1),  

File E197259 
cURus-Recognized (UL 1778, CSA C22.2 No. 
107.1),  
File E219627 

Explosion protection EPS 13 ATEX 1 607 X IECEx EPS 14.0063X II 
3G Ex nA nC IIC T4 Gc cCSAus HazLoc Class 
I, Div 2, Group A,B,C,D T4 

EPS 13 ATEX 1 607 X IECEx EPS 14.0063X II 
3G Ex nA IIC T4 Gc cCSAus HazLoc Class I, 
Div 2, Group A,B,C,D T4 6EP4133-0JB00-
0AY0: No explosion protection certification 

CB certification Yes, (IEC 60950-1) Yes, (IEC 60950-1) 
Marine approvals GL GL 
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9.4 EMC 
 

  6EP4134-3AB00- ... (10 A) 
6EP4136-3AB00- ... (20 A) 
6EP4137-3AB00- ... (40 A) 
6EP4131-0GB00-0AY0 (1.2 Ah) 
6EP4132-0GB00-0AY0 (2.5 Ah) 
6EP4133-0GB00-0AY0 (3.2 Ah) 
6EP4134-0GB00-0AY0 (7 Ah) 
6EP4135-0GB00-0AY0 (12 Ah) 

6EP4133-0JB00-0AY0 (5 Ah) 

Electrostatic discharge EN 61000-4-2 6 kV contact, 8 kV air 5 kV contact, 8 kV air 
Electromagnetic fields EN 61000-4-3 80 - 1000 MHz 10 V/m 

1400 - 2000 MHz 10 V/m 
2000 - 2700 MHz 10 V/m 
895 - 905 MHz and 1.89 GHz 10 V/m 

High-speed transient disturbance 
variables (burst) 

EN 61000-4-4 2 kV at DC input/output 

Surge voltages EN 61000-4-5 500 V symmetrical/unsymmetrical at the DC input/output, 1 kV un-
symmetrical at signal connections 

High-frequency fields EN 61000-4-6 10 V; 0.15 - 80 MHz 
Magnetic fields EN 61000-4-8 Not applicable 
Emitted interference EN 55022 Class B 
Generic standards EN 61000-6-2 Immunity for industrial environments 

EN 61000-6-3 Emission for residential areas 
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 Environmental conditions 10 
 

 

Table 10- 1 UPS1600 

 6EP4134-3AB00- ... (10 A) 6EP4136-3AB00- ... (20 A) 6EP4137-3AB00- ... (40 A) 
Ambient temperature -25 ... 70 °C for natural convec-

tion (self convection) 
-25 ... 60 °C for natural convec-
tion (self convection) 
15 A (derating) at 60° ... 70° C 

-25 ... 60 °C for natural convec-
tion (self convection) 
30 A (derating) at 60° ... 70° C 

Tested according to: 
• EN 60068-2-1 cold 
• EN 60068-2-2 dry heat 
• EN 60068-2-78 humid heat, constant 
• EN 60068-2-14 temperature change 

Remark: The service life of the UPS1100 battery modules (decrease to 50% of the original capac-
ity) depends on the battery temperature, at approximately 20° C: 4 years, 30 °C: 2 years, 40 °C: 1 
year 

Transport and storage 
temperature 

-40 ... 85 °C  
Tests (packed for shipping) according to: 
• EN 60068-2-1 cold 
• EN 60068-2-2 dry heat 
• EN 60068-2-30 humid heat, cyclic 

Humidity class Climatic class 3K3 according to EN 60721, 5 - 95 % no condensation 
Degree of pollution 2 
Mechanical  
stress in operation 

Tested according to: 
• EN 60068-2-6 Vibration, test Fc: 

3.5 mm deflection in the range 5 – 9 Hz 
1 g acceleration in the range 9 – 150 Hz 

• EN 60068-2-27 shock, test Ea: 
acceleration 150 m/s2 , test duration 11 ms 

Damaging gases Tested according to: 
• EN 60068-2-42 sulfur dioxide 
• EN 60068-2-43 hydrogen sulfide 

Air pressure Operation: 
• 1080 - 795 hPa (-1000 - 2000 m) 
• For operation at altitudes of 2000 m up to 6000 m above sea level: 

output must be derated by -7.5% / 1000 m or 
the ambient temperature must be reduced by 5 K / 1000 m 
see Image 6-5 Altitude derating (Page 148) 

Storage: 
• 1080 - 660 hPa (-1000 - 3500 m) 
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Table 10- 2 UPS1100 

 6EP4131-0GB00-0AY0 
(1.2 Ah) 
6EP4133-0GB00-0AY0 
(3.2 Ah) 
6EP4134-0GB00-0AY0 
(7 Ah) 
6EP4135-0GB00-0AY0 
(12 Ah) 

6EP4132-0GB00-0AY0 
(2.5 Ah) 

6EP4133-0JB00-0AY0 
(5 Ah) 

Ambient temperature 0 ... 40 °C for natural con-
vection 
(self convection)  
1.2 / 3.2 / 7 Ah: From prod-
uct version 3: -15 ... 50 °C 
for natural convection 
(self convection)  
12 Ah: From product version 
2: -15 ... 50 °C for natural 
convection 
(self convection) 

-40 ... 60 °C for natural con-
vection 
(self convection) 
 

-20 ... 50 °C for natural con-
vection 
(self convection) 

Tested according to: 
• EN 60068-2-1 cold 
• EN 60068-2-2 dry heat 
• EN 60068-2-78 humid heat, constant 
• EN 60068-2-14 temperature change 

 

Remark: The service life of the UPS1100 battery modules 
(decrease to 50% of the original capacity) depends on the 
battery temperature, at approximately 20° C: 4 years, 30 °C: 
2 years, 40 °C: 1 year 

 

Transport and storage tem-
perature 

-20 ... 50 °C -40 ... 60 °C -40 ... 60 °C 
Tests (packed for shipping) according to: 
• EN 60068-2-1 cold 
• EN 60068-2-2 dry heat 
• EN 60068-2-30 humid heat, cyclic 

 

Humidity class Climatic class 3K3 according to EN 60721, without conden-
sation 

 

Degree of pollution 2  
Mechanical stressing in 
operation 

Tested according to: 
• EN 60068-2-6 Vibration, test Fc: 

3.5 mm deflection in the range 5 – 9 Hz 
1 g acceleration in the range 9 – 150 Hz 

• EN 60068-2-27 shock, test Ea: 
acceleration 150 m/s2 , test duration 11 ms 
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 6EP4131-0GB00-0AY0 
(1.2 Ah) 
6EP4133-0GB00-0AY0 
(3.2 Ah) 
6EP4134-0GB00-0AY0 
(7 Ah) 
6EP4135-0GB00-0AY0 
(12 Ah) 

6EP4132-0GB00-0AY0 
(2.5 Ah) 

6EP4133-0JB00-0AY0 
(5 Ah) 

Damaging gases Tested according to: 
• EN 60068-2-42 sulfur dioxide 
• EN 60068-2-43 hydrogen sulfide 

 

Air pressure Operation: 
• 1080 - 795 hPa (-1000 - 2000 m) 
• For operation at altitudes of 2000 m up to 6000 m above 

sea level: 
output must be derated by -7.5% / 1000 m or 
the ambient temperature must be reduced by 
5 K / 1000 m 
see Image 6-5 Altitude derating (Page 148) 

Storage: 
• 1080 - 660 hPa (-1000 - 3500 m) 
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 Environment 11 
 

 

The devices are in conformance with RoHS. 

As a rule, only non-silicon precipitating materials are used. 

Disposal guidelines 
Packaging and packaging aids can and should always be recycled. The product itself may 
not be disposed of as domestic refuse. 

 

 Note 

The rechargeable batteries must be disposed of, discharged according to the applicable 
regulations. 
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 Service & Support 12 
 

 

Technical support 

Technical support for all IA/DT products can be accessed through the following 
communication channels: 

● Phone: + 49 (0) 911 895 7222 

● E-Mail (mailto:support.automation@siemens.com) 

● Internet: 
 Online support request form (http://www.siemens.de/automation/support-request) 

Technical documentation on the Internet 

Operating instructions and manuals for SITOP are available in the Internet: 
Operating instructions/manuals (http://www.siemens.de/sitop/manuals) 

SITOP power supply homepage 

General news about our power supplies is available in the Internet at the SITOP homepage: 
SITOP (http://www.siemens.de/sitop) 

Information material 

SITOP information can be downloaded from the Internet: 
Information and download center (http://www.siemens.de/sitop-infomaterial) 

CAx data 

2D/3D data and circuit diagram macros can be downloaded from the Internet: 
Siemens image database (http://www.siemens.de/sitop-cax) 

Request all CAx data via the CAx download manager: 
CAx shopping cart (http://www.siemens.de/cax) 

SITOP Selection Tool 

Simply and quickly select the optimum the power supply or DC-UPS: 
SITOP Selection Tool (http://www.siemens.de/sitop-selection-tool) 

Online catalog and ordering system 

The online catalog and the online ordering system are available through the Industry Mall 
homepage: 
Industry Mall (http://www.siemens.com/industrymall/de) 

mailto:support.automation@siemens.com
http://www.siemens.de/automation/support-request
http://www.siemens.de/sitop/manuals
http://www.siemens.de/sitop
http://www.siemens.de/sitop-infomaterial
http://www.siemens.de/sitop-cax
http://www.siemens.de/cax
http://www.siemens.de/sitop-selection-tool
http://www.siemens.com/industrymall/de
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Contact persons 

If you have any questions regarding the use of our products, then contact the Siemens 
contact person in your regional Siemens sales office. 

You can find these addresses as follows: 

● On the Internet (http://www.siemens.de/automation/partner) 

● In Catalog CA 01 

http://www.siemens.de/automation/partner
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